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Safety

This chapter includes:

e Electrical Safety on page 12

e Operational Safety on page 14
e Maintenance Safety on page 15
e Printer Symbols on page 16

Your printer and the recommended supplies have been designed and tested to meet strict safety
requirements. Attention to the following information ensures the continued safe operation of
your printer.
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Safety

Electrical Safety

Warning: Do not push objects (including paper clips or staples) into slots or openings on the
printer. Making contact with a voltage point or shorting out a part could result in fire or
electrical shock.

Warning: Do not remove the covers or guards that are fastened with screws unless you are
installing optional equipment and are specifically instructed to do so. Power should be OFF when
performing these installations. Disconnect the power cord when removing covers and guards for
installing optional equipment. Except for user-installable options, there are no parts that you can
maintain or service behind these covers.

The following are hazards to your safety:
e The power cord is damaged or frayed.
e Liquid is spilled into the printer.

e The printer is exposed to water.

If any of these conditions occur, do the following:

1. Turn off the printer immediately.

2. Disconnect the power cord from the electrical outlet.
3. Call an authorized service representative.

Laser Safety

This printer complies with laser printer performance standards set by governmental, national, and
international agencies and is certified as a Class 1 Laser Product. The printer does not emit hazardous
light because the beam is totally enclosed during all modes of customer operation and maintenance.

Warning: Use of controls, adjustments, or performance of procedures other than those specified in
this manual can result in hazardous radiation exposure.
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Safety

Power Cord

Use the power cord supplied with your printer.

Plug the power cord directly into a properly grounded electrical outlet. Make sure each end of the
cord is securely connected. If you do not know if an outlet is grounded, ask an electrician to check
the outlet.

Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have
a ground connection terminal.

Warning: Avoid the potential of electrical shock by ensuring that the printer is properly grounded.
Electrical products may be hazardous if misused.
Do not use an extension cord or power strip.

Verify that the printer is plugged into an outlet that is capable of providing the correct voltage and
power. Review the printer’s electrical specification with an electrician if necessary.

Do not place the printer in an area where people might step on the power cord.
Do not place objects on the power cord.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary
to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet.

Telephone Line Cord

Caution: To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger
telecommunication line cord.

WorkCentre 7755/7765/7775 Multifunction Printer 13
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Safety

Operational Safety

Your printer and supplies were designed and tested to meet strict safety requirements. These include
safety agency examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines helps to ensure the continued, safe operation of
your printer.

Printer Location

Do not block or cover the slots or openings on the printer. These openings are provided for
ventilation and to prevent overheating of the printer.

Place the printer in an area where there is adequate space for operation and servicing.
Place the printer in a dust-free area.

Do not store or operate the printer in an extremely hot, cold, or humid environment For optimum
performance environmental specifications, see Environmental Specifications on page 235

Place the printer on a level, solid non-vibrating surface with adequate strength to hold the weight of the
printer. The base printer weight without any packaging materials is approximately 275 kg (604 [b.).

Do not place the printer near a heat source.
Do not place the printer in direct sunlight to avoid exposure to light-sensitive components.
Do not place the printer where it is directly exposed to the cold air flow from an air conditioning unit.

Operational Guidelines

Do not remove the paper source tray that you selected in either the printer driver or control panel.
Do not open the doors when the printer is printing.

Do not move the printer when it is printing.

Keep hands, hair, neckties, etc., away from the exit and feed roller.

Printer Supplies

Use the supplies specifically designed for your printer. The use of unsuitable materials may cause
poor performance and a possible safety hazard.

Follow all warnings and instructions marked on, or supplied with, the printer, options, and supplies.

Caution: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreements,
and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of
performance caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this
printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage
may vary outside these areas; please contact your local representative for details.
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Safety

Maintenance Safety

e Do not attempt any maintenance procedure that is not specifically described in the
documentation supplied with your printer.

e Do not use aerosol cleaners. Clean with a dry lint-free cloth only.

e Do not burn any consumables or routine maintenance items. For information on Xerox supplies
recycling programs, go to www.xerox.com/gwa.

WorkCentre 7755/7765/7775 Multifunction Printer 15
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Safety

Symbol Description

Warning or Caution:
Ignoring this warning could cause serious injury or even death.
Ignoring this caution could cause injury or damage to the property.

Hot surface on or in the printer. Use caution to avoid personal injury.

Do not touch components with this symbol as personal injury could result.

Warning:
Moving parts. Use caution to avoid personal injury.

> @B P
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Features

This chapter includes:

Before Using the Printer on page 18
Parts of the Printer on page 19
Printer Configurations on page 22
Control Panel on page 24

More Information on page 29
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Features

Before Using the Printer

Xerox Welcome Center

If you need assistance during or after product installation, visit the Xerox website for online solutions
and support.

www.xerox.com/office/worldcontacts

If you require further assistance, contact our experts at the Xerox Welcome Center. A local
representative telephone number may have been provided when the product was installed. For
convenience and future reference, please record the telephone number in the space below.

Welcome Center or local representative telephone number:

#

Xerox US Welcome Center: 1-800-821-2797
Xerox Canada Welcome Center: 1-800-93-XEROX (1-800-939-3769)

If you need any additional help using your printer:
1. Refer to this User Guide.
2. Contact the Key Operator.

3. Visit our Customer Web Site at www.xerox.com/office/WC7755_WC7765_WC7775support or
contact the Xerox Welcome Center.

Please have your printer’s serial number when contacting Xerox.

The Welcome Center will want to know the following information: The nature of the problem, the serial
number of the printer, the fault code (if any), as well as the name and location of your company. Follow
the steps below to look up the serial number of the printer.

1. On the printer’s control panel, press Machine Status.

2. The Machine Information tab displays by default. The serial number is displayed on the left side of
the printer touch screen.

Note: The serial number is also found on the printer frame. Open the door underneath the Bypass
Tray. The serial number is located on the right side of the printer frame.

18 WorkCentre 7755/7765/7775 Multifunction Printer
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Features

Parts of the Printer

This section includes:

e Front-Left View on page 19

e Rear-Left View on page 20

e Internal Components on page 21

Front-Left View

7
4
5
6
wx77xx-125
1. Document Feeder 6. Tray 3
2. Power Switch 7. Tray 4
3. Output Tray 8. Left Side Door
4. Tray 1 9. Tray 5 (Bypass Tray)
5. Tray 2 10. Control Panel with Touch Screen

WorkCentre 7755/7765/7775 Multifunction Printer 19
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Features

Front-Right View

1. Document Feeder Tray
2. Output Tray

3. Bottom Right Cover

wc77xx-126

Rear-Left View

wc77xx-139
1. Fax Line 1 4. Bottom Left Cover

2. FaxLine 2 5. Tray 5 (Bypass Tray)

3. Ethernet Connection
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Internal Components

1. Toner Cartridges
Drum Cartridges (behind cover)

Transfer Module

A

Handle 2 (Transfer Module Release Handle)

wc77xx-127
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Features

. on page 22
. on page 22
) on page 23

The printer has many features to meet your print needs:
e Copy and print capabilities

e Maximum print speed of 75 pages per minute for black and white printing and 50 pages per
minute for color printing (on letter-size plain paper)

e 2400 x 2400 dpi

e Automatic 2-sided printing

e Color touch screen display on control panel

e Duplex Automatic Document Feeder (DADF) that holds up to 250 sheets

e Tray 1 and Tray 2 that each hold up to 500 sheets each; Size: Standard selectable sizes up to
11 x17in./A3

e Tray 3 that holds 870 sheets; Size: 8.5 x11in./ A4

e Tray 4 that holds up to 1,140 sheets; Size: 8.5 x 11 in./ A4

e Tray 5 (Bypass Tray) that holds up to 250 sheets; Size: Custom sizes up to 13 x 19 in. / SRA3

e 1GB RAM memory

e Hard drive that provides feature support for special job types and additional forms and macros
e PostScript and PCL fonts

e Ethernet 10/100/1000Base-TX connection

The printer is available in three configurations

Print Speed in PPM

Model (1-Sided and 2-Sided)
WorkCentre 7755 55 monochrome/40 color
WorkCentre 7765 65 monochrome/50 color
WorkCentre 7775 75 monochrome/50 color
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Printer Options

The following options are available for the printer:

For more information on options, go to www.xerox.com/office/WC7755_WC7765_WC7775supplies.

Fax

Scan to Email

High Capacity Feeder with 8.5 x 11 in./A4 support
Offset Catch Tray

Advanced Finisher

Professional Finisher with Booklet Maker

Light Production Finisher with optional C- and Z-folding
Convenience Stapler

Foreign Device Interface

Xerox Copier Assistant

Xerox Secure Access Unified ID System

Network Accounting

SmartSend

Unicode Print

Common Access Card Authentication (CAC)

Features
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Control Panel

This section includes:
e Control Panel Layout on page 25
e Information Pages on page 26
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Control Panel Layout

Features

15

11

wc77xx-128

Item Description

1 Touch Screen Displays information and provides access to printer functions.

2 Services Home Press to access the features, such as copy, scan, and fax, on the
touch screen.

3 Services Press to access the options for the selected feature, such as copy, scan,
and fax, on the touch screen.

4 Alphanumeric Keys Enter alphanumeric information.

5 Log In/Out To access password protected features, press Log In/Out, then enter the
user name and password using the touch screen. Press again to log out.

6 Help Press to view a help message about the current selection on the
touch screen.

7 Language Press to change the touch screen language and keyboard settings.

8 Dial Pause Inserts a pause in a fax number.

9 C Deletes numeric values or the last digit entered.

10 | Start Press to start a copy, scan, or fax job.

11 | Stop Press to pause a print, copy, scan, or fax job. On the touch screen, touch
Resume to continue or Delete to cancel the job.

12 | Interrupt Printing Press to interrupt printing. Press again to resume printing.

13 | Clear All Press twice to clear current job settings. Touch Confirm on the touch
screen to reset all job settings to default.
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Features

Item Description

14 | Energy Saver Button When printer is in low power mode, press to enter normal mode. Press
while the printer is in normal mode to enter low power mode.

15 | Machine Status Press to view supplies status, printer information, etc., on the
touch screen.

16 | Job Status Press to view the list of active and completed jobs on the touch screen.

Your printer has a printable set of information pages stored on its internal hard drive. The information
pages provide configuration and font information.

To print an information page:

1. On the control panel, press the Machine Status button.

2. Touch Information Pages, then touch the desired information page.
3. Touch Print.

Information pages can also be printed from CentreWare Internet Services (CentreWare IS).

An information page called the Configuration Report lists information about the current configuration
of your printer, and is useful for network analysis and general troubleshooting.
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Billing Meters

The billing meters screen displays printer usage and billing information.

1. On the printer’s control panel, press the Machine Status button.
2. Touch the Billing Information tab.

The Billing Meters are displayed on the left of the screen.
3. For more detailed information, touch Usage Counters.

Features
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Features

Accounting

Accounting is used to track billing and control access to copying, scanning, faxing and printing for each
user. When Accounting is enabled, each user is required to press the Log In/Out button and enter their
User ID information in order to use the printer. The system administrator must create user accounts
and then enable Accounting.

For details, see the System Administrator Guide at
www.xerox.com/office/WC7755_WC7765_WC7775docs.
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Features

More Information

The following links provide more information about your printer and its capabilities.

Information Source

Quick Use Guide Packaged with printer

User Guide (PDF) Software and Documentation CD
www.xerox.com/office/WC7755_WC7765_WC7775docs

System Administrator Guide www.xerox.com/office/WC7755_WC7765_WC7775docs

Recommended Media List www.xerox.com/paper (United States)

www.xerox.com/europaper (Europe)

Printer Management Tools www.xerox.com/office/WC7755_WC7765_WC7775drivers
Online Support Assistant www.xerox.com/office/WC7755_WC7765_WC7775support
Technical Support www.xerox.com/office/WC7755_WC7765_WC7775support
Information about touch screen messages Control panel Help button

Information pages Print from the printer’s touch screen

WorkCentre 7755/7765/7775 Multifunction Printer 29
User Guide


http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC7755_WC7765_WC7775&PgName=knowledgebase&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC7755_WC7765_WC7775&PgName=tech&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCen

tre+WC7755_WC7765_WC7775&PgName=driver&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC7755_WC7765_WC7775&PgName=userdocpdfs&FileName=user_guide&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC7755_WC7765_WC7775&PgName=userdocpdfs&FileName=sys_admin_guide&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+

WC7755_WC7765_WC7775&PgName=rmlna&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+

WC7755_WC7765_WC7775&PgName=rmleu&Language=english

Features

30 WorkCentre 7755/7765/7775 Multifunction Printer
User Guide



Installation and Setup

This chapter includes:

e Installation and Setup Overview on page 32

e Physical Connection on page 32

e Installing the Software on page 33

e Using CentreWare Internet Services on page 38

See also:

Online Support Assistant at www.xerox.com/office/WC7755_WC7765_WC7775support.

System Administrator Guide at www.xerox.com/office/\WC7755_WC7765_WC7775docs for
details on initial setup and configuration, setting up faxing and scanning, UNIX drivers, and more.
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Installation and Setup

Installation and Setup Overview

Before you can use your printer, you must:

1. Make sure the printer is connected correctly and turned on.
2. Install software drivers and utilities.

3. Configure the software.

Physical Connection

You can connect to your printer over a network. Connect to a functioning and dedicated fax telephone
line for the optional fax. Communication cables are not included with your printer and must be
purchased separately.

Ethernet Network

To physically connect your printer to the network:
1. Connect the power cable to the printer, and plug it into an electrical outlet.

2. Connect one end of a Category 5, or better, Ethernet cable to the Ethernet port in the back of the
printer. Connect the other end of the cable to your network port.

3. If your printer has fax installed, connect to a functioning telephone line using a standard RJ11 cable.
4. Turn the printer on.

Fax Connection

Use a standard RJ11 cable, No. 26 American Wire Gauge (AWG) or larger, to connect your printer to
the telephone line.

Initial Printer Setup

Initial settings must be completed before the printer software can be installed. If the printer has not
been previously powered up and configured, see the System Administrator Guide at
www.xerox.com/office/WC7755_WC7765_WC7775docs.
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Installation and Setup

Installing the Software

This section includes:

e Operating System Requirements on page 33

e Installing Drivers and Utilities for Windows on page 33

¢ Installing the Drivers and Utilities for Macintosh on page 34
e UNIX and Linux Drivers on page 37

Operating System Requirements

e PC: Windows 2000, XP, Vista, Windows Server 2003 or newer.
¢ Macintosh: OS X, version 10.3 or newer.
e UNIX and Linux: see www.xerox.com/office/WC7755 WC7765 WC7775drivers

Installing Drivers and Utilities for Windows

To access all features of the printer, you must:
e Install the Xerox print driver.
e Install the Xerox scan driver.

Installing a Network Printer

Before installing drivers, ensure that the printer is plugged in, turned on, connected to an active
network and has a valid IP address.

To install the driver:

1. Insert the Software and Documentation CD into your computer’s CD drive.

2. The installer starts automatically unless you have autorun disabled on your computer.
Note: If the installer does not start, navigate to the drive and double-click Setup.exe. If the
Software and Documentation CD is not available, download the latest driver from
www.xerox.com/office/WC7755_WC7765_WC7775drivers.

To change the language, click Language, select your language from the list, then click OK.
Click Install Drivers, then click Install Print and Scan Drivers.

Click Agree to accept the License Agreement.

Select your printer from the list of discovered printers, then click Install.

No v EWw

If your printer does not appear in the list of discovered printers:
a. Click IP Address or DNS Name near the top of the window.

b. Type the address or name of your printer, then click Search. If the IP address does not display,
see Finding The Printer’s IP Address on page 38.

¢. When the printer displays in the window, click Next.
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Installation and Setup

8. Select the desired printer driver:
e PostScript

e PCLS
e PCL6
9. Select the desired scan driver:
e TWAIN
e WIA

e Enable Xerox Scan Utility
10. Click Install.
11. When the installation completes, click Finish.

Installing the Drivers and Ultilities for Macintosh

To access all features of the printer, you must:
e Install the printer and scan drivers
e If required, add the printer

Before installing drivers, verify that the printer is plugged in, turned on, connected to an active network
and has an IP address.

Printer and Scan Drivers

Note: The printer and scan drivers both install at the same time.

To install the printer and scan driver:

1. Insert the Software and Documentation CD into the CD drive.
Note: If the Software and Documentation CD is not available, download the latest driver from
www.xerox.com/office/WC7755 WC7765_WC7775drivers.
Open the Mac folder, then open Mac OS 10.3+Universal PS folder.
Open WorkCentre 7755_7765_7775 CD.dmg.

Open WorkCentre 7755_7765_7775 CD.

Click Continue three times.

Click Agree to accept the License Agreement.

Click the disk for installation, click Continue, then click Install.
Enter your password, then click OK.
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If your printer does not appear in the list of discovered printers:
a. Click the Manually enter the printer’s name or address button at the top of the window.

b. Type the address or name of the desired printer, then wait for the computer to find the printer.
If the IP address of the printer is not known, see Finding The Printer’s [P Address on page 38.

c. Click Continue.
10. Click OK to accept the print queue message.
11. If desired, click the check boxes to Set Printer as Default and Print a Test Page.
12. Click Continue, then click Close.
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13. From the Apple menu, open System Preferences, then open Print & Fax.
14. Click the Printing tab, click to select the printer in the list, then click Printer Setup.

15. Click Installable Options, then confirm the options installed on the printer are displayed.

16. If changes are made, click Apply Changes, close the window, then quit System Preferences.

The printer is now ready to use.

Adding the Printer for OS X Version 10.3

O N U~ WwWwN =

0o NV EWN S

Open the Applications folder, then open the Utilities folder.

Open the Printer Setup Utility.

Click Add.

Confirm that the first drop-down menu is set to Rendezvous for a network connection.
Select the printer in the window.

Select Xerox from the Printer Model drop-down menu.

Select the appropriate printer model from the list.

Click the Add button.

Note: If your printer was not detected by the network, check to make sure that the printer is on,

and the Ethernet cable is connected properly.

If you want to connect by specifying the printer’s IP address:

Open the Applications folder, then open the Utilities folder.

Open the Printer Setup Utility.

Click Add.

Confirm that the first drop-down menu is set to IP Printing.

Select LPD/LPR, IPP, or Socket/HP Jet Direct from the Printer Type drop-down menu.
Enter the printer’s IP address in the Printer Address field.

Select Xerox from the Printer Model drop-down menu.

Select the appropriate printer model from the list.

Click the Add button.

Adding the Printer for OS X Version 10.4

1.

Open a Finder window, click the Applications folder, then click System Preferences.

Note: If the System Preferences application is displayed in your dock, click the icon to open
System Preferences.

Click Print & Fax, then click Printing.
Click the plus button under the list of detected printers.
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4. Click Default Browser in the Printer Browser window.
5. Select your printer from the list, then click Add.

Note: If your printer was not detected by the network, check to make sure that the printer is on and
the Ethernet cable is connected properly.

If you want to connect by specifying the printer’s IP address:

Open System Preferences from the Applications folder.

Open Print & Fax and select the Printing tab.

Click the plus button under the list of detected printers.

Click IP Printer in the Printer Browser window.

Select IPP, Line Printer Daemon - LPD, or HP Jet Direct — Socket from the Protocol list.
Type the printer’s IP address in the Address field.

Type a Name for the printer.
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Type a location for the printer.

9. Select Xerox from the Print Using drop-down list.
10. Select your printer model from the list.

11. Click Add.

Adding the Printer for OS X Version 10.5

Open the Applications folder, then double-click System Preferences.

Click Print & Fax.

Click the plus button under the list of installed printers.

Type the IP address or host name of the printer you want to add.

Type a Queue name for your printer or leave it blank to use the default queue.
Select your printer from the list, then click Add.
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Note: If your printer was not detected by the network, check to make sure that the printer is on,
and the Ethernet cable is connected properly.

If you want to connect by specifying the printer’s IP address:

From the Applications folder on the dock, click the System Preferences icon.

Click Print & Fax.

Click the plus button under the list of installed printers.

Click IP Printer.

Select IPP, Line Printer Daemon - LPD, or HP Jet Direct — Socket from the Protocol list.
Type the printer’s IP address in the Address field.

Type a name for the printer.

NV WN =

Type a location for the printer.

9. Select a driver to use from the Print Using drop-down list.
10. Select your printer model from the list.

11. Click Add.
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UNIX and Linux Drivers

Supported UNIX and Linux drivers are available at
www.xerox.com/office/WC7755_WC7765_WC7775drivers.

For details see the System Administrator Guide at
www.xerox.com/office/WC7755_WC7765_WC7775docs.

Other Drivers

The following drivers are also available for Windows only at:
www.xerox.com/office/WC7755_WC7765_WC7775drivers.

« Xerox Global Print Driver™ for PCL: Use to print to any PCL printer on your network, including those
made by other manufacturers. It configures itself for your individual printer upon installation.

e Xerox Mobile Express Driver™ for PCL: Use to print to any PCL printer on your network, including
those made by other manufacturers. It configures itself for the printer you select every time you
print. If you travel frequently to the same sites, you can save your favorite printers in that location
and the driver will remember your settings.

WorkCentre 7755/7765/7775 Multifunction Printer 37
User Guide


http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC7755_WC7765_WC7775&PgName=userdocpdfs&FileName=sys_admin_guide&Language=english

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCen

tre+WC7755_WC7765_WC7775&PgName=driver&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC7755_WC7765_WC7775&PgName=driver&Language=english

Installation and Setup

Using CentreWare Internet Services

CentreWare Internet Services (CentreWare IS) provides access to the printer’s embedded Web server. It
enables you to easily manage, configure, and monitor your printer using a Web browser on a network
computer. Use CentreWare IS to access printer status, configuration, security settings, and diagnostic
functions. It also provides access to special printing functions such as printing saved jobs.

CentreWare IS enables you to:

e Check supplies status from your computer, saving a trip to the printer.

e Access job accounting records to allocate printing costs and plan supplies purchases.

e Retrieve scanned document files stored in the printer.

e Access online manuals and technical support information located on the Xerox website.

Note: Some printer capabilities must be enabled using CentreWare IS. Unless your system administrator
has unlocked the printer, you will need to log in as an administrator to access these settings.

CentreWare IS requires:

e A Web browser and a TCP/IP connection between the printer and the network (in Windows,
Macintosh, or UNIX environments).

e JavaScript must be enabled in the Web browser. If JavaScript is disabled, a warning message
appears and CentreWare IS may not function properly.

e TCP/IP and HTTP must be enabled in the printer.

For details see the CentreWare IS Help or the System Administrator Guide at
www.xerox.com/office/WC7755_WC7765_WC7775docs.

Finding The Printer’s IP Address

The printer’s IP address is required to use CentreWare IS. If you do not know the IP Address, print the
Configuration Report. The printer’s IP address appears in the Common User Data section in the upper
left of the page.

To print the Configuration Report:

1. An the printer’s control panel, press the Machine Status button .

2. Touch the Machine Information tab, then touch Information Pages.
3. Touch Configuration Report, then touch OK.

4. After the report prints, touch Close.

Accessing CentreWare IS

1. At your computer, open a Web browser.
2. Type the IP address of your printer.
The CentreWare IS Welcome page appears.
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Printing

This chapter includes:

Printing Overview on page 40

Supported Media on page 41

Loading Media on page 43

Printing on Special Media on page 54

Selecting Printing Options on page 58

Printing on Both Sides of the Paper on page 63
Selecting the Paper to Use on page 65

Printing Multiple Pages to a Single Sheet (N-Up) on page 66
Printing Booklets on page 67

Using Color Corrections on page 70

Printing in Black and White on page 74

Printing Insert Pages on page 75

Printing Cover Pages on page 76

Printing Exception Pages on page 78

Scaling on page 79

Printing Watermarks on page 80

Printing Mirror Images on page 82

Creating and Saving Custom Sizes on page 83

Job Completion Notification for Windows on page 84
Printing Special Job Types on page 85
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Printing

Printing Overview

1. Select appropriate media.
2. Load media in the tray, then specify the size, color, and type on the printer’s control panel.

3. Access the print settings in your software application, CTRL+P for Windows, or CMD+P for
Macintosh for most software applications.

4. Select your printer from the list.

5. Access the printer driver settings by selecting Properties or Preferences (Windows), Xerox Features
for Macintosh. The title of the button may vary depending on your application.

6. Modify the printer driver settings as necessary, then click OK.
7. Select Print (in your application’s print settings dialog) to send the job to the printer.

See also:
Loading Media on page 43
Selecting Printing Options on page 58
Printing on Both Sides of the Paper on page 63
Printing on Special Media on page 54
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Supported Media

This section includes:

e Recommended Media on page 471

e General Media Loading Guidelines on page 41

e Media That Can Damage Your Printer on page 41
e Paper Storage Guidelines on page 42

Your printer is designed to be used with a variety of media types. Follow the guidelines in this section to
ensure the best print quality and to avoid jams.

For best results, use Xerox printing media specified for your printer.

Recommended Media

A complete list of recommended media types is available:
e www.xerox.com/paper Recommended Media List (United States)
e www.xerox.com/europaper Recommended Media List (Europe)

Ordering Media

To order paper, transparencies, or other specialty media, contact your local reseller or go to:
www.xerox.com/office/WC7755_WC7765_WC7775supplies.

Caution: Damage caused by using unsupported paper, transparencies, and other specialty media
is not covered by the Xerox warranty, service agreement, or Total Satisfaction Guarantee. The Total
Satisfaction Guarantee is available in the United States and Canada. Coverage may vary outside
these areas; please contact your local representative for details.

General Media Loading Guidelines

Follow these guidelines when loading paper and media in the appropriate trays:

e Use only recommended Xerox transparencies; print quality may vary with other transparencies.
e Do not print on sheets of label stock that have labels removed.

e Use only paper envelopes. Print envelopes 1-sided only.

e Do not overload the paper trays.

e Adjust the paper guides to fit the paper size.

e Make sure the correct paper type is selected on the printer’s touch screen after loading paper in a
tray. Improper settings may degrade image quality.

Media That Can Damage Your Printer

Your printer is designed to use a variety of paper and media types for print jobs. However, some media
can cause poor output quality, increased paper jams, or damage to your printer.
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Printing

Do not use the following:

Rough or porous media

Inkjet paper

Non-laser glossy or coated paper

Paper that has been photocopied

Paper that has been folded or wrinkled

Paper with cutouts or perforations

Stapled paper

Envelopes with windows, metal clasps, side seams, or adhesives with release strips
Padded envelopes

Plastic media other than supported transparencies

Paper Storage Guidelines

Providing good storage conditions for your paper and other media contributes to optimum print quality.

Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from
ultraviolet (UV) and visible light. UV radiation, which is emitted by the sun and fluorescent bulbs, is
particularly damaging to paper.

The intensity and length of exposure to visible light on paper should be reduced as much as possible.
Maintain constant temperatures and relative humidity.

Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to
collect moisture.

Store paper flat, either on pallets, cartons, shelves, or in cabinets.
Avoid having food or drinks in the area where paper is stored or handled.

Do not open sealed packages of paper until you are ready to load them into the printer. Leave
stored paper in the original packaging. For most commercial-cut size grades, the ream wrapper
contains an inner lining that protects the paper from moisture loss or gain.

Some specialty media is packaged inside resealable plastic bags. Store the media inside the bag
until you are ready to use it. Keep unused media in the bag and reseal it for protection.
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Loading Media

This section includes:

e Loading Paperin Tray 1 or Tray 2 on page 43

e Loading Paperin Tray 3 or Tray 4 on page 45

e Loading Paperin Tray 5 (Bypass Tray) on page 47

e Loading Paper in Tray 6 (Optional High-Capacity Feeder) on page 50
e Loading Envelopes on page 51

e Loading Pre-Cut Tabs on page 52

Select the appropriate tray depending on the media you plan to use. Use Tray 5 (Bypass Tray) for
printing C4 and C5 envelopes and tabs. For details, see Recommended Media on page 41.

Loading Paper in Tray 1 or Tray 2

Tray 1 and Tray 2 accept the following media types:
e Plain

e Punched

e Transparency

e Letterhead

e Heavyweight

e Extra heavyweight

e Extra heavyweight reloaded

e Recycled
e Bond
e Labels

e Heavyweight labels

e Pre-printed

e Gloss

e Heavyweight gloss

e Heavyweight gloss reloaded

%)

Tray 1 and Tray 2 accept a maximum of approximately 560 sheets of 20 Ib. (75 g/m“) Bond paper from

55x85in.to11 x 17 in. (A5: 148 x 210 mm to A3: 297 x 420 mm).

Tray 1 and Tray 2 accept paper weights from 17 |b. Bond to 81 Ib. Cover (64 g/m2 to 220 g/mz).
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To load paper in Tray 1 or Tray 2:
1. Pull the paper tray out towards you.

D
l wc77xx-024

2. Before loading paper into the paper trays, fan the edges to separate any sheets of paper that are
stuck together. This reduces the possibility of paper jams.

3. If required, move the paper tray guides further out to load the new paper. To adjust the side and
rear guides, pinch the guide lever on each guide and slide the guides to their new position. To
secure the guides in position, release the levers.

wc77xx-025

Load the paper against the left-hand side of the tray.

Notes:

» Load long edge feed pre-printed paper facedown, with the top of the page toward the front of
the tray.

» Load short edge feed pre-printed paper facedown, with the top of the page toward the left of
the tray.

» Do not load paper above the maximum fill line. Doing so may cause paper jams.

44 WorkCentre 7755/7765/7775 Multifunction Printer
User Guide



Printing

4. Push the tray completely into the printer.

U
' wc77xx-026

5. If required, choose paper size, type, or color on the printer’s touch screen, then touch Confirm.
6. If you have not changed the media type, touch Confirm on the touch screen.

Loading Paper in Tray 3 or Tray 4

Tray 3 and Tray 4 accept following media types:
e Plain

e Punched

e Transparency

e Letterhead

e Heavyweight

e Extra heavyweight

e Extra heavyweight reloaded

e Recycled
e Bond
e Labels

e Heavyweight labels

e Pre-printed

e Gloss

e Heavyweight gloss

¢ Heavyweight gloss reloaded

Tray 3 accepts a maximum of approximately 560 sheets of 20 |b. (75 g/mz) 8.5x11in. (A4: 210 x 297
mm) Bond paper.

Tray 4 accepts a maximum of approximately 1,270 sheets 20 lb. (75 g/mz) 8.5x11in. (A4: 210 x 297
mm) Bond paper.

Tray 3 and Tray 4 accept paper weights from 17 |b. Bond to 81 Ib. Cover (64 g/m2 to 220 g/mz).
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To load paper in Tray 3 or Tray 4:
1. Pull the paper tray out towards you.

wc77xx-029

2. Before loading paper into the paper trays, fan the edges to separate any sheets of paper that are
stuck together. This reduces the possibility of paper jams.

3. If required, move the paper tray guides further out to load the new paper. To adjust the side and
rear guides, pinch the guide lever on each guide and slide the guides to their new position. To
secure the guides in position, release the levers.

wc77xx-030

Load the paper against the left-hand side of the tray.

Notes:
» Load pre-printed paper facedown, with the top of the page toward the front of the tray.

» Do not load paper above the maximum fill line. Doing so may cause paper jams.
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4. Push the tray completely into the printer.

wc77xx-103

5. If required, choose paper type, or color on the printer’s touch screen, then touch Confirm.
6. If you have not changed the media type, touch Confirm on the touch screen.

Loading Paper in Tray 5 (Bypass Tray)

Use the bypass tray for a variety of media types and custom sizes. It is primarily intended for small
quantity jobs using special media. The bypass tray is located on the left-hand side of the printer. A tray
extension is provided to accommodate larger paper. After loading paper in the bypass tray, make sure
that the bypass tray settings on the touch screen match the paper size and type loaded.
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Tray 5 (Bypass Tray) accepts the following paper types:
e Plain

e Punched

e Transparency

e Letterhead

e Heavyweight

e Extra heavyweight

e Extra heavyweight plus

e Extra heavyweight reloaded

e Recycled
e Bond
e Labels

e Heavyweight labels

e Extra Heavyweight labels

e Pre-printed

e Gloss

e Heavyweight gloss

e Extra Heavyweight gloss

e Heavyweight gloss reloaded
e Pre-Cut Tabs

e Envelopes

Tray 5 (Bypass Tray) accepts a maximum of approximately 280 sheets of 20 Ib. (75 g/mz) Bond paper.

Tray 5 (Bypass Tray) accepts the following range of paper sizes: X: 148 to 488 mm (5.8 to 19.2in.); Y:
100 to 330 mm (3.9 to 13 in.).

Tray 5 (Bypass Tray) accepts paper weights from 17 lb. Bond to 111 Ib. Cover (64 g/m2 to 300 g/mz).

wc77xx-161
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To load paper in Tray 5 (Bypass Tray):
1. Open Tray 5 by rotating it outward. For larger paper, pull the extension straight out until it stops.

wc77xx-027

2. Insert the paper either long edge or short edge first. Larger paper sizes can only be fed short edge first.

wc77xx-028

3. Slide the guides so they just touch the edges of the paper.
Notes:
» Load short edge feed pre-printed paper faceup, with the top of the page toward the right of the tray.
» Load long edge feed pre-printed paper faceup, with the top of the page toward the rear of the tray.
» Do not load paper above the maximum fill line. Doing so may cause paper jams.

4. 1If required, choose paper size, type, or color on the printer’s touch screen, then touch Confirm.
5. If you have not changed the media type, touch Confirm on the touch screen.
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Loading Paper in Tray 6 (Optional High-Capacity Feeder)

Tray 6 accepts the following media types:
e Plain

e Punched

e Letterhead

e Heavyweight

e Extra heavyweight

e Extra heavyweight reloaded

e Recycled
e Bond
e Labels

e Heavyweight labels

e Pre-printed

e Gloss

e Heavyweight gloss

e Heavyweight gloss reloaded

Tray 6 accepts a maximum of approximately 2,000 sheets 20 lb. (75 g/mz) 8.5x11in. (A4: 210 x 297
mm) Bond paper.

1. Pull the paper tray out towards you.
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2. Before loading paper into the paper trays, fan the edges to separate any sheets of paper that are
stuck together. This reduces the possibility of paper jams.

Load the paper against the right-hand side of the tray.

Notes:
» Load pre-printed paper faceup, with the top of the page toward the front of the tray.

« To help avoid paper jams, do not load paper above the maximum fill line.

wc77xx-162

BTy

4. If required, choose paper type or color on the printer’s touch screen, then touch Confirm.
5. If you have not changed the media type, touch Confirm on the touch screen.

Loading Envelopes

Envelopes can only be loaded in Tray 5 (Bypass Tray).

Tray 5 (Bypass Tray) accepts C5 envelopes measuring 229 mm x 324 mm (9 x 12.75 in.) and C4
envelopes measuring 162 mm x 229 mm (6.3 x 9 in.).
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To load envelopes in Tray 5 (Bypass Tray):
1. Insert envelopes in Tray 5 (Bypass Tray) with the flaps on the trailing edge, open and facing down.

A~
@®

2. Slide the guides so they just touch the edges of the envelopes.

wc77xx-124

Note: To help avoid jams, do not load envelopes above the maximum fill line.

3. Choose the envelope size on the printer’s touch screen, then touch Confirm.

Loading Pre-Cut Tabs

Pre-Cut Tabs can only be loaded in Tray 5 (Bypass Tray).

To load Single Straight Pre-Cut Tabs in Tray 5 (Bypass Tray):
1. Insert the Pre-Cut Tabs in Tray 5 (Bypass Tray) with the tabs on the trailing edge, facing up.

\\%

N\

wc77xx-163

2. Slide the guides so they just touch the edges of the Pre-Cut Tabs.

Note: To help avoid jams, do not load Pre-Cut Tabs above the maximum fill line.
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On the printer’s touch screen, set the following:

e From the Size menu, select Custom, then enter the size of the Pre-Cut Tabs, including the width
of the tabs.

e From the Paper menu, select Pre-Cut Tabs, then enter the number of tabs in each set.
¢ Touch Confirm.
If you have not changed the media, touch Confirm on the touch screen.

Note: Tab number one must be on top. Partially used tab sets must be removed from the tray
before printing a new Pre-Cut Tabs job.
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Printing on Special Media

This section includes:

Printing on Transparencies on page 54
Printing on Envelopes on page 55

Printing on Labels on page 55

Printing on Glossy Paper on page 56
Printing on Custom Size Paper on page 57

Printing on Transparencies

Transparencies can be printed from Tray 1, 2, 3, 4, and 5 (Bypass Tray). For best results, use only
recommended Xerox transparencies.

To order paper, transparencies, or other specialty media, contact your local reseller or go to
www.xerox.com/office/WC7755_WC7765_WC7775supplies.

Caution: Damage caused by using unsupported paper, transparencies, or other specialty media is
not covered by the Xerox warranty, service agreement, or Total Satisfaction Guarantee. The Total
Satisfaction Guarantee is available in the United States and Canada. Coverage may vary outside
these areas; please contact your local representative for details.

See also:

www.xerox.com/paper Recommended Media List (United States)
www.xerox.com/europaper Recommended Media List (Europe)

Guidelines

Remove all paper before loading transparencies in the tray.

Handle transparencies by the edges using both hands. Fingerprints or creases can cause poor
print quality.

Do not load more than 20 transparencies. Overloading the tray can cause the printer to jam.
Load transparencies faceup into Tray 5 (Bypass Tray) and facedown into trays 1, 2, 3 or 4.
Do not use transparencies with stripes on the side.

Do not fan transparencies.

After loading transparencies, change the paper type to Transparency on the touch screen.

In the printer driver, select either Transparency as the paper type, or select the tray loaded with
transparencies as the paper source.
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Printing on Envelopes

Envelopes can be printed only from Tray 5 (Bypass Tray).

Guidelines

Successful envelope printing is dependent on the quality and construction of the envelopes. Try
another envelope brand if the desired results are not achieved.

Maintain constant temperatures and relative humidity.

Store unused envelopes in their packaging to avoid the excess moisture and dryness which can
affect print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before
or during printing.

Avoid padded envelopes; use envelopes that lie flat on a surface.

In the printer driver, select either Envelope as the paper type or Tray 5 (Bypass Tray) as the
paper source.

Note: Some wrinkling or embossing may occur when printing on envelopes.

Caution: Never use envelopes with windows or metal clasps; they can damage the printer. Damage
caused by using unsupported envelopes is not covered under the Xerox warranty, service
agreement, or Total Satisfaction Guarantee. The Total Satisfaction Guarantee is available in the
United States and Canada. Coverage may vary outside these areas, please contact your local
representative for details.

Printing on Labels

Labels can be printed from Tray 1, 2, 3, 4, and 5 (Bypass Tray).

To order paper, transparencies, or other specialty media, contact your local reseller or go to the Xerox
Supplies website at www.xerox.com/office/WC7755_WC7765_WC7775supplies.
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Guidelines

Use labels designed for laser printing.

Do not use vinyl labels.

Do not use dry gum labels.

Print only on one side of the sheet of labels. Use full sheet labels only.

Do not use any sheet where labels are missing; it may damage the printer.

Store unused labels flat in their original packaging. Leave the sheets of labels inside the original
packaging until ready to use. Return any unused sheets of labels to the original packaging and
reseal it.

Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing
them in extreme conditions may cause print quality problems or cause them to jam in the printer.

Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and
jam in the printer.

Extra Heavyweight Labels can only be fed from Tray 5 (Bypass Tray).

In the printer driver, select either Labels, Heavyweight Labels, or Extra Heavyweight Labels as
the paper type or the tray containing the labels.

Printing on Glossy Paper

Glossy paper can be printed from Trays 1, 2, 3, 4, and 5 (Bypass Tray).

To order paper, transparencies, or other specialty media, contact your local reseller or go to the Xerox
Supplies website for your printer: www.xerox.com/office/WC7755_WC7765_WC7775supplies.

Guidelines

Do not open sealed packages of glossy paper until you are ready to load them into the printer.
Leave glossy paper in the original wrapper, and store unopened packages in the original shipping
carton until ready to use.

Remove all other paper from the tray before loading glossy paper.

Load only the amount of glossy paper you plan to use and remove the unused portion from the
tray when you are finished printing. Replace the unused portion in the original wrapper and seal for
later use.

Rotate stock frequently. Long periods of storage in extreme conditions can cause glossy paper to
curl and jam in the printer.

In the printer driver, select Gloss Coating, Heavyweight Gloss Coating or Extra Heavyweight
Gloss Coating as the paper type, or select the tray containing the glossy paper.
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In addition to the wide variety of standard paper sizes that you can use for printing, you can also print
on custom size paper within the following dimensions and weights.

1-Sided Printing

Manual 2-Sided Printing

Automatic 2-Sided Printing

Short 100-330 mm (3.9-12.9in) | 100-330 mm (3.9-12.9in) | 139.7-330 mm (5.5-12.9in.)
edge

Long 148-488 mm (5.8-19.21in.) | 148-488 mm (5.8-19.2in.) | 182-488 mm (7.1-19.2in.)
edge

Weight | 64-300 g/m? 64-300 g/m? 64-176 g/m?
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Selecting Printing Options

Printing options, also referred to as printer driver options, are specified as Printing Preferences in
Windows, and Xerox Features in Macintosh. Printing Options include settings for 2-sided printing, page

layout, and print quality.

Printing Options for Windows on page 58

Setting Default Printing Options for Windows on page 59

Selecting Printing Options for an Individual Job in Windows on page 60

Saving a Set of Commonly Used Printing Options in Windows on page 60

Selecting Finishing Options for Windows on page 60

Printing Options for Macintosh on page 60

Selecting Options for an Individual Job for Macintosh on page 61

Saving a Set of Commonly Used Printing Options for Macintosh on page 61

Selecting Finishing Options for Macintosh on page 62

Printing Options for Windows

The following table lists printing options organized in tabs within the Printing Preferences window.

Tab

Paper/Output

PostScript Printing Options

Job Type

Paper Size, Paper Color, Paper Type,
and tray selection

Transparency Separators
2-sided Printing

Finishing (if a finisher installed)
Print Quality

Output Destination

PCL 6 Printing Options

Job Type

Paper Size, Paper Color, Paper Type,
and tray selection

Transparency Separators
2-sided Printing

Finishing (if a finisher installed)
Print Quality

Output Destination

Special Pages

Covers
Inserts
Exception Pages

Covers
Inserts
Exception Pages

Color Options
(Color Correction)

Automatic Color
Black and White conversion
Color Adjustments

Color
Black and White conversion
None

Layout/Watermark

Pages Per Sheet (N-Up)
Booklet Layout
Orientation

2-Sided Printing
Watermark

Pages Per Sheet (N-Up)
Booklet Layout
Orientation

2-Sided Printing
Watermark

58 WorkCentre 7755/7765/7775 Multifunction Printer

User Guide




Tab

Advanced

PostScript Printing Options

Paper/Output

e Copies

e Collate

e Output Options

e Banner Sheet

e Offset Sets

e Feed Edge

Image options

¢ Rotate Image 180 degrees
e Reduce/Enlarge

e Margins

e Mirrored Output

e PostScript Pass-through
e Color Configuration
Booklet Layout

e Image Order
Advanced Printing Features
Font Substitution

Font Download

PostScript Output
PostScript Level

PostScript Error Handler

Printing

PCL 6 Printing Options

Paper/Output

e Copies

e Collate

e Output Options

e Banner Sheet

e Offset Sets

e Feed Edge

Image options

e Rotate Image 180 degrees
e Reduce/Enlarge

e Margins

Booklet Layout

e Image Order

Advanced Printing Features
Font Substitution

Font Download

Help is available in all tabs. For more information about Windows printer driver options, click the Help button
in the lower left-hand corner of any tab in the Properties or Printing Preferences window.

When you print from any software application, the printer uses the print job settings specified in the
Printing Preferences window. You can specify your most common printing options and save them so

that you do not have to change them every time you print.

For example, if you typically print on both sides of the paper, specify 2-sided printing in Printing Preferences.

To change Printing Preferences:

1. Click Start, select Settings, then click Printers and Faxes.

2. Inthe Printers and Faxes folder, right-click the icon for your printer, then click Printing Preferences.

3. Click a tab in the Printing Preferences window, make selections, then click OK.

For more information about Windows printer driver options, click the Help button in the
lower left-hand corner of any tab in the Printing Preferences window.
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To use special printing options for a particular job, change the Printing Preferences before sending the
job to the printer. For example, if you want to use the Enhanced print quality mode when printing a
particular document, select this setting in Printing Preferences before printing that job.

1. With the document open in your application, access the Print dialog box (CTRL+P for
most applications).

2. Select the printer and click the Properties button to open the Printing Preferences window. This
button is labeled Preferences in some applications. Click a tab in the Printing Preferences window,
and make selections.

3. Click OK to save and close the Printing Preferences window.
4. Print the job.

You can define and save a set of printing options, so that you can quickly apply them to future print jobs.

To save a set of printing options:
1. Click Saved Settings at the bottom of the Printing Preferences window, then click Save As.

2. Enter a name for the set of printing options, then click OK. The set of options is saved and will appear
in the list. The next time you want to print using these options, select the name from the list.

If your printer has the Advanced Finisher, the Professional Finisher or the Light Production Finisher
installed, finishing options are selected in the printer driver.

To select finishing features in the PostScript and PCL printer drivers:
1. Inthe printer driver, click the Paper/Output tab.
2. Click the arrow to the right of the Finishing section, then select the desired finishing options.

See the following table for specific printing options in the Macintosh PostScript printer driver.

Tab Printing Options

Paper/Output Job type

Paper size, paper color, paper type, and tray selection
Transparency separators

2-sided printing

Print quality

Finishing (if finisher installed)

Output Destination
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Tab Printing Options
Special Pages Covers
Inserts

Exception pages

Image Options RGB Source Color
CMYK Source Color
Output Color Correction
Invert Image

Layout/Watermark Booklet layout
Page Borders
Watermark

Advanced Booklet Image Order
Output Options
Banner Sheet

Offset

True Gray Graphics
Mirrored Output
Printing Optimization

To use special printing options for a particular job, change the driver settings before sending the job to
the printer.

1. With the document open in your application, click File, then click Print.
Select your printer from the Printer list.

From the Copies & Pages menu, select Xerox Features.

Select the desired printing options from the drop-down lists.

Click Print to print the job.

s whN

You can define and save a set of options, so that you can quickly apply them to future print jobs.

To save a set of printing options:
1. Select the desired printing options from the drop-down lists on the Print menu screen.
2. Select Save As from the Presets menu to save and name the set of printing options.

3. The set of options is saved and will appear in the Presets list. To print using these options, select
the name from the list.
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Selecting Finishing Options for Macintosh

If your printer has the Advanced Finisher, the Professional Finisher or the Light Production Finisher
installed, finishing options are selected in the printer driver.

To select finishing features in the Macintosh printer driver:
1. Inthe printer driver, click the Copies & Pages menu, then select Xerox Features.

2. Inthe Paper/Output dialog box, click the arrow to the right of the Finishing section, then select
the desired finishing options.
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. on page 63
. on page 63
) on page 64

A 2-sided document can be printed on supported paper. Before printing a 2-sided document, verify the
paper type and weight are supported.

Paper weights in the range of 64to 176 g/m2 (17 to 47 Ib. Bond) can be used for automatic 2-sided printing.

The following paper types can be used for automatic 2-sided printing:
e Plain

e Letterhead

e Heavyweight

e Recycled

e Bond

e Pre-printed

The following paper and media cannot be used for 2-sided printing:
e Transparencies

e Envelopes

e Labels

e Any die-cut specialty media, such as business cards

e Extra Heavyweight

e Gloss

¢ Heavyweight Gloss

For details, see on page 41.

See the following table for 2-sided document printer driver settings.

Operating System

Windows 2000, XP, Vista, or 1. Click the Paper/Output tab.

Windows Server 2003 2. Click an option under 2-Sided Printing:
e 2-Sided Print
e 2-Sided Print, Flip on Short Edge
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Operating System

Mac OS X, version 10.3 or newer | 1. In the Print dialog box, click Xerox Features.
2. Click an option under 2-Sided Printing
e Click 2-Sided Print.
e Click 2-Sided Print, Flip on Short Edge.

When you select 2-Sided Printing in the printer driver, you can specify the page layout which
determines how the pages turn.

Portrait Landscape
i 3 ’
Portrait Portrait Landscape Landscape
2-Sided Print 2-Sided Print, Flip on 2-Sided Print, Flip on 2-Sided Print
Short Edge Short Edge

1. Inthe printer driver, click the Layout/Watermark tab.
2. Click Portrait, Landscape, or Rotated Landscape.
3. Click 2-Sided Print, or 2-Sided Print, Flip on Short Edge.

1. Inthe application, click Portrait, Landscape or Rotated Landscape page orientation.
2. Inthe Print dialog box, select Xerox Features from the Copies & Pages menu.
3. Click 2-Sided Print, or 2-Sided Print, Flip on Short Edge.
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Selecting the Paper to Use

When you send your print job to the printer, you can choose to let the printer automatically select
which paper to use based on the document size, paper type and paper color you select, or select a
specific tray.

Selecting Paper in a Supported Driver

Windows

1. Inthe printer driver, click the Paper/Output tab.

2. To change the paper type, click the arrow next to the Paper section, then select the paper type
from the Other Type menu.

3. To change the paper color, click the arrow next to the Paper section, then select the paper color
from the Other Color menu.

4. To specify a tray, click the arrow next to the Paper section, then select the tray from the Select by
Tray menu.

5. To specify a paper size, click the arrow next to the Paper section, then select Other Size. In the
Paper Size window, select the size from the Output Paper Size menu, then click OK.

Macintosh

1. Inthe Print dialog box, click Copies & Pages menu, then click Paper Feed.

2. From the All pages from drop-down list, click Auto Select to select the paper based on your

application settings, or select a specific paper tray.
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Printing Multiple Pages to a Single Sheet (N-Up)

When printing a multiple-page document, you can print more than one page on a single sheet of
paper. Print one, two, four, six, nine, or 16 pages per side.

Printing N-Up Using a Supported Driver

Windows

1. Inthe printer driver, click the Layout/Watermark tab.
2. Click Pages Per Sheet (N-Up).
3. Click the button for the number of pages you want to appear on each side of the sheet.

Macintosh

1. Inthe Print dialog box, click Copies & Pages menu, then click Layout.
2. Select the number of Pages per Sheet and Layout Direction.
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Printing Booklets

With 2-sided printing, you can print a document in the form of a small book. Create booklets for any
paper size that is supported for 2-sided printing. The driver automatically reduces each page image
and prints four pages per sheet of paper (two on each side). The pages are printed in the correct order
so that you can fold and staple the pages to create a booklet.

Notes:
» Automatic folding requires the optional Professional Finisher or the optional Light
Production Finisher.

» Booklets can be created using 8.5x 11 in. (A4 210 mm x 297 mm) paperand 11 x 17 in. (A3 297
mm x 420 mm) paper.

When you print booklets, you can specify the creep and gutter in supported drivers.

e QGutter: Specifies the horizontal distance (in points) between the page images. A point is 0.35 mm
(1/72in.).

e Creep: Specifies how much the page images are shifted outward (in 10ths of a point). This
compensates for the thickness of the folded paper, which otherwise would cause the page images
to shift slightly outward when folded. You can select a value from zero to 1.0 points.

Gutter Creep

w0 N
/

Selecting Booklet Printing in a Supported Driver Using a Booklet Maker

Windows

1. Inthe printer driver, click the Paper/Output tab, click the arrow to the right of Finishing, then
select Booklet Creation.

2. Inthe Booklet Creation window, under Booklet Finishing, do one of the following:
e Click None: no folding or stapling.
o Click Booklet Fold: bi-fold, 5 sheets maximum.
e Click Booklet Fold and Staple: bi-fold and saddle staple, 15 sheets maximum.
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3. Under Booklet Layout, do one of the following:
o If your document is preformatted as a booklet, click None.
e To have the printer order the pages into a booklet, click Booklet Layout. If desired, click Draw
Page Borders.
4. The paper size is automatically selected. To manually specify the paper size, under Booklet Paper
Size, clear the Automatically Select check box, click the down arrow, then select the paper size.
5. The gutter and creep values are set automatically. To manually specify the gutter and creep values,
click the arrows.
6. Click OK.
Macintosh
1. Inthe Print dialog box, click Copies & Pages, click Xerox Features, then click the Paper/Output.
2. Click the arrow to the right of Finishing, then select Booklet Creation.
3. Inthe Booklet Creation dialog box, under Booklet Finishing, do one of the following:
e Click None: no folding or stapling.
e Click Booklet Fold: bi-fold, 5 sheets maximum.
e Click Booklet Fold and Staple: bi-fold and saddle staple, 15 sheets maximum.
4. Under Booklet Layout, do one of the following:
e If your document is preformatted as a booklet, click None.
e To have the printer order the pages into a booklet, click Booklet Layout. If desired, click Print
Page Borders.
5. The paper size is automatically selected. To manually specify the paper size, under Booklet Paper
Size, click the down arrow, then select the paper size.
6. The gutter and creep values are set automatically. To manually specify the gutter and creep values,
click the arrows.
7. Click OK.

Selecting Booklet Printing in a Supported Driver Without Using a Booklet

Maker

Windows

1. Inthe printer driver, click the Layout/Watermark tab.

2. Click the Booklet Layout option, then click Booklet Options.

3. The paper size is automatically selected. To manually specify the paper size, under Booklet Paper
Size, click the down arrow, then select the paper size.

4. The gutter and creep values are set automatically. To manually specify the values, click the arrows
to specify the gutter and creep values.

5. Click OK.

6. If desired, select Draw Page Borders from the drop-down list.

7. Click OK.
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Macintosh

1. Inthe Print dialog box, click Copies & Pages, click Xerox Features, then click Layout/Watermark.
2. Under Booklet Layout, click Enabled.

3. Click Booklet Options.

4. The paper size is automatically selected. To manually specify the paper size, under Booklet Paper

Size, clear the Automatically Select check box, click the down arrow, then select the paper size.

5. The gutter and creep values are set automatically. To manually specify the gutter and creep values,
click the arrows.

6. Click OK.
7. If desired, click Print Page Borders.
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This section includes:

. on page 70

) on page 71

. on page 71

. on page 71

) on page 72

The Color Correction options provide simulations of different color devices. Automatic is the default
correction for general image processing. See the following table to determine which option to use.

Color Correction Description

Automatic Color Applies the best color correction to each graphic element: text, graphics, and

(Recommended) images.

Vivid Color Produces brighter and more saturated colors.

Black and White Converts all colors to black and white or shades of gray.

Color Adjustments Allows you to make minor adjustments, or access Custom options for Press
Matching.

Color Correction Description

Color (Recommended) | Applies the best color correction to each graphic element: text, graphics, and
images.

Black and White Converts all colors to black and white or shades of gray.

None Color corrections are not used.
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Color Correction Description

Automatic Applies the best color correction to each graphic element: text, graphics, and
(Recommended) images.

sRGB Display Simulate a CRT computer display

Black & White Converts all colors to black and white or shades of gray.

Press Match Simulate a specified printing press.

s wWwnN -

In the printer driver, click the Color Options tab.
Click the desired color correction: Automatic, Vivid Color, Black and White, or Color Adjustments.

In the Print dialog box, from the Copies & Pages menu, click Xerox Features, select Image
Options, then select Output Color Correction.

Select the desired color correction: Automatic, Black & White or None.

This capability is only available in the Windows PostScript printer driver.

In the printer driver, click the Color Options tab.
Click Color Adjustments.
Click the Color Adjustments button.

In the More Color Adjustments window, under Color Correction, click the down arrow, then click the
desired color correction.

Click OK.
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If you need to make additional color adjustments for your job, you can customize a color correction.

1. After selecting a color correction (see steps 1 to 4 above), customize the selected correction by
moving these sliders:

o Lightness: Move the slider to the right to lighten colors or to the left to darken colors in your
print job. White remains white and black remains black.

e Saturation: Move the slider to the right to increase color intensity or to the left to decrease
color intensity without changing the darkness.

e Contrast: Move the slider to the right to increase contrast or to the left to decrease contrast.
With increased contrast, saturated colors become more saturated, darker colors become more
black, and lighter colors become more white.

e Color Cast:
Paired colors are complements of each other.

¢ Cyan/Red: Move the slider to change the color variation between cyan and red. Increasing
the cyan decreases the red and vice versa.

e Magenta/Green: Move the slider to change the color variation between magenta and
green. Increasing the magenta decreases the green and vice versa.

¢ Yellow/Blue: Move the slider to change the color variation between yellow and blue.
Increasing the yellow decreases the blue and vice versa.

The sample image changes as you move the sliders.
2. Click OK.

3. To track the adjustments and print the file name, print quality mode, and color settings for your job
on the edge of the page, select the Print Settings on Page box.

Selecting Press Match Advanced Color Options

If you need to proof a job that will ultimately be printed on a printing press, you can select the desired
printing press simulation.

Note: This capability is only available in the Windows and Macintosh PostScript printer drivers.

Windows

1. Inthe printer driver, click the Advanced tab.

2. Click Image Options, then click Color Configuration.

3. Click the Color Configuration drop-down menu, then click Custom.
4. Inthe Custom Color Adjustments window, click the Press Match tab.

Note: To match spot colors, click the Spot Color tab.

a. Click the Text and Graphics menu, then click the desired press match.
b. Click the Images menu, then click the desired press match.
5. Click OK.
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If you need to make additional color adjustments for your job, you can customize a press match.

1. After selecting a press match (see steps 1 to 4 above), click More Adjustments, then click the More
Adjustments button.

2. Customize the selected press match by moving these sliders:

o Lightness: Move the slider to the right to lighten colors or to the left to darken colors in your
print job. (White remains white and black remains black.)

e Saturation: Move the slider to the right to increase color intensity or to the left to decrease
color intensity without changing the darkness.

e Contrast: Move the slider to the right to increase contrast or to the left to decrease contrast.
With increased contrast, saturated colors become more saturated, darker colors become more
black, and lighter colors become more white.

e Color Cast:
Paired colors are complements of each other.

e Cyan/Red: Move the slider to change the color variation between cyan and red. Increasing
the cyan decreases the red and vice versa.

e Magenta/Green: Move the slider to change the color variation between magenta and
green. Increasing the magenta decreases the green and vice versa.

¢ Yellow/Blue: Move the slider to change the color variation between yellow and blue.
Increasing the yellow decreases the blue and vice versa.

3. Click OK twice.

Macintosh

1. Inthe print dialog box, click the Copies & Pages menu, then click Xerox Features.
2. Click Image Options, click CMYK Source Color, then click the desired press match.
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Printing in Black and White

Printing in Black and White Using a Supported Driver

Windows

1. Inthe print dialog box, click Properties, then click the Color Options tab.
2. Under Color Corrections, click Black and White, then click OK.

Macintosh

1. Inthe Print dialog box, click Copies & Pages, click Xerox Features, then click Color Options.
2. In Color Corrections, click Black and White.
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Printing Insert Pages

An insert is a divider page or slipsheet that can be inserted after a print job, between copies of a print
job, or between individual pages of a print job. You must specify the tray to use as the source for the
insert pages.

Print Insert Pages Using a Supported Driver

Windows

1. Click the Special Pages tab, then click Add Inserts.
2. Inthe Add Inserts window, select the desired options, then click OK.

Macintosh

1. Inthe Print dialog box, click Copies & Pages, click Xerox Features, then click Special Pages.
2. Click Add Inserts.
3. Select the desired settings, then click OK.
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A cover page is the first or last page of a document. The printer enables you to choose a different paper
source for the cover page than for the body of a document. For instance, use your company letterhead for
the first page of a document, or use heavyweight paper for the first and last pages of a report.

e Use any applicable paper tray as the source for printing cover pages.

e Verify that the cover page is the same size as the paper used for the rest of your document.

If you specify a different size in the driver than the tray you select as a cover pages source, your
cover(s) print on the same paper as the rest of your document.

You have the following options for cover pages:

e No Covers: Prints the first and last pages of your document from the same tray as the rest of

your document.

e Front Only: Prints the first page on paper from the specified tray.

e Back Only: Prints the back page on paper from the specified tray.

e Front and Back: Same: Front and back cover pages print from the same tray.

e Front and Back: Different: Front and back cover pages can print from different trays.

Cover Page Print Option Pages Printed on Cover
Front 1-sided printing Page 1

2-sided printing Pages 1 and 2
Back 1-sided printing Last page

2-sided printing (odd-numbered pages) Last page

2-sided printing (even-numbered pages)

Last two pages

For the back of your front cover to remain blank when 2-sided printing, page two of your document
must be blank. For the back cover of your document to remain blank, see the following table for
inserting blank pages.

Print Option

1-sided printing

Last Page of Text Blank Pages

Add one blank page at the end of the document.

2-sided printing

Odd-numbered Add two blank pages at the end of the document.

Even-numbered Add one blank page at the end of the document.
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Printing Cover Pages Using a Supported Driver

Windows

1. Inthe printer driver, click the Special Pages tab.
2. Click the Add Covers button.
3. Inthe Add Covers window, select the desired options, then click OK.

Macintosh

1. Inthe Print dialog box, click Copies & Pages, click Xerox Features, then click Add Covers.
2. Click Before document or After document.
3. Click the desired options, then click OK.
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Printing Exception Pages

The printer enables you to specify the characteristics of any pages in the print job that differ from the
settings to use for the majority of the print job.

For example, your print job contains 30 pages that print on standard-sized paper, and two pages that
must print on a different size of paper. In the Add Exceptions dialog box, set the characteristics of
these two exception pages and select the alternate paper size to use.

e Page(s): Specify the location (page or range of pages) to place the inserts. Separate individual
pages or pages ranges with commas. Specify ranges with a dash. For example, to add inserts after
pages 1,6,9,10,and 11, type: 1, 6, 9-11.

e Paper: The paper summary displays the Use Job Settings default size, color, and type of paper to
use for the exception pages. To change the paper to use for the exception pages, click the down
arrow to the right of the Paper section, then select from the following menu items:

e Other Size: Click this menu item, then click the paper size desired for the exception pages.
e Other Color: Click this menu item, then click a color for the paper to use for the exception pages.
e Other Type: Click this menu item, then click the type of paper or media to use for the
exception pages.
e 2-Sided Printing: Click the down arrow, then click the desired 2-sided printing option:
e Use Job Setting: Matches the setting used for the majority of the document.
e 1-Sided Print: Prints the exception pages on one side only.

e 2-Sided Print: Prints the exception pages on both sides of the sheet of paper with the images
printed so the job can be bound along the long edge of the sheet.

o 2-Sided Print, Flip on Short Edge: Prints the exception pages on both sides of the sheet of
paper with the images printed so the job can be bound along the short edge of the sheet.

e Job Settings: Displays the attributes of the paper for the majority of the document. If you select
Use Job Setting for any paper attribute (size, color, or type), the setting displayed here is used for
that attribute of the exception page.

Printing Exception Pages Using a Supported Driver

Windows

1. Inthe printer driver, click the Special Pages tab.
2. Click the Add Exceptions button.
3. Click the desired settings, then click OK.

Macintosh

1. Inthe Print dialog box, click Copies & Pages, then click Xerox Features.
2. Click Special Pages, then click Add Exceptions.
3. Click the desired settings, then click OK.
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Scaling

To reduce or enlarge your printed page images select a scaling value between 25 and 400 percent. The

default is 100 percent.

XEROX

XEROX

XEROX

50% 100 % 200 %

Setting Scaling Using a Supported Driver

Windows

1. Inthe printer driver, click the Paper/Output tab.
2. Click the down arrow to the right of the Paper section, then click Other Size.

3. Inthe Paper Sizes dialog box, click down arrow to the right of Scale Options, then click either:

e Automatically Scale to scale from one standard paper size to another.
e Manually Scale to scale by a percentage entered in the percentage box.

Macintosh

1. Inthe application, click File, then click Page Setup.
2. Inthe Scale box, type a value between 25 and 400 percent.
3. Click OK.
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Printing Watermarks

A watermark is additional text that can be printed across one or more pages. For example, terms like Draft
and Confidential, which you might stamp on a page before distribution, can be inserted with a watermark.

Some printer drivers allow you to:

e Create a watermark.

o Edit an existing watermark’s text, color, location, and angle.

e Place a watermark on either the first page or every page in a document.

e Print a watermark in the foreground or background or blend with the print job.
e Use a graphic for the watermark.

e Use atime stamp for the watermark.

Note: Not all applications support watermark printing.
Selecting, Creating, and Editing Watermarks Using a Supported Driver

Windows

1. Inthe printer driver, click the Layout/Watermark tab.
e Click the Watermark down arrow, then click the desired existing watermark.

e To modify a watermark, click the Watermark down arrow, then click the Edit button to display
the Watermark Editor dialog box.

e To create a new watermark, click the Watermark down arrow, click New, then use the
Watermark Editor dialog box.

2. To select watermark printing options, click the Watermark down arrow, click Options, then click the
desired printing options.
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Macintosh

1. Inthe Print dialog box, click Copies & Pages, then click Xerox Features.
e Click the Watermark down arrow, then click the desired existing watermark.
e To modify a watermark, click the Watermark down arrow, then click the Edit button to display
the Watermark Editor dialog box.
e To create a new watermark, click the Watermark down arrow, click New, then use the
Watermark Editor dialog box.
2. To select watermark printing options, click the Watermark down arrow, click Options, then click the
desired printing options.
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Printing Mirror Images

You can print pages as a mirror image. Images mirror left to right when printed.
Printing Mirror Images Using a Supported Driver

Windows

1. Inthe printer driver, click the Advanced tab.
2. Under Image Options, Mirrored Output, click Yes.

Macintosh

1. Inthe Print dialog box, click Copies & Pages, then click Xerox Features.
2. Click Advanced, click Mirrored Output, then click Enabled.
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Creating and Saving Custom Sizes

Custom size paper can print from Tray 5 (Bypass Tray). You can save custom size paper settings in a
supported printer driver. Since these custom sizes are saved in your computer’s operating system, they
are available for you to select in all your applications.

Note: For details, see Printing on Custom Size Paper on page 57.

Creating and Saving Custom Sizes Using a Supported Driver

Windows

1. Click the Paper/Output tab.

2. Click the down arrow the right of the Paper summary, then click Other Size.

3. Inthe Output Paper Size menu, click New.

4. Inthe New Custom Size dialog box, type a name in the Name box, then enter dimensions in the
Width and Height boxes.

5. Click OK.

Macintosh

1. Inthe application, click File, then click Page Setup.

2. Inthe Paper Size drop-down menu, click Manage Custom Sizes.

3. Click the + button to add a new custom page size.

4. Double click the name Untitled, then type a name for the custom size.

5. Enter the dimensions in the Width and Height boxes.

6. Click Printer Margins, then either:

e Select User Defined, then enter custom margin values.
e Select your printer from the list to use default margins.
7. Click OK.
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Job Completion Notification for Windows

You can choose to be notified when your job is done printing. A message appears in the lower right corner
of your computer screen with the name of the job and the name of the printer where it was printed.

Note: This feature is only available when your printer is connected to your computer over a network.

Enabling Job Completion Notification

1. Inthe printer driver, click the More Status button at the bottom of any tab.
2. Inthe Status window, click Notification, then click the desired option.
3. Click the X in the upper right corner of the window.
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Printing Special Job Types

You can assign the following special job types from either the Windows or Macintosh printer drivers.
e Printing and Deleting Secure Print Jobs on page 85

e Printing a Sample Set on page 86

e Delayed Printing on page 86

e Saving a Print Job to the Printer on page 87

e Sending a Print Job to a Fax Machine on page 87

Note: When using a Macintosh, click Copies & Pages, then click Xerox Features to access the Job
Type menu.

Printing and Deleting Secure Print Jobs

The secure job type allows you to print a job only after you select your name and enter your 4-10 digit
passcode on the printer’s control panel.

Printing Secure Jobs

Windows

1. Inthe printer driver, click Paper Output, click the Job Type menu, then click Secure Print.
2. Type a 4-10 digit passcode.

3. Click OK.

Macintosh

1. Inthe print dialog box, click Copies & Pages, then click Xerox Features.
2. Click the Job Type menu, then click Secure Print.

3. Type a 4-10 digit passcode.

4. Click OK.

Printing or Deleting Secure Jobs at the Printer

1. On the printer’s control panel, press the Job Status button.

2. On the touch screen, touch your document in the job list, touch Release, then enter the passcode
to print the job, or touch Delete to delete the job.
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Printing a Sample Set

The Sample Set job type allows you to send a multiple-copy job, print a sample copy of the job, and
hold the remaining copies of the job at the printer. After you review the sample copy, you can release
or delete the remaining copies.

Windows

1. Inthe printer driver, click Paper Output, click the Job Type menu, then click Sample Set.
2. Click OK.

Macintosh

1. Inthe print dialog box, click Copies & Pages, then Xerox Features.
2. Click the Job Type menu, then click Sample Set.

Printing or Deleting the Job at the Printer

1. On the printer’s control panel, press the Job Status button.
2. On the touch screen, touch the All Services button, then touch Reprint Saved Jobs.
3. Touch the folder containing your saved job, select your saved job, then press the green Start button.

Delayed Printing

A print job can be delayed for up to 24 hours from the original job submission time. Enter the time at
which you would like the job to print. Use either a 12-hour format or a 24-hour format.

Windows

1. Inthe printer driver, click Paper Output, click the Job Type menu, then click Delay Print.
2. Click the arrows to set the print time, then click OK.
3. Click OK.

Macintosh

1. Inthe print dialog box, click Copies & Pages, then Xerox Features.
2. Click the Job Type menu, then click Delay Print.
3. Click the arrows to set the print time, then click OK.
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Saving a Print Job to the Printer

The Saved Job type stores the print job in the printer so you can print it from the printer’s control panel.
The job is not automatically deleted after printing, but it can be manually deleted from the printer’s
control panel.

Windows

1. Inthe printer driver, click Paper Output, click the Job Type menu, then click Saved Job.
2. Inthe Saved Job dialog box, type a job name.
Select a folder on the printer to save the job or use the Public Folder.
3. If desired, enter the Secure Job data.
4. Click OK.
5. Click OK. The job will be saved to the printer.

Macintosh

1. Inthe print dialog box, click Copies & Pages, then Xerox Features.
2. Click the Job Type menu, click Saved Job.
3. Inthe Saved Job dialog box, type a job hame.

Select a folder on the printer to save the job or use the Public Folder.
4. If desired, enter the Secure Job data.
5. Click OK.
6. Click Print. The job will be saved to the printer

Printing or Deleting a Job at the Printer

1. On the printer’s control panel, press the Job Status button.

2. Onthe touch screen, touch your document in the job list, then touch Release to print the remaining
copies, or touch Delete to delete the job.

Sending a Print Job to a Fax Machine

Windows

In the printer driver, click Paper Output, click the Job Type menu, then click Fax.
In the Fax dialog box, enter the recipient information

If desired, click Cover Sheet, then enter the cover sheet data.

If desired, click Options, then select the desired fax options.

Click OK.

Click OK to send the fax.
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Macintosh

In the print dialog box, click Copies & Pages, then Xerox Features.
Click the Job Type menu, click Fax.

In the Fax dialog box, enter the recipient information

If desired, click Cover Sheet, then enter the cover sheet data.

If desired, click Options, then select the desired fax options.

Click OK.

Click Print to send the fax.
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This chapter includes:
e Basic Copying on page 90
e Adjusting Copy Options on page 91

See also:
System Administrator Guide at www.xerox.com/office/WC7755_WC7765_WC7775docs for

details on managing copy functions.
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Basic Copying

To make copies:
1. On the control panel, press the yellow Clear All button to remove previous copy settings.

2. Load your original documents. Use the document glass for single copies or paper that cannot be
fed using the document feeder. Use the document feeder for multiple or single pages.

wc77xx-032 wc77xx-031

Document Glass Document Feeder

e Lift the document feeder cover and place e Insert originals faceup, with page 1 on top.
the original facedown, towards the back- Adjust the paper guides so they fit against the
left corner of the document glass. originals.

e The original must be aligned to the e The document feeder accepts paper weights
matching paper size printed on the edge of from 26 Ib. Text to 74 lb. Cover (38 g/m? to
the glass. 200 g/mz).

e The maximum feeder capacity is
approximately 250 sheets of 80 g/m2 paper

3. On the control panel touch screen, touch Copy.
4. Use the alphanumeric keypad on the control panel to enter the number of copies. The number of
copies appears in the upper-right corner of the touch screen.
e To correct the number of copies entered using the alphanumeric keypad, press the C button,
then reenter the number.
o To stop a copy job, press the red Stop button on the control panel. On the touch screen, touch
Resume to continue the job, or Cancel to cancel the job completely.
5. If desired, change the copy settings. For details, see Adjusting Copy Options on page 91.

6. Press the green Start button on the control panel.
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Adjusting Copy Options

This section includes:

Basic Settings on page 91

Image Quality Adjustments on page 96
Layout Adjustments on page 98

Output Format Adjustments on page 101
Advanced Copying on page 107

Basic Settings

The Copy tab appears when the touch screen Copy button is touched. Use the Copy tab to change the
following basic settings:

Selecting Color or Black and White Copies on page 91
Reducing or Enlarging the Image on page 92
Selecting the Tray to Use for Copies on page 93
Specifying 2-Sided Originals or Copies on page 93
Collated Copies on page 93

Stapling Copies on page 94

Folding Copies on page 94

Advanced Folding Settings on page 95

Hole Punching Copies on page 96

Booklet Creation on page 96

Selecting Color or Black and White Copies

If the original document contains color, you can create copies in full color, a single color
(monochrome), or in black and white.

To select the output color:

1.

Touch Copy on the touch screen.

2. Select the output color:

e Auto Detect: this option detects the color content in the original document, and makes copies
in full color if the original is a color document, or in black only if the original is a black and
white document.

e Black & White: this option copies in black and white only. Colors in the original are converted
to shades of gray.
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3. For additional options:

a. Touch More, then select from the following:

Auto Detect: this option detects the color content in the original document, and makes
copies in full color if the original is a color document, or in black only if the original is a
black and white document.

Black & White: this option copies in black and white only. Colors in the original are
converted to shades of gray.

Color: this option copies in full color output using all four printing colors (cyan, magenta,
yellow, and black).

Single Color: this option copies in shades of a single color.

b. Touch Save.

Reducing or Enlarging the Image

Image size can be reduced to 25 % of original size or enlarged to 400 % of original size.

To reduce or enlarge the image:

1. On the touch screen, touch Copy.

2. Toreduce or enlarge the image proportionally, do one of the following:

e Touch the minus (-) or plus (+) button.
e Touch the Reduce/Enlarge box, then use the alphanumeric keypad to enter the value.

3. Toreduce or enlarge the image proportionally by a preset amount, such as to fit a particular paper size:

a. Touch More.

b. Touch Proportional %, then touch one of the Preset % buttons.

Note: You can also use the arrow buttons to change the percentage.

c. To center the image on the page, touch Auto Center.
d. Touch Save.

4. Toreduce or enlarge the width and length of the image by different percentages:
a. Touch More, then touch Independent X-Y%.
b. Touch the Width percentage arrow buttons to scale the width (X axis) of the image.

¢. Touch the Length percentage arrow buttons to scale the length (Y axis) of the image.

Note: You can also touch one of the Presets.

d. To center the image on the page, touch Auto Center.

e. Touch Save.
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Selecting the Tray to Use for Copies

To make copies on letterhead, colored paper, different paper sizes, or transparencies, select a paper
tray loaded with the desired media.

To select the tray to use:
1. Touch Copy on the touch screen.
2. Touch the desired tray under Paper Supply.
3. To use another tray:
a. Touch More.
b. Touch the desired tray.
¢. Touch Save.

Note: Auto Select allows the printer to automatically use trays containing the correct paper size
using the printer default settings for type and color.

Specifying 2-Sided Originals or Copies
The document feeder and the document glass can be used to copy one or both sides of 2-sided originals.

To copy both sides of a 2-sided original:

1. Touch Copy on the touch screen.

2. Under 2-Sided Copying, touch 2 —> 2 Sided.
3. Press the green Start button.

The document feeder automatically copies both sides of the 2-sided original.

Note: When using the document glass for 2-sided copying, a message appears at the top of the
touch screen when it is time to place the next original on the glass.

Other options are available under 2-Sided Copying:

e 1->1 Sided: Scans only one side of the originals and produces 1-sided copies.
e 1->2Sided: Scans only one side of the originals and produces 2-sided copies.
e 2 ->1Sided: Scans both sides of the originals and produces 1-sided copies.

e If you selected 2-sided copies and you want the images on side 2 to be rotated 180 degrees, touch
Rotate Side 2.

Collated Copies

You can choose to have multi-page copy jobs automatically collate. For example, when making three 1-
sided copies of a six-page document, the copies are printed in this order:

1,2,3,4,56;1,2,3,4,5,6;1,2,3,4,5,6

To choose collated copies:
1. Touch Copy on the touch screen.
2. Under Copy Output, touch Collated.
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Uncollated Copies

Uncollated copies are printed in this order:
1,1,1,2,2,2,3,3,3,4,4,4,5,5,5,6,6,6

To choose uncollated copies:

1. Touch Copy on the touch screen.

2. Under Copy Output, touch More.
3. Under Collation, touch Uncollated.
4. Touch Save.

Stapling Copies

If your printer has the Advanced Finisher, the Professional Finisher, or the Light Production Finisher,
copies can be automatically stapled.

To select stapling:
1. Touch Copy on the touch screen.
2. Under Copy Output, touch 1 Staple (Portrait) or 1 Staple (Landscape).
3. For additional stapling options, touch More.
Note: Stapling options are dependent upon paper feed orientation (short edge or long edge). If the

desired stapling option is unavailable, touch Paper Supply, then choose the appropriate tray.
Touch the help button for details.

a. Under Staple, touch 1 Staple, 2 Staples or 4 staples. The screen shows the location of the
staple on the page.

b. Touch Original Orientation to change page orientation. If necessary, touch Paper Supply to
select the tray loaded with the required paper.

c. Touch Save.

Folding Copies

If your printer has the Professional Finisher or the Light Production Finisher, copies can be
automatically folded.

The Professional Finisher provides the following folding capabilities:
e Nofolding
e Single fold
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The Light Production Finisher provides the following folding capabilities:
e No folding

e Single fold

e (Cfold (optional)

e ZFold for 8.5 x 11 in./A4 paper (optional)

e ZFold half sheet for 11 x 17 in./A3/JIS B4 paper (optional)

Notes:

» Folding options are dependent upon paper size and feed orientation.The paper must be fed
short edge. If the folding button or the desired folding option is unavailable, touch Paper
Supply, then choose the appropriate tray. Touch the help button for details.

» To mix Z Fold half sheet (11 x 17 in./A3 paper) with non-folded 8.5 x 11 in./A4 paper to create a
pullout, use Build Job. For details, see Building a Job on page 107.
1. Touch Copy on the touch screen.
2. Touch Folding under Copy Output, then touch Single Fold.

3. Under Fold Pages, touch Individually to fold and stack each page separately, or touch Together as
a Set. If desired, when Together as a Set is selected, touch Booklet Staple to staple the pages at
the fold.

4. Touch Save.

Advanced Folding Settings

Additional options can be selected when making folding settings. On the Folding screen, touch
Advanced Settings, then choose from the following:

1. Originals

e Standard: Images are printed full size

e Booklet Format: Images are reduced and printed in booklet format
2. Side 1 Image

e Image Inside Fold: The side 1 image is printed inside the fold.

e Image Outside Fold: The side 1 image is printed outside the fold.
3. Collation

e Collated: See Collated Copies on page 93

¢ Uncollated: See Uncollated Copies on page 94
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Hole Punching Copies

If your printer has the Advanced Finisher, the Professional Finisher or the Light Production Finisher,
copies can be automatically hole punched.

Note: Hole punch options are dependent on paper size and feed orientation.The paper can be fed
short edge or long edge. If the desired hole punch option is unavailable, touch Paper Supply, then
choose the tray containing the paper in the correct orientation.

1. Touch Copy on the touch screen.

2. Under Copy Output, touch More.

3. Under Hole Punch, touch 2 Hole Punch, 3 Hole Punch, or 4 Hole Punch.

Note: Hole punch settings vary based on printer configuration.

4. Touch Save.

Booklet Creation

Copies can be printed in the form of a booklet. The page images are reduced to print two images per
side of each printed page. The pages can then be folded and stapled manually, or with the appropriate
finisher, they can be folded and stapled automatically. For details, see Creating Booklets on page 101.

Image Quality Adjustments

Use the Image Quality tab to change the following image quality settings:
e Specifying the Original Type on page 96

e Adjusting the Darkness, Sharpness, and Saturation on page 97

e Automatically Suppressing Background Variations on page 97

e Adjusting the Contrast on page 97

e Selecting Color Presets on page 98

e Adjusting the Color Balance on page 98

Specifying the Original Type

The printer optimizes the image quality of the copies based on the type of images in the original
document and how the original was created.

To specify the original type:

1. Touch Copy on the touch screen, then touch the Image Quality tab.

2. Touch Original Type.

3. Inthe Original Type window:
a. On the left side of the window, touch the content type of the original document.
b. If known, select how the original was produced.
c. Touch Save.
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Adjusting the Darkness, Sharpness, and Saturation

You can lighten or darken copies and adjust the sharpness and saturation.

To adjust these image options:
1. On the touch screen, touch Copy, then touch the Image Quality tab.
2. Touch Image Options.
3. Inthe Image Options window:
a. Move the Lighten/Darken pointer up or down to lighten or darken the image.
b. Move the Sharpness pointer up or down to sharpen or soften the image.
¢. Move the Saturation pointer up or down to make the image colors more or less vivid.
d. Touch Save.

Automatically Suppressing Background Variations

When you are using originals printed on thin paper, text or images printed on one side of the paper can
sometimes be seen on the other side of the paper. To prevent this from happening in your copy, use the
Auto Suppression setting to minimize the sensitivity of the printer to variations in light background colors.

To change this setting:

1. Touch Copy on the touch screen, then touch the Image Quality tab.
2. Touch Image Enhancement.

3. Under Background Suppression, touch Auto Suppression.

4. Touch Save.

Adjusting the Contrast

Contrast is the difference between light and dark areas in an image. To reduce or increase the contrast
of the copies:

1. Touch Copy on the touch screen, then touch the Image Quality tab.
2. Touch Image Enhancement.
3. Do one of the following:

e Touch Auto Contrast to allow the printer to set the contrast.

e Touch Manual Contrast, then move the Contrast pointer up or down to increase or decrease
contrast. If you select Normal, the middle position on the slider, no changes are made to
the contrast.

4. Touch Save.
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Selecting Color Presets

If you have a color original, you can adjust the color using presets called Color Effects. For example,
the copy colors can be adjusted to be brighter or cooler.

To select a color preset:

1. On the touch screen, touch Copy, then touch the Image Quality tab.

2. Press the Color Presets button.

3. Touch the desired color preset. The sample images show how the colors are adjusted.
4. Touch Save.

Adjusting the Color Balance

If you have a color original, you can adjust the balance of the primary printing colors between cyan,
magenta, yellow and black before you print your copy.

To adjust the color balance:
1. Touch Copy on the touch screen, then touch the Image Quality tab.
2. Touch Color Balance.
3. To adjust the density levels of all four primary colors:
a. Select Basic Color on the Color Balance window.
b. Move the slider to adjust the level for each color.
4. To adjust the highlight, midtone, and shadow density levels by color:
a. Touch Advanced Color.
b. Touch the desired color.
c. Move the sliders to adjust the levels for highlights, midtones, and shadows.
d. Repeat steps 4b and 4c for additional colors.
5. Touch Save.

Layout Adjustments

Use the Layout Adjustment tab to change the following settings:
e Specifying the Orientation of the Original on page 99

e Specifying the Original Size on page 99

e Book Copying on page 99

e Shifting the Image on page 100

e Erasing the Edges of a Copy on page 100

e Inverting the Image on page 101
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Specifying the Orientation of the Original

If you plan to have the copies automatically stapled, specify the orientation:
1. On the touch screen, touch Copy, then touch the Layout Adjustment tab.
2. Touch Original Orientation, then touch the desired orientation.

a. Upright Images and Sideways Images refer to the direction the originals are loaded in the
document feeder.

b. Portrait Originals and Landscape Originals refer to the images on the originals.
3. Touch Save.

Specifying the Original Size

To specify the original size so that the correct area is copied:
1. On the touch screen, touch Copy, then touch the Layout Adjustment tab.
2. Touch Original Size.
a. Touch Auto Detect to allow the printer to automatically determine the size of the originals.

b. Touch Preset Scan Areas to specify the area to copy if it matches a standard paper size. Touch
the desired paper size in the scrolling list.

c. Touch Custom Scan Areaq, then touch the arrows to manually specify the height and width to
be copied.

d. Touch Mixed Size Originals to copy standard size originals of different sizes. Use the diagram
on the screen to determine which original sizes can be mixed in the same copy job.

3. Touch Save.

Book Copying

When copying a book, magazine, or other bound document, you can copy either the left or right page,
or both pages onto a single sheet of paper.

Note: You must use the document glass to make copies from books, magazines, or other bound
documents. Do not place bound originals in the document feeder.

To copy images from a book:

1. On the touch screen, touch Copy, then touch the Layout Adjustment tab.

2. Touch Book Copying.

3. Touch Off to copy both pages of an open book as one image on a single sheet of paper.

4. Touch Both Pages to copy the left and the right pages of an open book onto two sheets of paper:
If Binding Edge Erase is required, touch the arrows.

5. Touch Left Page Only to copy only the left page of an open book on a single sheet of paper:
If Binding Edge Erase is required, touch the arrows.

6. Touch Right Page Only to copy only the right page of an open book on a single sheet of paper:
If Binding Edge Erase is required, touch the arrows.

7. Touch Save.
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Shifting the Image

You can change the placement of the image on the copy page. This is useful if the image size is smaller
than the page size.

Originals must be positioned correctly for image shift to work correctly. For details, see Basic Copying
on page 90.

e Document feeder: position originals faceup, left (long) edge entering the feeder first.

e Document glass: position originals facedown, in the back-left corner of the document glass, long
edge to the left.

To change image placement:
1. Touch Copy on the touch screen, then touch the Layout Adjustment tab.
2. Touch Image Shift.
3. Touch Auto Center to center the image on the page.
4. To specify the position of the image:
a. Touch Margin Shift.
b. Touch the arrow buttons to specify the amount of Up/Down and Left/Right shift for Side 1.
c. For 2-sided copies, touch the arrow buttons to specify the amount of Up/Down and Left/Right
shift for Side 2 or select Mirror Side 1.

Note: If preset values were previously saved by the system administrator, select the preset in the
lower-left corner of the window.

5. Touch Save.

Erasing the Edges of a Copy

You can erase content from the edges of your copies by specifying the amount to erase on the right,
left, top, and bottom edge.

To erase edges on copies:
1. Touch Copy on the touch screen, then touch the Layout Adjustment tab.
2. Touch Edge Erase.
3. To erase all the edges by the same amount:
a. Touch All Edges.
b. Touch the arrow buttons to specify the amount to erase from all edges on Side 1.
4. To specify different amounts for the edges:
a. Touch Individual Edges.
b. Touch Side 1, then touch the arrow buttons to specify the amount to erase from each edge.
c. Touch Side 2, then touch the arrow buttons to specify the amount to erase from each edge on
Side 2 or touch Mirror Side 1.

Note: If preset values were previously saved by the system administrator, such as Hole Punch erase,
touch the preset in the lower-left corner of the window.

5. Touch Save.
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Inverting the Image

Originals can be printed as mirror images; this reflects each image left to right on the page.
Originals can be printed as negative images; the positive image is printed as a negative.

To invert images:

1. Touch Copy on the touch screen, then touch the Layout Adjustment tab.

2. Touch Invert Image.

3. To mirror images, touch Mirror Image. The default is Normal Image, which does not mirror the images.
4

To create negative images, touch Negative Image. The default is Positive Image, which does not
print the image as a negative.

5. Touch Save.

Output Format Adjustments

Use the Output Format tab to make the following changes:
e Creating Booklets on page 101

e Including Covers on page 102

e Chapter Start Pagination on page 103

e Adding Inserts on page 103

e Specifying Exception Pages on page 104

e Adding Annotations on page 105

e Inserting Transparency Separators on page 106

e Printing Multiple Images on a Page on page 106

e Repeating Images on a Sheet of Paper on page 107

Creating Booklets

Copies can be printed in the form of a booklet. The page images are reduced to print two images per
side of each printed page. The pages can then be folded and stapled manually, or with the appropriate
finisher, they can be folded and stapled automatically.

Note: In this mode, the printer does not print the copies until it has scanned all of the originals.

To create a booklet:

1. Touch Copy on the touch screen, then touch the Output Format tab.

2. Touch Booklet Creation, then touch On.

3. To Fold and Staple using the finisher:
a. Touch Fold & Staple.
b. To specify a specific tray, touch Paper Supply, touch the desired tray, then touch Save.
c. To specify 2 sided originals, touch Original Input, then touch 2 Sided Originals.
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4. To fold only using the finisher:
a. Touch Fold Only.
b. To select a paper tray, touch Paper Supply, touch the desired tray, then touch Save.
c. To specify 2 sided originals, touch Original Input, then touch 2 Sided Originals.

5. Touch Save.

To add covers to a copy job, select different trays for the first and last page. Those trays can be loaded
with heavier stock, color or pre-printed paper. The covers can be blank or printed.

The paper used for the covers must be the same size as the paper used for the rest of
the document.

To select the type of covers and the tray to use for the cover paper:
1. Touch Copy on the touch screen.
2. Under Paper Supply, touch the tray containing the paper for the body pages of the job.

If the paper supply is set to Auto Select, covers are disabled.

3. Touch the Output Format tab.

4, Touch Special Pages, then touch Covers.

5. Toinclude both a front and back cover that use the same tray and printing option:
a. Touch Front & Back Same under Covers Options.

b. Touch a printing option for the covers: Blank Cover, Print on Side 1, Print on Side 2, or Print on
Both Sides.

c. If you selected Print on Both Sides, the image on Side 2 can be rotated 180 degrees by
touching Rotate Side 2.

d. Touch the tray containing the cover paper under Paper Supply, then touch Save.
6. Toinclude a front and back cover that do not use the same tray or printing option:
a. Touch Front & Back Different.

b. Touch a printing option for the Front Cover: Blank Cover, Print on Side 1, Print on Side 2, or
Print on Both Sides.

c. If you selected Print on Both Sides, the image on Side 2 can be rotated 180 degrees by
touching Rotate Side 2.

d. Touch the tray containing the cover paper under Paper Supply, then touch Save.

Touch a printing option for the Back Cover: Blank Cover, Print on Side 1, Print on Side 2, or
Print on Both Sides.

f. If you selected Print on Both Sides, the image on Side 2 can be rotated 180 degrees by
touching Rotate Side 2.

g. Touch the tray containing the cover paper under Paper Supply, then touch Save.
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7. Toinclude only a front cover or only a back cover:
a. Touch Front Cover Only or Back Cover Only.

b. Touch a printing option for the covers: Blank Cover, Print on Side 1, Print on Side 2, or Print on
Both Sides.

c. If you selected Print on Both Sides, the image on Side 2 can be rotated 180 degrees by
touching Rotate Side 2.

d. Touch the tray containing the cover paper under Paper Supply.
8. Touch Save. The cover settings are displayed in the Special Pages window.

Note: To edit or delete a cover, touch the cover in the list, then touch the desired operation in the
drop-down menu.

9. Touch Save on the Special Pages window.

Chapter Start Pagination

To set each chapter to start on the front or back of a page, when you copy 2-sided, define the chapter’s
starting page number. If necessary, one side of the paper is left blank so that the chapter starts on the
requested side of the paper.

To set the start side of particular pages:
1. Touch Copy on the touch screen.
2. Under Paper Supply, touch the tray containing the paper for the body pages of the job.

Note: If the paper supply is set to Auto Select, Chapter Start is disabled.

Touch the Output Format tab.

Touch Special Pages, then touch Chapter Starts.

Touch the Page Number box, then use the alphanumeric keypad to enter the page number.
Touch either On Right Page, the front side of the paper, or On Left Page.

Touch Add. That page is added to the list on the right of the window.

Repeat steps 5 to 7 for other pages to be set.

Touch Close. The page settings are displayed in the list on the right side of the Special Pages window.

20 XN Vs W

0. Touch Save.

Adding Inserts
Blank or pre-printed sheets can be inserted at specific locations in your copy job. The tray to be used for
the inserts can be specified.

Note: The paper used for the inserts must have the same width as the paper used for the rest of the
document. Inserts cannot be added if Booklet Creation is selected.

To add inserts:
1. Touch Copy on the touch screen, then touch the Output Format tab.
Note: If the paper supply is set to Auto Select, inserts cannot be added.

2. Touch Special Pages, then touch Inserts.
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Touch the After Page Number box, then use the alphanumeric keypad to enter the page number.

Touch the Insert Quantity arrow buttons to specify the number of sheets to be inserted at
that location.

To specify the paper tray to be used for the insert:

a. Touch Paper Supply.

b. Touch the desired tray.

¢. Touch Save.

Touch Add. The insert appears in the list on the right of the window.

Repeat steps 3 to 6 to add additional inserts.

Touch Close. The inserts are displayed in the list on the right side of the Special Pages window.

Note: To edit or delete an insert, touch the insert in the list, then touch the desired operation in the
drop-down menu.

Touch Save.

Specifying Exception Pages

Exception pages can be printed in a copy job using paper from a different tray.

Notes:

e The paper used for the exception pages must be the same size as the paper used for the rest of
the document.

» Exception pages cannot be added if Booklet Creation is selected.

To select the exception pages:

1.

On the touch screen, touch Copy, then touch the Output Format tab.
Note: If the paper supply is set to Auto Select, exception pages are disabled.

Touch Special Pages, then touch Exceptions.

Using the alphanumeric keypad, enter the starting value for the range of the pages to be printed
on paper from another tray. To enter the end of the range, touch the end range box, then enter the
value using the alphanumeric keypad. To specify a single page as an exception, enter its number as
the start and end of the range.

To specify the paper used for the exception pages:

a. Touch Paper Supply.

b. Touch the tray containing paper for the exception pages.

c. Touch Save.

Touch Add. The exception pages are added to the list on the right of the window.
Repeat steps 3 to 5 to add additional exception pages.

Touch Close. The exception pages are displayed in the list.

Note: To edit or delete an exception page, touch the page in the list, then touch the desired
operation in the drop-down menu.

Touch Save.
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Adding Annotations

Annotations, such as page numbers and the date, can be automatically added to copies.

Notes:

» Annotations are not added to covers, tabs, inserts, or blank chapter start pages.

« Annotations cannot be added if Booklet Creation is selected.

To add annotations:

1. On the touch screen, touch Copy, then touch the Output Format tab.

2. Touch Annotations.

3. Toinsert page numbers:

a.
b.
C.

d.
e.

f.

Touch Page Numbers, then touch On.
Touch Apply To to include the page number on all pages or all pages except the first.

Touch the Starting Page Number box, then use the alphanumeric keypad to enter the
page number.

Under Position, touch an arrow to position the page number in the header or footer.
Touch Save. The # symbol is shown on the sample page(s).
To change the text formatting, touch Format & Style, choose settings, then touch Save.

4. To insert a comment:

a.
b.

d.
e.

f.

Touch Comment, then touch On.

Touch Apply To to include the comment on all pages, all pages except the first, or the first
page only.

Touch an existing comment. To create a new comment, touch a blank row, enter the text for
the comment, up to 50 characters, using the touch screen keyboard, then touch Save.
Under Position, touch an arrow to position the selected comment in the header or footer.
Touch Save. The comment location is shown on the sample page(s).

To change the text formatting, touch Format & Style, choose settings, then touch Save.

5. Toinsert the current date:

a.
b.

Touch Date, then touch On.

Touch Apply To to include the date on all pages, all pages except the first page, or the first
page only.

Under Position, touch an arrow button to position the date in the header or footer.

Touch Save. The date location is shown on the sample page(s).

To change the text formatting, touch Format & Style, choose settings, then touch Save.
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6.

7.

To insert a Bates Stamp:
a. Touch Bates Stamp, then touch On.

b. Touch the Starting Page Number box, then use the alphanumeric keypad to enter the starting
page number. Leading zeros can be included.

¢. Touch Apply To to include the Bates Stamp on all pages or all pages except the first page.

Touch an existing prefix in the list. To create a new prefix, touch a blank row, enter the text for
the prefix, up to 8 characters, using the touch screen keyboard, then touch Save.

e. Under Position, touch an arrow button to position the Bates Stamp in the header or footer.
f. Touch Save. The Bates Stamp location is shown on the sample page(s).

g. To change the text formatting, touch Format & Style, choose settings, then touch Save.
Touch Save.

Inserting Transparency Separators

Blank sheets of paper can be automatically inserted between each printed transparency. The size and
orientation of the separators must be the same as the transparencies.

Note: If the paper supply is set to Auto Select, transparency separators cannot be selected.

To select transparency separators:

1.
2.
3.

Touch Copy on the touch screen, then touch the Output Format tab.
Touch Transparency Separators, then touch On.

Under Separator Supply, touch the tray containing the paper to use for the separators. If the tray
containing the separator paper is not displayed, touch More, touch the desired tray, then touch Save.

Under Transparency Supply, touch the tray containing the transparencies. If the tray containing
the transparencies is not displayed, touch More, touch the desired tray, then touch Save.

Touch Save.

Printing Multiple Images on a Page

You can copy a single image that prints several times onto one side of a sheet of paper. The size of the
images are reduced proportionally to fit on the paper.

To print multiple original images on a sheet:

1.
2.
3.

Touch Copy on the touch screen, then touch the Output Format tab.

Touch Page Layout, then touch Pages per Side.

Touch the number of original pages for each side of the paper. To specify a different number:
a. Touch Specify Rows & Columns.

b. Touch the arrow buttons to change the number of rows.

¢. Touch the arrow buttons to change the number of columns.

Note: The right side of the window contains a diagram of the image layout.

Touch Original Orientation, then touch Portrait Originals or Landscape Originals.
Touch Save.
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Repeating Images on a Sheet of Paper

Several copies of one original image can be copied onto one side of a sheet of paper. This is useful in
making multiple copies of a small image.

To repeat an image on a sheet:

1. Touch Copy on the touch screen, then touch the Output Format tab.

2. Touch Page Layout, then touch Repeat Image.

3. Touch the appropriate button to repeat the image two, four, six, or nine times on each side of the paper.

Note: The right side of the window contains a diagram of the image layout.

4. To specify a different number:
a. Touch Specify Rows & Columns.
b. Touch the arrow buttons to change the number of rows.
c. Touch the arrow buttons to change the number of columns.
Note: The right side of the window contains a diagram of the image layout.
5. Touch Auto Repeat to allow the printer to automatically determine the maximum number of rows
and columns that can be placed on the currently selected paper size.
6. Touch Original Orientation, then touch Portrait Originals or Landscape Originals
7. Touch Save.

Advanced Copying

Use the Job Assembly tab to change the following settings:
e Building a Job on page 107

e Printing a Sample Copy on page 108

e Saving Copy Settings on page 109

e Retrieving Saved Copy Settings on page 109

Building a Job

Complex copy jobs that include a variety of originals requiring different copy settings can be produced
using this feature. Each “segment” can have different copy settings. After all segments are
programmed and scanned (the page images are stored temporarily in the printer), the complete copy
job is printed.
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To build a copy job:
1. Touch Copy on the touch screen.
2. Program and scan the first segment:
a. Load the originals for the first segment.

b. Touch the desired copy settings (layout adjustments, image adjustments, etc.), for the
first segment.

c. Touch the Job Assembly tab.

d. Touch Build Job, then touch On.

e. Press the green Start button on the control panel to scan the first set of originals.
3. Program and scan additional segments:

a. Load the originals for the next segment.

b. When the Build Job window appears, touch Program Next Segment in the upper-right corner
of the window.

¢. Using the appropriate tabs, touch the required settings for that segment.
d. Pressthe green Start button to scan the originals for that segment.

4. Repeat step 3 for each remaining segment.

5. When all of the segments have been programmed and scanned:

a. If the Build Job window is not visible on the display screen, touch the Job Assembly tab, then
touch Build Job.

b. Using the alphanumeric keypad, enter the number of copies in the Quantity for Final Job box.
c. Touch the Print the Job button in the upper-right corner of the Build Job window.
The Job Progress window displays. If necessary, the job can be cancelled by touching Delete.

Printing a Sample Copy

With a complicated copy job, it can be helpful to print a test copy before printing multiple copies. This
feature prints a single copy and holds the remaining copies. After inspection of the sample, the
remaining copies can be printed (using the same settings), or cancelled.

Note: The sample copy is not counted as part of the total quantity selected. For example, when
copying a book, if three is entered as the number of desired copies; one copy of the book will be
printed, and three other copies will be held until they are released for printing (four copies total).

To print the sample copy:

1. Touch Copy on the touch screen, then touch the desired copy settings.
Touch the Job Assembly tab.

Touch Sample Job, then touch On.

Touch Save.

s whN

Press the green Start button on the control panel. The sample set is printed.

To print the remaining copies or delete the job:
1. To release and print the remaining copies of the job, touch Release.
2. If the sample copy is unsatisfactory, touch Delete.
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Saving Copy Settings

To use a particular combination of copy settings for future copy jobs, the settings can be saved with a
name and retrieved for later use with other copy jobs.

To save the current copy settings:

1. On the touch screen, touch Copy.

2. Touch the Job Assembly tab, then touch Save Current Settings.

3. Under Setting, touch the down arrow button and select one of the available rows from the list.

Note: If an existing row is selected, its saved settings can be replaced with the current settings, or
the saved settings in that row can be deleted.

4. Enter a name for the saved settings using the touch screen keyboard.
5. Touch Save.

Retrieving Saved Copy Settings

You can retrieve and use any previously saved copy settings for current jobs.

Note: To save the copy settings with a name, see Saving Copy Settings on page 109.
To retrieve saved settings:
1. On the touch screen, touch Copy.

2. Touch the Job Assembly tab, then touch Retrieve Saved Settings.
3. Touch the desired saved setting.

Note: To delete a saved setting, touch it, then touch the Delete Settings button.
4. Touch Load Settings. The saved settings are loaded for the current copy job.
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Scanning

This chapter includes:

e Scanning Overview on page 112

e Loading Original Documents on page 113

e ScantoaFolder on page 114

e Scan to a Network File Repository on page 116
e Scan to an Email Address on page 117

e ScantoHome on page 119

e Using the Xerox Scan Utility on page 120

e Setting Scan Options on page 132

See also:

System Administrator Guide at www.xerox.com/office/WC7755_WC7765_WC7775docs for
details on setting up scanning.
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Scanning Overview

Scanning is an optional printer feature providing several methods for scanning and storing an original
document. The scanning procedure used with the WorkCentre 7755/7765/7775 differs from that of
desktop scanners. Because the printer is normally connected to a network rather than directly to a
single computer, you select a destination for the scanned image at the printer.

The printer supports the following scanning capabilities:

e Scan a document and store the image on the printer’s hard drive.

e Scan original document to a document repository on a network server.

e Scan original document to an email address.

e Scan original document to your home directory.

e Create scan templates and download scanned images to your computer using Xerox Scan Utility.
e Import scanned images into applications using TWAIN and WIA.

Notes:
e The printer must be connected to a network to retrieve a scan file.

» Scanning must be enabled before use. For details, see the System Administrator Guide at
www.xerox.com/office/WC7755_WC7765_WC7775docs or CentreWare IS help.

= Print, copy, and fax jobs can print while you are scanning original documents or downloading
files from the printer’s hard drive.
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Loading Original Documents

All scanning tasks begin with loading the original document in the printer. Use the document glass for
single page jobs, or originals that will not feed through the document feeder. Use the document feeder
for multiple or single page jobs.

Using the Document Glass

Lift the document feeder cover and place the original facedown, towards the back, left corner of the
document glass as shown.

wc77xx-032

Using the Document Feeder

Insert originals faceup. Adjust the paper guides so they fit against the originals.

wc77xx-031
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Scan to a Folder

This section includes:

e Scanning to the Public Folder on page 114

e Retrieving Scan Files to Your Computer Using CentreWare IS on page 115
e Using a Private Folder on page 115

Scanning to a folder is the simplest scanning method. A folder is storage space in the printer’s internal
hard drive. When you scan a document at the printer, the scan file is stored in folder on the hard drive.
You then retrieve the stored scan file to your computer using CentreWare IS.

The printer provides a Public Folder to store scanned images. This folder is available to all users without
requiring a password. Your scanned documents can be viewed by all users. If desired, you can create a
password-protected private folder accessible only by you. See Using a Private Folder on page 115.

Note: Scanning to a folder must be enabled by the system administrator.

Scanning to the Public Folder

Documents can be scanned to, and retrieved from, the folder without a password.
1. Load the original on the document glass or in the document feeder.

2. Press the Services Home button.

3. On the touch screen, touch Workflow Scanning.

4, From All Templates, touch _PUBLIC.

Notes:

e When you scan a document to a folder, the default settings create a 1-sided, color PDF
document. These settings can be changed using the printer’s control panel, or at your computer
using CentreWare IS.

» Settings chosen using CentreWare IS can be overridden using the printer’s touch screen.

5. To change any of the scan settings, use the four buttons at the bottom of the touch screen: Output
Color, 2-Sided Scanning, Original Type and Scan Presets, to select the desired options for the
scan. For details, see Setting Scan Options on page 132.

6. Press the green Start button. The Job Progress screen appears on the printer’s control panel.

When the scan is complete, the printer’s touch screen will redisplay the Workflow Scanning tab. The file
is stored in the Public folder on the printer’s hard drive. You can then retrieve the file to your computer
using CentreWare IS.
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Retrieving Scan Files to Your Computer Using CentreWare IS

Scanned files are retrieved by copying them from the printer to your computer’s hard drive.

1. At your computer, launch your Web browser.

2. Type the printer’s IP address into the Web browser’s address bar, then press Enter to open
CentreWare IS.
Note: If you don’t know your printer’s IP address, see Finding The Printer’s IP Address on page 38.

3. Click the Scan tab.

4. Inthe Display section, click the Mailboxes button.

5. Inthe Scan to Mailbox section, click Default Public Folder. The Folder Contents window contains
your image file.
Note: If your image file is not displayed, click Update View.

6. Inthe Action section, select one of the following options, then click the Go button:

e Download: saves a copy of the file to your computer. When prompted, click Save, then choose
where you wish the file to be saved on your computer. You can then open the file or close the
dialog box.

e Reprint: prints the file on the printer without saving a copy of the file to your computer.

e Delete: deletes the file from the mailbox. When prompted, click OK to delete the file or Cancel:
cancel the operation.

Using a Private Folder

Your system administrator may have created private folders on the printer. A private folder may require
the use of a password. After selecting the private folder, touch Enter Password for Folder, then enter
the password for the folder using the touch screen keyboard.

You can use CentreWare IS to create a private folder yourself using the following procedure.

Creating a Private Folder

1. Launch your Web browser.

2. Type the printer’s IP address into the Web browser’s address bar, then press Enter to open
CentreWare IS.
Note: If you don’t know your printer’s IP address, see Finding The Printer’s IP Address on page 38.

Click the Scan tab.

In the Display section, click the Mailboxes button.

In the Scan to Mailbox section, click Create Folder.

Enter a name for the folder and, if desired, create a password.
Click the Apply button.

No v &sWw

Your private folder is now available for use, and will appear in the folder list in CentreWare IS and on
the printer’s touch screen under Local Templates, indicating that its contents will be stored locally on
the printer’s hard drive.
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Scan to a Network File Repository

Scanning to a network file repository is a feature of Workflow Scanning. Documents you scan are sent
to a document repository on a network server configured by your system administrator.

Note: Scanning to a network file repository must be enabled by your system administrator.

To use the scan to a network file repository feature:

1. On the printer’s control panel, press the Services Home button.

2. Touch Workflow Scanning.

3. From All Templates, select the template created by your system administrator.

Note: Templates must be created by the system administrator. For details, see the System
Administrator Guide at www.xerox.com/office/WC7755 WC7765 WC7775docs.

4. The template defines the scan settings as well as the destination of the image. To change any of
the scan settings, use the four buttons at the bottom of the control panel, Output Color, 2-Sided
Scanning, Original Type and Scan Presets, to select the desired options for the scan. For details,
see Setting Scan Options on page 132.

5. Place the document original in the document feeder or on the document glass, then press the
green Start button.
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Scan to an Email Address

Scanning to an email address is a feature of Workflow Scanning. Scanned documents are sent as
attachments to email.

Note: Scanning to an email address must be enabled by your system administrator.

To send a scanned image to an email address:

1.
2.
3.

On the printer’s control panel, press the Services Home button.

Touch the E-Mail icon.

To change the From... address, touch From...

Note: The From... address was configured by your system administrator. You may or may not be
able to change the From... address.

Enter the email address using the touch screen keyboard, then touch Save.

Touch New Recipient.

You can enter the full email address using the touch screen keyboard or by getting the email
address from the Address Book. Enter the recipient name or part of the name, depending on how
the address book is set up, then touch Search.

Touch Add to add the recipient to the list.

Repeat steps 4 to 5 to add additional recipients to the list. When all recipients have been added to
the list, touch Close.

A default subject is provided for the email. To change the subject, touch Subject, then enter the
new subject using the touch screen keyboard. When finished, touch Save.

Place the document original in the document feeder or on the document glass, then press the
green Start button.

To send a scanned image to an email address in the Address Book:

1. On the printer’s control panel, press the Services Home button.

2. Touch E-mail.

3. Touch Address Book.

4, Touch Public in the Address Book’s drop-down list.

5. Enter the name of the recipient of your email.

6. Touch Search.

7. The public address book searches for the name and displays a list. Select the name from the list.

8. Touch To:, then touch Close.

9. Place the document to email in the document feeder or on the document glass, then press the
green Start button.
If desired, use the four buttons at the bottom of the touch screen: Output Color, 2-Sided
Scanning, Original Type and Scan Presets, to select the desired options for the scan.

See also:

Setting Scan Options on page 132
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Setting Email Options

You can override the template settings and change the following email settings:

File Name
File Format
Message
Reply To

To change the File Name, Message or Reply to email options:

1.
2.
3.

4,

On the printer’s control panel, touch the Services Home button.
Touch E-Mail, then touch the E-mail Options tab.

Touch File Name, Message, or Reply to, then delete or modify the default text using the touch
screen keyboard.

Touch Save.

To change the file format:

1.

2.
3.
4

On the printer’s control panel, press the Services Home button.

Touch E-Mail, then touch the E-mail Options tab.

Touch File Format, then select the desired file type. Each file format is described when selected.
Touch Save to accept the file format.
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Scan to Home

The Scan to Home feature allows you to scan a document to your home directory.

Note: Scan to Home must be enabled by your system administrator.

To use the Scan to Home feature:
1. On the printer’s control panel, press the Services Home button.
2. From All Templates, select the template created by your system administrator.

3. The template defines the scan settings as well as the destination of the image. To change any of
the scan settings, touch the four buttons at the bottom of the touch screen, Output Color, 2-Sided
Scanning, Original Type and Scan Presets, to select the desired options for the scan. For details,
see Setting Scan Options on page 132.

4. Place the document original in the document feeder or on the document glass, then press the
green Start button.
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Using the Xerox Scan Utility

This section includes:

Scanning Using the Xerox Scan Utility on page 120

Creating Scan Templates on page 121

Deleting Scan Templates on page 123

Managing Xerox Scan Utility Folder and Email Profiles on page 124
Importing Scanned Files into an Application on page 129

The Xerox Scan Utility (XSU) allows you to scan images from the printer directly to your computer.
Scanned images are not stored in the printer. Using XSU, you can create scan templates, preview
images, copy images to a folder on your computer, and copy images to email.

Note: You must install the scan drivers to use the Xerox Scan Utility. For details, see the System
Administrator Guide at www.xerox.com/office/WC7755 WC7765 WC7775docs.

Scanning Using the Xerox Scan Utility

At the printer, load your original on the document glass or in the document feeder.

1.
2.
3.

Press the Services Home button.

On the touch screen, touch Workflow Scanning.

From All Templates, select your template in the list. To create a template, see Creating Scan
Templates on page 121.

Note: Settings chosen using CentreWare IS can be overridden using the printer’s touch screen.

The Workflow Scanning screen appears. To change any of the scan settings, use the four buttons
at the bottom of the touch screen, Output Color, 2-Sided Scanning, Original Type and Scan
Presets, to select the desired options for the scan. For details, see Setting Scan Options on

page 132.

Press the green Start button. The Job Progress screen is displayed on the printer’s touch screen.
When the scan is complete, the printer’s touch screen will redisplay the Workflow Scanning tab.
Your file is stored in the selected folder on the destination computer’s hard drive.

Notes:
« A password may be required when scanning to a template. Contact your system administrator.

« If scanning fails, a confirmation page will print. If the scan completes successfully, the page will
not print. For details, see the System Administrator Guide at
www.xerox.com/office/WC7755_WC7765_WC7775docs.
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Creating Scan Templates

This section includes:

e Creating a Template with an Image View Setting on page 121

e Creating a Template to Scan Images Directly to a Folder on page 122
e Template File Formats and Names on page 123

e Creating Unique Image File Names on page 123

Scan templates contain file type, resolution, and document original size settings. You can specify
additional settings to retain thumbnail images, or you can select a folder destination so that when
images are scanned, they are automatically copied into a designated folder on your computer.

You must create a scan template before you can download images to your computer or import images
to applications using TWAIN or WIA.

Creating a Template with an Image View Setting

To create a new template or edit an existing template with the option to retain thumbnail images in
the XSU:

1. Access the Xerox Scan Utility on your computer:

¢ Windows: Right-click the Xerox Scan Utility icon in the taskbar, then select Open Xerox Scan
Utility. If the icon does not appear in the taskbar, click Start, select All Programs, or Programs if
you are using Windows Classic View, select Xerox Office Printing > Scanning > Xerox Scan Utility.

e Macintosh: Navigate to Applications > Xerox > Xerox Scan Ultility, then double-click the Xerox
Scan Utility.

2. Click the Scan Settings tab, then select the desired settings for the template: Color, Black and
White, Original Size, Resolution, Original Type, File Format, and Sides to Scan.

3. Click the Preview image in Xerox Scan Utility option to view the scanned image in both the Scan
to Email and Copy to Folder tabs. From these tabs you can select the appropriate folder or email
profile settings to use with your scanned images.

4. Select one of the following options:

e To create a new template for the settings you selected, type the name for the new template in
the Saved Template Settings field.

o To edit an existing template with the settings you selected, select a template from the list
displayed in the Saved Template Settings drop-down list.

5. Edit the settings, then click Save to save the settings for the template.

Note: Spaces are not permitted in template names.

The template will now appear in the list of templates on the Workflow Scanning tab on the printer’s
touch screen.
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Creating a Template to Scan Images Directly to a Folder

To create a template that places scanned images in a specific folder destination on your computer:
1. Access the Xerox Scan Utility on your computer:

e Windows: Right-click the Xerox Scan Utility icon in the taskbar, then select Open Xerox Scan
Utility. If the icon does not appear in the taskbar, click Start, select All Programs, or Programs if
you are using Windows Classic View, select Xerox Office Printing > Scanning > Xerox Scan Utility.

e Macintosh: Navigate to Applications > Xerox > Xerox Scan Utility, then double-click the Xerox
Scan Utility.

2. Click the Scan Settings tab, then select the desired settings for the template: Color, Black and
White, Original Size, Resolution, Original Type, File Format, and Sides to Scan.

3. Click the Send image directly to folder option to send the scanned images directly to a
designated folder without first viewing the images. Enter information in the following fields:

a. To create a unique file name for one or more of the scanned images in the thumbnail view,
enter a file name in the Base File Name field.

b. Enter the folder path where you want to save the file in the Save To field, or click the Browse
button to locate the folder.

c. Select one of the following options:

e Leave the Save a copy in Xerox Scan Utility option selected. This enables thumbnail views
of the scanned images to remain in the Copy to Folder and Scan to Email tabs. This is the
default setting.

e Clear the check mark in the Save a copy in Xerox Scan Utility option. This turns off
thumbnail views of the scanned images.

4. Select one of the following options:

e To create a new template for the settings you selected: type the name for the new template in
the Saved Template Settings field.

e To edit an existing template with the settings you selected: Select a template from the list
displayed in the Saved Template Settings drop-down list.

5. Click the Save button to save the settings for the new or revised template.

The template will now appear in the list of templates on the Workflow Scanning tab on the printer’s
touch screen.
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Template File Formats and Names

Supported file types:

JPEG

Multi-page TIFF
PDF

PDF/A
Single-page TIFF
XPS

Unsupported file types:

BMP
GIF

Single-page File Naming Format (JPEG and Single-page TIFF): DOC_xxx_yyyy-mm-dd_hh-mm-ss.JPG
(or .tif) where xxx = sequence (page) number, etc.

Multi-page File Naming Format (Multi-page TIFF, PDF, PDF/A, XPS): DOC_yyyy-mm-dd_hh-mm-ss.tif
(or .pdf, or .xps).

Creating Unique Image File Names

When you assign a nhame to a scanned image, the image displays with the date and time the image
was scanned appended to the name. For example:

If you enter the name report as the name for an image that was scanned at 1:45:15 PM on July 1,
2008, the image name is: report_2008-07-01_13.45.15.xxx.

If you enter the name report for several images that were scanned at varying times on July 1, 2008,
the names are: report_2008-07-01_13.45.15.xxx, report_2008-07-01_13.45.25.xxx, and
report_2008-07-01_13.47.32.xxx. The date and time information is unique for all scanned images.

Deleting Scan Templates

To delete a scan template:

1.

&~ wN

Access the Xerox Scan Utility on your computer:

e Windows: Right-click the Xerox Scan Utility icon in the taskbar, then select Open Xerox Scan
Utility. If the icon does not appear in the taskbar, click Start, select All Programs, or Programs if
you are using Windows Classic View, select Xerox Office Printing > Scanning > Xerox Scan Utility.

¢ Macintosh: Navigate to Applications > Xerox > Xerox Scan Utility, then double-click the Xerox
Scan Utility.

Click the Scan Settings tab.
Select the template you want to delete in the Saved Template Settings drop-down list.
Click the Delete button.

When prompted, confirm that you want to delete the template. The template will be deleted from
the template list in Xerox Scan Utility and from the template list on the printer’s touch screen.
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Managing Xerox Scan Utility Folder and Email Profiles

This section includes:

e Creating or Editing Email Profiles on page 124
e Deleting Email Profiles on page 125

e Creating or Editing Folder Profiles on page 125
e Deleting Folder Profiles on page 126

With the Xerox Scan Utility, you can create profiles to be reused when sending scanned images as
email attachments or when copying scanned images to specific folders. Profiles eliminate the need for
re-entering the same email or folder destination information.

Creating or Editing Email Profiles

To create or revise an email profile:
1. Access the Xerox Scan Utility on your computer:

e Windows: Right-click the Xerox Scan Utility icon in the taskbar, then select Open Xerox Scan
Utility. If the icon does not appear in the taskbar, click Start, select All Programs, or Programs if
you are using Windows Classic View, select Xerox Office Printing > Scanning > Xerox Scan Utility.

e Macintosh: Navigate to Applications > Xerox > Xerox Scan Utility, then double-click the Xerox
Scan Utility.

2. Click the Scan to Email tab.
3. Select one of the following options:
e To create a new profile, enter the name for the new profile in the Email Profiles field.

e To edit an existing profile, select a profile from the list displayed in the Email Profiles drop-
down list.

4. To create a unique name for one or more of the scanned images in the thumbnail view:
a. Select the images, then enter a file name in the Base Attachment Name field.
b. Enter the appropriate information in the To, CC, Subject, and Message fields.

5. Click the Save button to save the settings for the new or revised profile.

Note: When you enter a name for images in the Base Attachment Name field, and save the profile,
the file name is the name you entered and the unique date and time each image was scanned.

See also:
Creating Unique Image File Names on page 123
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Deleting Email Profiles

To delete an email profile:
1. Access the Xerox Scan Utility on your computer:

e Windows: Right-click the Xerox Scan Utility icon in the taskbar, then select Open Xerox Scan
Utility. If the icon does not appear in the taskbar, click Start, select All Programs, or Programs if
you are using Windows Classic View, select Xerox Office Printing > Scanning > Xerox Scan Utility.

e Macintosh: Navigate to Applications > Xerox > Xerox Scan Utility, then double-click the Xerox
Scan Utility.

Click the Scan to Email tab.

Select the profile you want to delete in the Email Profiles drop-down list.
Click the Delete button.

When prompted, confirm that you want to delete the profile.
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Creating or Editing Folder Profiles

To create or revise a folder profile:
1. Access the Xerox Scan Utility on your computer:

e Windows: Right-click the Xerox Scan Utility icon in the taskbar, then select Open Xerox Scan
Utility. If the icon does not appear in the taskbar, click Start, select All Programs, or Programs if
you are using Windows Classic View, select Xerox Office Printing > Scanning > Xerox Scan Utility.

e Macintosh: Navigate to Applications > Xerox > Xerox Scan Utility, then double-click the Xerox
Scan Utility.

2. Click the Copy to Folder tab.
3. Select one of the following options:
e To create a new profile, enter the name for the new profile in the Folder Profiles field.

» To edit an existing profile, select a profile from the list displayed in the Folder Profiles drop-
down list.

4. To create a unique name for one or more of the scanned images in the thumbnail view:
o Select the images, then enter a file name in the Base File Name field.

e Enter the folder path where you want to save the file in the Save To field, or click the Browse
button to locate the folder.

5. Click the Save button to save the settings for a new or revised profile.
Note: When you enter a new file name for images in the Base File Name field, and the profile is

saved, the new file name displays the name you entered and the unique date and time each image
was scanned.

See also:
Creating Unique Image File Names on page 123
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Deleting Folder Profiles

To delete a folder profile:

1.

s whN

Access the Xerox Scan Utility on your computer:

e Windows: Right-click the Xerox Scan Utility icon in the taskbar, then select Open Xerox Scan
Utility. If the icon does not appear in the taskbar, click Start, select All Programs, or Programs if
you are using Windows Classic View, select Xerox Office Printing > Scanning > Xerox Scan Utility.

e Macintosh: Navigate to Applications > Xerox > Xerox Scan Utility, then double-click the Xerox
Scan Utility.

Click the Copy to Folder tab.

Select the profile you want to delete in the Folder Profiles drop-down list.
Click the Delete button.

When prompted, confirm that you want to delete the profile.

Using the Scan to Email and Copy to Folder Tools

Use the Scan to Email or Copy to Folder tools in the Xerox Scan Utility to attach scanned images to
email messages or copy them to local or network folders.

This section includes:

Scan to Email Tab on page 126

Using an Email Profile for Scanned Image Attachments on page 126

Selecting New Email Settings to Send Scanned Image Attachments on page 127

Copy to Folder Tab on page 127

Using a Folder Profile When Copying Scanned Images to a Folder on page 128
Selecting New Folder Settings When Copying Scanned Images to a Folder on page 128
Deleting Image Files Using the Xerox Scan Utility on page 129

Scan to Email Tab

When sending scanned images as attachments to email, you can use a saved email profile or manually
enter one or more addresses, a subject and message text.

Using an Email Profile for Scanned Image Attachments

To send scanned images as attachments in an email using an email profile:

1.

2.

Access the Xerox Scan Utility on your computer:

e Windows: Right-click the Xerox Scan Utility icon in the taskbar, then select Open Xerox Scan
Utility. If the icon does not appear in the taskbar, click Start, select All Programs, or Programs
if you are using Windows Classic View, select Xerox Office Printing, select Scanning, and then
select Xerox Scan Utility.

e Macintosh: Navigate to Applications > Xerox > Xerox Scan Utility, then double-click the Xerox
Scan Utility.

Click the Scan to Email.
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3. Select one or more images you want to send in an email.
4. Select the profile you want to use from the Email Profiles drop-down list.

The fields for Attachment Base Name, To, CC, Subject, and Message display information that
applies to the saved profile.

5. If desired, enter a different name in the Base Attachment Name field and select new email
settings. The Xerox Scan Utility adds the scan date and time information for each image to the end
of the file name.

Note: For example, if you scan an image at 10:15:07 AM on April 27, 2008, select PDF as the file
name extension, then enter the new file name report in the Base Attachment Name field, the
actual file name becomes: report_2008-04-27_10.15.07.pdf.

6. Click the Copy to Email button to open your email application. The selected images are attached
to the email.
7. If desired, make additional changes to the email message, then send the email.

Selecting New Email Settings to Send Scanned Image Attachments

To send scanned images as attachments in an email without using a profile:
1. Access the Xerox Scan Utility on your computer:

e Windows: Right-click the Xerox Scan Utility icon in the taskbar, then select Open Xerox Scan
Utility. If the icon does not appear in the taskbar, click Start, select All Programs, or Programs if
you are using Windows Classic View) select Xerox Office Printing > Scanning > Xerox Scan Utility.

e Macintosh: Navigate to Applications > Xerox > Xerox Scan Utility, then double-click the Xerox
Scan Utility.

2. Click the Scan to Email tab.

3. Select one or more images you want to send in an email.

4. Enter a name in the Base Attachment Name field. The Xerox Scan Utility appends the scan date
and time information for each image to the end of the file name.

Note: For example, if you scan an image at 10:15:07 AM on April 27, 2008, select PDF as the file
name extension, then enter the new file name report in the Base Attachment Name field, the
actual file name becomes: report_2008-04-27_10.15.07.pdf.

5. Enter the appropriate information in the To, CC, Subject, and Message fields.

6. Click the Copy to Email button to open your email application. The selected images are attached
to the email message.

7. If desired, make additional changes to the email message, and then send the email.

Copy to Folder Tab

When copying scanned images to a folder, you can use a folder profile that has been saved with
specific settings.

WorkCentre 7755/7765/7775 Multifunction Printer 127
User Guide



Scanning

Using a Folder Profile When Copying Scanned Images to a Folder

You can create a folder profile to save folder destinations that you frequently use. To copy scanned
images to a folder using a folder profile:

1. Access the Xerox Scan Utility on your computer:

e Windows: Right-click the Xerox Scan Utility icon in the taskbar, then select Open Xerox Scan
Utility. If the icon does not appear in the taskbar, click Start, select All Programs, or Programs if
you are using Windows Classic View, select Xerox Office Printing > Scanning > Xerox Scan Utility.

e Macintosh: Navigate to Applications > Xerox > Xerox Scan Utility, then double-click the Xerox
Scan Utility.

Click the Copy to Folder tab.
Select one or more images you want to copy.
Select the profile you want to use from the list displayed in the Folder Profiles field drop-down list.

&~ whN

If desired, enter a different name in the Base File Name field and select a new folder location. The
Xerox Scan Utility appends the scan date and time information for each image to the end of the
file name.

Note: For example, if you scan an image at 10:15:07 AM on April 27, 2008, select PDF as the file
extension, then enter the new file name report in the Base File Name field, the actual file name
becomes: report_2008-04-27_10.15.07.pdf.

6. Click the Copy to Folder button to copy the selected images to the folder.

Selecting New Folder Settings When Copying Scanned Images to a Folder

To copy scanned images to a folder without using a profile:
1. Access the Xerox Scan Utility on your computer:

¢ Windows: Right-click the Xerox Scan Utility icon in the taskbar, then select Open Xerox Scan
Utility. If the icon does not appear in the taskbar, click Start, select All Programs, or Programs if
you are using Windows Classic View, select Xerox Office Printing > Scanning > Xerox Scan Utility.

¢ Macintosh: Navigate to Applications > Xerox > Xerox Scan Ultility, then double-click the Xerox
Scan Utility.

2. Click the Copy to Folder tab.

3. Select one or more images you want to copy to a folder.

4. Enter a name for the image in the Base File Name field. The Xerox Scan Utility appends the scan
date and time information for each image to the end of the file name.

Note: For example, if you scan an image at 10:15:07 AM on April 27, 2008, select PDF as the file
name extension, then enter the new file name report in the Base File Name field, the actual file
name becomes: report_2008-04-27_10.15.07.pdf.

5. Enter the folder path where you want to save the file in the Save To field, or click the Browse
button to locate the folder.

6. Click the Copy to Folder button to copy the selected images to the folder.
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Deleting Image Files Using the Xerox Scan Utility

Scanned images displayed in the Xerox Scan Utility are stored on your computer’s hard drive. To delete
scanned images that are no longer needed using the Xerox Scan Utility:

1. Access the Xerox Scan Utility on your computer:

e Windows: Right-click the Xerox Scan Utility icon in the taskbar, then select Open Xerox Scan
Utility. If the icon does not appear in the taskbar, click Start, select All Programs, or Programs if
you are using Windows Classic View, select Xerox Office Printing > Scanning > Xerox Scan Utility.

e Macintosh: Navigate to Applications > Xerox > Xerox Scan Utility, then double-click the Xerox
Scan Utility.

2. Click the Scan to Email or Copy to Folder tab.
3. Select the images you want to delete.
4. Click the Delete Scanned Image button.

Importing Scanned Files into an Application

You can import images scanned to your computer from your printer into Windows or Macintosh
applications on your computer.

This section includes:

e Importing Scanned Images into a Windows Application (TWAIN) on page 129

e Using the WIA Image Manager in a Windows Application on page 130

e Using the Xerox Scan Utility in a Macintosh OS X Application (TWAIN) on page 131

Importing Scanned Images into a Windows Application (TWAIN)

To import images into an application for Windows 2000, Windows XP, Windows Vista and Windows
Server 2003:

1. Open the file in which you want to place the image.

2. Select the application’s menu item to acquire the image. For example, if you are using Microsoft
Word 2003 to place an image in a document:

a. Click Insert.

b. Select Picture.

c. Select From Scanner or Camera.

d. Select the scanner, then click the Custom Insert button.

The Xerox Scan Utility window displays thumbnails of the scanned images. The date and time the
image was scanned appears below each thumbnail. If you move your mouse over the thumbnail, a
pop-up message displays information including the resolution and size of the image file. If a
recently scanned image is not displayed, click the Refresh button.

3. Select the image you want to import. Some applications allow you to import multiple images.
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To select more than one image, hold down the Ctrl key on your keyboard as you select each image.
To import all of the images in the folder, select the Edit menu, then click Select All.

Click the Retrieve button. A copy of the image is transferred to the location in your application. If
you want to delete the images you selected, click the Delete button.

Note: For details, click the Help menu to view online help.

Using the WIA Image Manager in a Windows Application

You can import images that you scanned from the printer to your computer into an application using
the WIA Image Manager on Windows XP, Windows Vista and Windows Server 2003.

To import scanned images into an application:

1.
2.

Open the file in which you want to place the image.

Select the application’s menu item to acquire the image. For example, if you are using Microsoft
Word 2003 to place an image in a document:

a. Click Insert.

b. Select Picture.

c. Select From Scanner or Camera.

d. Select the scanner, then click the OK button.

In the Get Pictures from WIA Xerox printer window, open the folder to view thumbnails of the
images. The filename appears below each thumbnail.

To see details of an image file:
a. Select the image.

b. Click View picture information. The Properties dialog box displays information about the file
size and the date and time that the image was scanned.

c. Click OK close.

d. Select the image you want to import. Some applications enable you to import multiple images.
To select more than one image, hold down the Ctrl key on your keyboard as you select each image.
To import all of the images in the folder, select the Edit menu, then click Select All.

Click the Get Pictures button.

A copy of the image is transferred to the location selected in your application.

Note: If you want to delete the images you selected, click the Delete button.
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Using the Xerox Scan Utility in a Macintosh OS X Application (TWAIN)

To import images into an application:

1.
2.

Open the file in which you want to place the image.

Select the application’s menu item to acquire the image. For example, if you are using Microsoft
Word 2004 for Mac to place an image in a document:

a. Click Insert.

b. Select Picture.

c. Select From Scanner or Camera.

d. Select the scanner, then click the Acquire button.

The Scan to Email and Copy to Folder tabs on the Xerox Scan Utility display thumbnails of the
images. Information about each image, including the template used, resolution, size of the image
file, and the profile name and settings appears to the right of the thumbnail.

Select one or more images to import. Some applications allow you to select multiple images.

To select more than one image, hold down the Command button on your keyboard as you select
each image.

To import all the images in a folder, click the Select All check box.
Click the Import button. A copy of the image is transferred to the location selected in your
application. If you want to delete the images you selected, click the Delete button.

Note: For details, click the Help button.
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The scanning features in your printer use templates that define the scan settings and the destination
for an image.

To change any of the scan settings, use the four buttons at the bottom of the control panel touch screen:
e Output Color

e 2-Sided Scanning

e Original Type

e Scan Presets

To change the scan settings:
1. On the printer’s touch screen, touch Services Home.

2. Touch Workflow Scanning, then touch the desired settings in the four buttons at the bottom of
the touch screen. Help is available for each setting by pressing the printer’s Help button.

Setting Use

Setting the Output Color Override automatic detection; set to Black & White, Grayscale
or Color

Setting 1-sided or 2-sided originals Use the document feeder to scan 2-sided originals. Select 2-

sided scanning to scan both sides of the paper to produce a
multi-page image.

If your original cannot be fed through the document feeder, use
the document glass to manually perform 2-sided scanning.

Setting the Original Type Choose from: Photo & Text, Photo, Text, Map or
Newspaper/Magazine

Setting the Scan Presets Choose from: Sharing & Printing, Archival-Small File Size, OCR,
High Quality Printing, Simple Scan

The printer offers advanced options permitting precise control of the scanning process for critical
applications. Many of these advanced settings override the automatic settings. They are selected using
the printer’s control panel touch screen.
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Advanced settings allow you to control image options, image enhancements, scan resolution, files size
and updating of templates.

To use Advanced Settings:

1. On the printer’s touch screen, touch Services Home.

2. Touch Workflow Scanning, then touch the Advanced Settings tab.

3. Touch the desired setting. Help is available for each setting by pressing the printer’s Help button.

Setting Use

Image Options Choose: from lightness/darkness, sharpness or color saturation

Image Enhancement Choose from: Background Suppression, or Contrast

Resolution Choose from: 72 to 600 dpi

Quality/File Size Choose from: good image quality with small file size., higher image
quality with larger file size, or highest image quality with largest
file size.

Update Templates Retrieves new or updated templates and removes outdated templates

Layout adjustments provide additional settings for original orientation, original size and edge erase.

To use Layout Adjustment:

1. On the printer’s touch screen, touch Services Home button.

2. Touch Workflow Scanning, then touch the Layout Adjustment tab.

3. Touch the desired setting. Help is available for each settings by pressing the printer’s Help button.

Setting Use

Original Orientation Choose from: Upright Images, Sideways Images, Portrait Originals
or Landscape Originals

Original Size Choose from: Auto Detect, Preset Scan Area, Custom Scan Areaq,
Mixed Size Originals

Edge Erase Choose from: All Edges or Individual Edges

Filing Options provide additional settings for naming images, choosing image formats, and behavior if
a file name already exists.
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To use Filing Options:

1. On the printer’s touch screen, touch Services Home button.
2. Touch Workflow Scanning, then touch the Filing Options tab.

3. Touch the desired setting. Help is available for each settings by pressing the printer’s Help button.

Setting Use
File Name Define a filename prefix.
File Format Choose from: PDF (Image-only or searchable), PDF/A (Image-only

or searchable), XPS, Multi-page TIFF, TIFF (1 file per page), or JPEG
(1 file per page)

If File Already Exists

Choose from: Add Number to Name, Add Date and Time to Name,
Add to TIFF/JPEG Folder, Overwrite Existing File, or Do Not Save

Document Management

Assign descriptive metadata to a scanned job

Add File Destinations

Define additional network locations as destinations for
scanned documents

Document Management and Add File Destinations can only be modified after scanning to a
network file repository or Scan to Home has been set up. For details, see the System Administrator

Guide at

Job Assembly allows you to combine assorted sets of originals for assembly into a single print job.

To use Job Assembly:

1. On the printer’s touch screen, touch Services Home button.

2. Touch Workflow Scanning, then touch the Job Assembly tab.

3. Touch Build Job, then touch On. Help is available for Build Job by pressing the printer’s Help button.
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This chapter includes:

Fax Overview on page 136

Sending a Fax on page 137

Server Fax on page 139

Sending an Internet Fax on page 140
Faxing from Your Computer on page 141
Selecting Fax Options on page 143

Fax Mailboxes on page 147

Fax Polling on page 149

Adding Speed Dial Entries on page 151
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Fax Overview

Fax capability is available in four options:
e Embedded Fax: Document is scanned and sent directly to a fax machine.

e Server Fax: Document is scanned and sent through an Ethernet network to a fax server, which
sends the fax to a fax machine.

e Internet Fax: Document is scanned and emailed to a recipient.
e Faxing from your computer: The current print job is sent as a fax.

Note: Fax capability must be enabled by the system administrator before use. For details, see the
System Administrator Guide at www.xerox.com/office/WC7755_WC7765_WC7775docs.
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Sending a Fax

To send a fax using the printer’s Embedded Fax:
1. Load the document.

e Document Glass: Place the first page of the document facedown, in the upper left corner of
the document glass.

e Document Feeder: Remove any staples and paper clips from pages and insert them faceup in
the document feeder.

e On the printer’s touch screen, touch Services Home, then touch Fax.
2. To address the fax, do one of the following:

e Enter a fax number (telephone number) using the alphanumeric keypad, or touch Dialing
Characters to enter numbers using the touch screen keypad, then touch Add.

e Touch Address Book, then touch Individual or Group from the drop-down list. Touch the
arrows to scroll through the list, touch the desired contact, then touch Add to Recipients.
Touch Close.

Notes:

« Contacts must be entered in the Address Book to use this function. For details, see Adding Speed

Dial Entries on page 151.

» Chain Dial can be performed when viewing the list of Individual contacts in the Address Book.
For details, see Using Chain Dial on page 152.
o If you know the speed dial number:
e Touch Speed Dial.
e Touch Enter Number, the touch Add.
e Enter the speed dial number using the keypad.
e Touch Add.

Note: Speed dial numbers must be created before using this function.

3. Toinclude a cover sheet:
e Touch Cover Sheet, then touch On.
e Touch the To box, enter the recipient’s name using the touch screen keyboard, then touch Save.
e Touch the From box, enter the sender’s name using the touch screen keyboard, then touch Save.

¢ To add a comment, touch an available comment, then enter the text using the touch screen
keyboard, then touch Save. To delete a comment, touch the comment, then touch Clear.

e Touch Save.
4. Adjust fax options if required. For details, see Selecting Fax Options on page 143.

5. Press the green Start button. The printer scans the pages and transmits the document when all
pages have been scanned.
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Inserting Pauses in Fax Numbers

Some fax numbers require one or more pauses during the dialing sequence.

To insert pauses in a fax number, begin entering the fax number using the alphanumeric keypad, touch
the Pause button on the control panel to insert a pause (represented by a comma), in the desired
location, then complete entering the fax number.
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Server Fax

If a fax server is connected to the network, a document can be sent from the printer to a fax machine
without requiring a dedicated telephone line.

When using the Server Fax, a document is scanned and sent to a location on the network (a fax
repository). The fax server then sends the fax over a telephone line to a fax machine (telephone number).

The Server Fax service must be enabled before use, and a fax repository must be configured.

Sending a Server Fax

To send a Server Fax:
1. Load the document.

e Document Glass: Place the first page of the document facedown, in the upper left corner of
the document glass.

e Document Feeder: Remove any staples and paper clips from pages and insert them faceup in
the document feeder.

e On the printer’s touch screen, touch Services Home, then touch Server Fax.
2. Enter either:

e A fax number (telephone number) using the alphanumeric keypad, or touch Dialing
Characters to use the touch screen. Touch Add to add to the recipients list.

e Asaved fax number by touching Fax Directory. Touch a saved fax number in the fax directory
to add it the recipients list using the drop-down list. Existing fax numbers can be edited or
cleared using the drop-down list. Touch Close when all fax numbers have been added.

Note: To save a fax number in the fax directory, touch an empty row, then enter the fax number using
the touch screen or the alphanumeric keypad. Touch Save when all numbers have been saved.
3. Adjust fax options if necessary. For details, see Selecting Fax Options on page 143.

4. Press the green Start button. The printer scans the pages and transmits the document when all
pages have been scanned.

5. To print a confirmation page displaying the fax transmission status, turn on the confirmation
report option.
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Sending an Internet Fax

If an SMTP (email) server is connected to the network, a document can be sent to an email address.
This feature eliminates the need for a dedicated telephone line and the associated service costs. When
sending an Internet Fax, the document is scanned and sent to an email address.

Note: The Internet Fax service must be enabled before use, and an SMTP server must be
configured. For details, see the System Administrator Guide at
www.xerox.com/office/WC7755_WC7765_WC7775docs and CentreWare IS help.

To send an Internet Fax:
1. Load the document.

e Document Glass: Place the first page of the document facedown, in the upper left corner of
the document glass.

e Document Feeder: Remove any staples and paper clips from pages and insert them faceup in
the document feeder.

2. On the printer’s touch screen, touch Services Home, then touch Internet Fax.
3. Touch New Recipient.
4. Enter either:

e The recipient’s email address using the touch screen keyboard, then touch Add. Repeat for
each recipient, then touch Close.

e Touch Address Book, then touch the desired recipient in the Names list. Use the drop-down list
to add the name to the Recipients list. When all recipients have been added, touch Close. To
search for a recipient, touch Search Public Address Book, then enter the desired recipient’s
name using the touch screen keyboard.

Note: The Address Book is created by the system administrator.

5. Adjust fax options if necessary. For details, see Selecting Fax Options on page 143.

6. Press the green Start button. The printer scans the pages and sends the document as an email
attachment (in PDF or TIFF format), when all pages have been scanned.

7. To print a confirmation page displaying the fax transmission status, turn on the confirmation
report option.
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Faxing from Your Computer

A document stored on your computer can be sent as a fax using the printer driver.

Note: To fax from your computer, fax must be installed in the printer and enabled by the
system administrator.

Sending the Fax

1. With the document open in your application, access the Print dialog box.
e Windows: CTRL+P for most applications.
e Macintosh: CMD+P for most applications.
2. Select the printer.
3. Select printer features.
e Windows: Click the Paper/Output tab.
e Macintosh: Click Copies & Pages, then click Xerox Features.
Click the Job Type menu, then select Fax.
In the Fax window, click Add Recipients.
Enter the recipient’s name and fax number. If desired, complete the additional information.
If desired, click Save to Personal Phonebook to save the recipient information.
Click OK.
Send the fax.
e Windows: Click OK.
¢ Macintosh: Click Print.
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For details, click the Help button in the Fax window.

Including a Cover Sheet

1. Inthe Fax window, click Cover Sheet.
2. Click the Cover Sheet Options menu, then select Print a Cover Sheet.

3. Inthe Cover Sheet window, make the desired selections from the Recipient Information and
Sender’s Information menus.

4, If desired, complete the additional information.

5. Toinclude an image, such as a company logo or background text, on the fax cover sheet, click the
Cover Sheet menu, then click New.

6. Inthe Cover Sheet Image Editor window, enter a name for the cover sheet, then click the Options
menu and select either Text or Picture. For text, enter the desired text. For a picture, click Choose
File, then locate the desired picture file.

7. Click OK twice.

For details, click the Help button in the Fax window.

WorkCentre 7755/7765/7775 Multifunction Printer 141
User Guide



Faxing

Setting Options

1. Inthe Fax window, click Options.

2. Make the desired selections. If you are unfamiliar with the settings, contact your system administrator.
3. Click OK.

Creating Recipient Groups

If you frequently fax to the same group of recipients, you can add them as a group and then fax to
the group.

1. Inthe Fax window, click the Recipients tab.

2. After entering the recipients, press Shift and click on the desired recipients. Press CTRL and click to
skip recipients.

3. Click Save as Group.

4. Inthe Save as Group window, enter a name for the group, then click OK.

The group is stored in your Personal Phonebook.

For details, click the Help button in the Fax window.

Using Fax Phonebooks

In addition to the Personal Phonebook, there are two shared fax phonebooks that must be configured
by your system administrator. For details, see the System Administrator Guide at
www.xerox.com/office/WC7755_WC7765_WC7775docs.

To use a phonebook:
1. Inthe Fax window, click Add from Phonebook.
2. Click the menu at the top of the Add from Phonebook window, then select the desired phonebook.

3. Click the desired recipient, then click Add. For large address books, type the first few letters of the
name. When it appears, click the name, then click Add.

4. When all recipients have been added, click OK.

For details, click the Help button in the Fax window.
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Selecting Fax Options

This section includes:

e Setting 2-Sided Faxing on page 143

e Selecting the Original Type on page 143
e Setting the Fax Resolution on page 143
e Adjusting Image Quality on page 143

e Adjusting Layout on page 144

e Additional Fax Options on page 145

Setting 2-Sided Faxing

1. Touch Fax on the touch screen.
2. Touch 2-Sided Scanning, then touch the desired option (1-Sided, 2-Sided, 2-Sided, Rotate Side 2).

Selecting the Original Type

1. Touch Fax on the touch screen.
2. Touch Original Type, then touch the desired option (Photo & Text, Photo, Text).

Setting the Fax Resolution

1. Touch Fax on the touch screen.
2. Touch Resolution, then touch the desired option (Standard, Fine, Super Fine).

Adjusting Image Quality

Lighten/Darken and Sharpness

To adjust the brightness or sharpness of the image:

1. Touch Fax on the touch screen.

2. Touch the Image Quality tab, then touch Image Options.

3. Touch the pointer to set Lighten/Darken or Sharpness to the desired level.
4. Touch Save.

Image Enhancement-Auto Suppression

When faxing originals printed on thin paper, images printed on one side of the paper can sometimes
be seen on the other side of the paper. The printer can be set to reduce this problem.

1. Touch Fax on the touch screen.
2. Touch the Image Quality tab, then touch Image Enhancement.
3. Touch Auto Suppression.
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4. To manually adjust the image contrast (the difference between light and dark areas in an image),
touch Manual Contrast, then touch the pointer to adjust the contrast level. The default setting is
Auto Contrast.

5. Touch Save.
Adjusting Layout

Adjusting the Original Size

1. Touch Fax on the touch screen.
2. Touch the Layout Adjustment tab, then touch Original Size.
3. Touch one of the following:
e Auto Detect, which enables the printer to automatically identify the size of the originals.
e Preset Scan Areas, for manual definition of the scan area using standard paper dimensions.
e Custom Scan Area, for manual definition of a custom scan area.
e Mixed Size Originals, for scanning originals of different standard sizes.
4. Touch Save.

Reducing or Splitting

1. Touch Fax on the touch screen.
2. Touch the Layout Adjustment tab, then touch Reduce/Split.
3. Touch one of the following options:
e Reduce to Fit, which shrinks large documents to fit on smaller paper.
e Split Across Pages, which continues a single image across several pages.
4. Touch Save.

Book Faxing

1. Touch Fax on the touch screen.
2. Touch the Layout Adjustment tab, then touch Book Faxing.
3. Touch one of the following options:

o Off (Default).

e Both Pages to scan both pages of the book. If required, touch the arrows to set the Binding
Edge Erase.

e Left Page Only to scan the left page of the book. If required, touch the arrows to set the
Binding Edge Erase.

¢ Right Page Only to scan the right page of the book. If required, touch the arrows to set the
Binding Edge Erase.

4. Touch Save.
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Additional Fax Options

Selecting a Confirmation Report

1. Touch Fax on the touch screen.
2. Touch the Fax Options tab, then touch Confirmation Report.
3. Touch one of the following options:
e Print Confirmation for all fax jobs.
e Print on Error Only.
4. Touch Save.

Selecting the Starting Rate

Select the highest starting rate unless the fax destination for the fax you are sending has
special requirements.

To select the transmission speed for a fax:

1. Touch Fax on the touch screen.

2. Touch the Fax Options tab, then touch Starting Rate.

3. Touch Super G3 (33.6 Kbps), G3 (14.4 Kbps), or Forced (4800 bps), then touch Save.

Delay Sending a Fax

To send a fax at a specified time (within 24 hours):
Note: The printer needs to be set to the current time before using this function.

1. Touch Fax on the touch screen.
2. Touch the Fax Options tab, then touch Delay Send.
3. Touch Specified Time:
e Touch Hour, then touch the arrows to set a number from 0 to 12.
e Touch Minute, then touch the arrows to set a number from 0 to 59.
e Touch AM or PM.
4. Touch Save.
5. Load the originals, then enter the fax number of the recipient.
6. Press the green Start button to scan the document.
The fax will be sent at the specified time.
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Selecting Send Header Text

To turn Send Header Text on or off:
1. Touch Fax on the touch screen.
2. Touch the Fax Options tab, then touch Send Header Text.
3. Touch one of the following options:
e Off (default).
e On.
4. Touch Save.

Note: For details, see the System Administrator Guide at
www.xerox.com/office/WC7755_WC7765_WC7775docs.
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Fax Mailboxes

A fax can be stored locally in the printer or in a remote fax machine.

Storing a Fax in a Local Mailbox

E o

Note: A mailbox must be created before using this feature. For details, see Scan to a Folder on
page 114, or see the System Administrator Guide at
www.xerox.com/office/WC7755_WC7765_WC7775docs.

On the touch screen, touch Fax.

Touch the Fax Options tab, then touch Mailboxes.

Touch Store to Local Mailbox.

Use the alphanumeric keypad to enter the following:

¢ Mailbox Number.

e Mailbox Passcode.

Touch Save.

Load the document in the document feeder or on the document glass.
Press the green Start button.

Storing a Fax in a Remote Mailbox

s wnN =

On the touch screen, touch Fax.
Touch the Fax Options tab, then touch Mailboxes.
Touch Send to Remote Mailbox.

Touch the field under Fax Number, then touch Dialing Characters or Address Book. Enter the fax
number of the fax machine that you want to access, then touch Add.

Use the alphanumeric keypad to enter the following.

¢ Mailbox Number.

¢ Mailbox Passcode.

Touch Save.

Load the document in the document feeder or on the document glass.
Press the green Start button.

Printing Stored Faxes

s wnN -

On the touch screen, touch Fax.

Touch the Fax Options tab, then touch Mailboxes.

To print stored faxes, touch Print Local Mailbox Documents.
Use the alphanumeric keypad to enter the following:

e Mailbox Number.

e Mailbox Passcode.

Touch Print All Documents.
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Deleting Stored Faxes:

On the touch screen, touch Fax.

Touch the Fax Options tab, then touch Mailboxes.
Touch Delete Local Mailbox Documents.

Use the alphanumeric keypad to enter the following:
e Mailbox Number.

s wnN -

e Mailbox Passcode.
5. Touch Delete All Documents.
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Fax Polling

You can store a fax document on the printer and make it available for other fax machines. You can also
retrieve faxes stored on other fax machines.

Note: Both fax machines must have this feature.

Storing a Fax for Remote Polling

You can make stored fax documents available for remote polling by enabling Non-Secure Local Polling
or Secure Local Polling.

1. On the touch screen, touch Fax.
2. Touch the Fax Options tab, then touch Local Polling.
3. To enable Non-Secure Polling, touch Non-Secure Polling.
Any fax machine can access the stored faxes.
4. To enable Secure Polling, touch Secure Polling.
You must specify the fax machines that can access the stored faxes.
a. Use the alphanumeric keypad, or touch Address Book to add fax numbers to the list.

b. Touch Allow all Address Book fax numbers access to add all stored fax addresses to the
access list.

5. Touch Save.
6. Place your original document in the document feeder or on the document glass.
7. Press the Start button.

Printing and Deleting Stored Faxes

On the touch screen, touch Fax.

Touch the Fax Options tab, then touch Local Polling.
Touch Print All to print all stored fax documents.
Touch Delete All to delete all stored fax documents.

s wWwhnN -

Remote Polling
If remote polling is enabled, you can retrieve documents that were stored using local polling on
another fax machine, or documents that are stored in a fax mailbox on another fax machine.

Note: If Local Polling is enabled, Remote Polling is disabled. Set Local Polling to Off to poll a remote
fax or fax mailbox.

Polling a Remote Fax

1. On the touch screen, touch Fax.
2. Touch the Fax Options tab, then touch Remote Polling.
3. Touch Poll a Remote Fax.
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Touch Dialing Characters or Address Book to enter the fax number of the fax machine that you
want to access, then touch Add. Add additional fax numbers if necessary.

To set a time when you want your printer to retrieve faxes from other fax machines:
a. Touch Delay Send.

b. Touch Specified Time to set the time.

c. Touch Save.

Touch Poll Now to retrieve and print the faxes.

Polling a Remote Mailbox

BwnNn-

On the touch screen, touch Fax.
Touch the Fax Options tab, then touch Remote Polling.
Touch Poll a Remote Mailbox.

Touch the field under Fax Number, then touch Dialing Characters or Address Book. Enter the fax
number of the fax machine that you want to access, then touch Add.

Use the alphanumeric keypad to enter the following:

¢ Mailbox Number.

¢ Mailbox Passcode.

Touch Poll Now to retrieve and print the faxes in the mailbox.

Note: For details, see the System Administrator Guide at
www.xerox.com/office/WC7755_WC7765_WC7775docs.
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Adding Speed Dial Entries

This section includes:

Adding an Individual on page 151

Adding a Group on page 151

Editing or Clearing Speed Dial Entries on page 152
Using Chain Dial on page 152

Adding an Individual

A total of 200 speed dial entries can be stored in the printer.

To store multiple recipients in one speed dial button, store the recipients as a group dial. For details, see
Adding a Group on page 151.

1.

o s wN

N

On the touch screen, touch Fax.

Touch Address Book.

Touch the down arrow, then touch Individuals.

Touch an available Speed Dial entry. Touch the scroll arrows if necessary.

Touch Entry Name, enter the name using the touch screen keyboard, then touch Save.

Touch Fax Number, enter the number using the alphanumeric keypad or by touching Dialing
Characters, then touch Save.

If required, the Starting Rate can be changed by touching the desired speed under Starting Rate.
A cover sheet can be assigned to the speed dial number.

a. Touch Cover Sheet, then touch On.

b. Touch the To box, then enter the name using the touch screen keyboard.

c. Touch the From box, then enter the name using the touch screen keyboard.
d

To add a comment, touch an available comment, touch Edit, then enter the comment using
the touch screen keyboard.

e. Touch Save.

Adding a Group

Create a group to send a fax to multiple individuals. Groups can include both previously stored
individuals and group entries.

i whN =

Note: Individual entries must be set up before groups can be defined.

On the touch screen, touch Fax.

Touch Address Book, touch the down arrow, then touch Groups.

Touch an available group Speed Dial entry.

Touch the Group Name, enter the name using the touch screen keyboard, then touch Save.
Touch Add Recipients.
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Touch the down arrow, then touch Individuals to add individual speed dial entries, or touch
Groups to add speed dial groups.

Touch the desired speed dial entry, then touch Add to Group.
When all entries have been added, touch Save, then touch Close.

Editing or Clearing Speed Dial Entries

W N =

On the touch screen, touch Fax.

Touch Address Book.

Touch the down arrow, then touch Individuals or Groups.

Touch the desired Speed Dial entry, then touch Edit Details or Clear Entry.

Using Chain Dial

Chain dial creates a single fax recipient telephone number by adding two or more fax numbers
together into a single number. For example, an area code or extension number could be stored
separately from the rest of the telephone number. Chain dialing is accessed from the Address Book.

1.

s whN

On the touch screen, touch Fax.

Touch Address Book.

Touch the down arrow, then touch Individuals.

Touch Chain Dial.

To add numbers to an existing speed dial number:

a. Enter the numbers in the Recipient box using the touch screen keypad.

b. Touch the desired speed dial entry from the scrolling list. Touch the scroll arrows if necessary.
c. Touch Add to Recipient. The numbers are added together in the Recipient box.

d. Touch Save. The combined number appears as a single recipient in the Recipients list.

e. Touch Close. The fax can now be sent.
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This chapter includes:
e Maintenance and Cleaning on page 154
e Ordering Supplies on page 160
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Maintenance and Cleaning

This section includes:

General Precautions on page 154

Locating the Serial Number on page 155

Usage Counters on page 156

Resetting Routine Maintenance Item Life Counters on page 156
Cleaning the Printer on page 157

Installing Staples on page 162

See also:

Safety on page 11

General Precautions

Warning: When cleaning your printer do NOT use organic or strong chemical solvents or aerosol
cleaners. Do NOT pour fluids directly into any area. Use supplies and cleaning materials only as
directed in this documentation. Keep all cleaning materials out of the reach of children.

Warning: Internal parts of the printer may be hot. Use caution when doors and covers are open.

Warning: Do NOT use pressurized air spray cleaning aids on or in the printer. Some pressurized air
spray containers contain explosive mixtures and are not suitable for use in electrical applications.
Use of such cleaners can result in a risk of explosion and fire.

Warning: Do NOT remove the covers or guards that are fastened with screws. You cannot maintain
or service any parts that are behind these covers and guards. Do NOT attempt any maintenance
procedure that is NOT specifically described in the documentation supplied with your printer.

To avoid damaging the printer, keep the following guidelines in mind:

Do not place anything on top of the printer.

Do not leave the covers and doors open for any length of time, especially in well-lit places. Light
exposure can damage the drum cartridges.

Do not open covers and doors during printing.
Do not tilt the printer while in use.

Do not touch the electrical contacts, gears, or laser devices. Doing so may damage the printer and
cause the print quality to deteriorate.

Make sure any parts removed during cleaning are replaced before you plug in the printer.
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Locating the Serial Number

When ordering supplies or contacting Xerox for assistance, you will be asked to provide your printer’s
serial number.

The serial number can be read from the printer’s touch screen.
1. Press the Machine Status button. If necessary, touch the Machine Information tab.
2. The serial number is displayed on the left side of the Machine Information screen.

If the serial number cannot be read from the printer’s touch screen, it can also be found inside the printer.
1. If Tray 6 is installed, slide the entire Tray 6 High Capacity Feeder assembly to the left until it stops.

2. Raise Tray 5 (Bypass Tray).

\/

N\

wc77xx-065
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3. Pull the release handle and open the left side door.

wc77xx-066

The serial number is on the right side of the printer frame.
Close the left side door.
Lower Tray 5.

N o v s

If necessary, slide the entire Tray 6 High Capacity Feeder assembly to the right to its original position.

Usage Counters

The usage counters store printer usage and billing information.
1. Press the Machine Status button.
2. Touch the Billing Information tab.

Total impressions appear in this window. For more detail:

1. Touch Usage Counters, then touch the down arrow to choose the desired counter. Touch the scroll
arrows to view the entire list.

2. Touch Close.

Resetting Routine Maintenance Item Life Counters

When replacing some routine maintenance items, the printer’s life counter must be reset.

1. Login as system administrator. Press the Log In/Out button, enter the User ID (admin is the
default), touch Next, enter the Password (1111 is the default), then touch Enter.

On the printer’s control panel, press Machine Status.

Touch the Tools tab, then touch Device Settings.

Touch General, then touch Supply Counter Reset. Touch the scroll arrows if necessary.
Touch the desired supply item, then touch Reset Counter.

In the pop-up window, touch Reset.

No U EWwWN

Touch Close.
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Cleaning the Printer

e Cleaning the Document Glass and Document Cover on page 157
e (Cleaning the Exterior on page 158

e C(Cleaning the Document Feeder Rollers on page 158

e Ordering Supplies on page 160

Cleaning the Document Glass and Document Cover

To ensure optimum print quality, regularly clean the glass areas of your printer. This helps avoid output
with streaks, smears, and other marks that transfer from the glass area while scanning documents.

Use a lint-free cloth lightly dampened with Xerox Anti-Static or another suitable non-abrasive glass
cleaner to clean the document glass and the glass strip to its left.

wc77xx-132

Use a lint-free cloth, Xerox Cleaning Fluid or Xerox Film Remover to clean the under side of the
document cover and the document feeder.

wc77xx-131
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Cleaning the Exterior

Regular cleaning keeps the touch screen and control panel free from dust and dirt. To remove finger
prints and smudges, clean the touch screen and control panel with a soft, lint-free cloth.

wc77xx-134

Use a cloth to clean the document feeder, output trays, paper trays and outside areas of your printer.

wc77xx-135

Cleaning the Document Feeder Rollers

Dirt on the document feeder rollers can cause paper jams or deteriorate print quality. For best

performance, clean the document feeder rollers once a month.

1. Open the document feeder top cover until it comes to a stop. The document feeder left cover will
open automatically.

wc77xx-049
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2. While turning the rollers, wipe them with a clean, lint free cloth moistened with water.

wc77xx-133

Caution: Do not use alcohol or chemical cleaners on the document feed rollers.

3. Close the top cover until it clicks into place, then close the left cover until it clicks into place.
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Ordering Supplies

This section includes:

Consumables on page 160

Routine Maintenance [tems on page 160
When to Order Supplies on page 161
Recycling Supplies on page 161

Certain consumables and routine maintenance items need to be ordered occasionally. Each supply
item includes installation instructions.

Consumables

Use genuine Xerox Toner Cartridges (Cyan, Magenta, Yellow and Black).

Note: Each toner cartridge includes installation instructions.

Caution: Use of toner other than Genuine Xerox Toner may affect print quality and printer
reliability. It is the only toner designed and manufactured under strict quality controls by Xerox for
specific use with this printer.

Routine Maintenance Items

Routine maintenance items are printer parts that have a limited life and require periodic replacement.
Replacements may be parts or kits. Routine maintenance items are typically customer replaceable.

The following items are routine maintenance items:

Toner Cartridge

Drum Cartridge

Waste Toner Container

Fuser Assembly

Charge Corotron

Hole Punch Waste Container

Staple Cartridge

Booklet Staple Cartridge

Staple Waste Container (Light Production Finisher)
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When to Order Supplies

The printer’s touch screen displays a warning when the supply nears its replacement time. Verify that
you have replacements on hand. It is important to order these supplies when the messages first appear
to avoid interruptions to your printing. The touch screen displays an error message when the supply
must be replaced.

Order supplies from your local reseller or from the Xerox Supplies website at:
www.xerox.com/office/WC7755_WC7765_WC7775supplies.

Caution: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreements,
and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of
performance caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this
printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage
may vary outside these areas; please contact your local representative for details.

Recycling Supplies
For information on Xerox supplies recycling programs, go to www.xerox.com/gwa.

Some routine maintenance items come with a prepaid return label. Please use it to return used
components in their original boxes for recycling.
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Installing Staples

If your printer has the optional Advanced Finisher, the optional Professional Finisher, the optional Light
Production Finisher, you will be alerted by a message on the printer touch screen when a staple
cartridge is empty and needs to be replaced.

This section includes:

e Main Staple Replacement for Advanced Office Finisher and Professional Finisher on page 162

e Booklet Staple Replacement for Professional Finisher and Light Production Finisher on page 164
e Main Staple Replacement for Light Production Finisher on page 167

Main Staple Replacement for Advanced Office Finisher and Professional
Finisher

Warning: Do not perform this procedure when the printer is copying or printing.

1. Open the finisher door.

% wc77xx-068

2. Hold the staple cartridge unit by orange handle R1 and push it to the right.

1)

wc77xx-098
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3. Remove the staple cartridge by gripping the orange handle at the front of the cartridge and pulling
it firmly toward you.

wc77xx-136

5. Insert the front side of the new staple case into the staple cartridge (1), then push the rear side into
the cartridge (2).

wc77xx-137
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6. Grip the staple cartridge by the orange handle and insert it into the staple cartridge unit until it clicks.

wc77xx-102

7. Close the finisher door.

Booklet Staple Replacement for Professional Finisher and Light Production
Finisher

Note: The booklet maker uses two staple cartridges labeled R2 and R3. Booklet stapling requires
that both staple cartridges contain staples.

Warning: Do not perform this procedure when the printer is copying or printing.

1. Open the finisher door.

% wc77xx-068
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2. While squeezing orange levers R2 and R3 together (1), pull the staple cartridge unit out of the
finisher until it stops (2).

Note: The staple cartridge unit does not detach from the finisher.

ARR

ARR

wc77xx-105
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wc77xx-106
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5. Lift the staple cartridge out of the staple cartridge unit.

ARR

ARR

wc77xx-109

7. Repeat steps 3 to 6 for staple cartridge R3.
8. Return the staple cartridge unit to its original position.

AN
)

wc77xx-110

9. Close the finisher door.
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Main Staple Replacement for Light Production Finisher

Warning: Do not perform this procedure when the printer is copying or printing.

1. Open the right finisher door.
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wc77xx-140

2. Grip the staple cartridge by the orange handle and remove it by pulling it firmly toward you.

wc77xx-142
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4. Insert the new staple case into the staple cartridge.

wc77xx-143

5. Grip the staple cartridge by the orange handle and insert it into the staple cartridge unit until it clicks.

——— Wc77xx-144

6. Close the right finisher door.
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wc77xx-145
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Troubleshooting

This chapter includes:

Control Panel Messages on page 170
General Troubleshooting on page 171
Clearing Paper Jams on page 174
Clearing Staple Jams on page 215
Print Quality Problems on page 226
Copy and Scan Problems on page 227
Fax Problems on page 228

Getting Help on page 231
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Control Panel Messages

The control panel touch screen provides information and troubleshooting help. When an error or
warning condition occurs, the touch screen displays a message. The touch screen may also display an
animated graphic showing the location of the problem, such as the location of a paper jam.

Problems which prevent the full operation of the printer have associated fault codes. These codes will
help pinpoint the specific subsystem with the problem. Current faults and fault history can be retrieved
at any time.

To see a list of the fault messages that have been displayed on the printer:
1. Press the Machine Status button.

2. On the touch screen, touch the Faults tab.

3. Touch Current Faults, Current Messages, or Fault History.

4. Touch Close.
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This section contains procedures to help you locate and resolve problems. Some problems can be
resolved by simply restarting the printer.

To restart the printer:
1. Locate the power switch on the top of the printer.
2. Turn the switch OFF, wait 2 minutes, then turn the switch back ON.

If the problem is not resolved by restarting the printer, see the table in this chapter that best describes
the problem.

. on page 171

. on page 172

) on page 172
. on page 172

. on page 172

) on page 173

Probable Causes Solutions

The power cord is not correctly plugged into Turn off the printer, and plug the power cord securely into
the outlet. the outlet.

Something is wrong with the outlet connected | Plug another electrical appliance into the outlet and see
to the printer. whether it operates properly.

Try a different outlet.

The power switch is not correctly turned on. Turn the power switch on the top of the printer off, wait two
minutes, then turn it back on.

Ensure that the main power switch on the rear of the printer
is in the on position.

The printer is connected to an outlet with a Use a power source with the specifications listed in
voltage or frequency that does not match the on page 236.
printer specifications.

Caution: Plug the three-wire cord (with grounding prong) directly into a grounded AC outlet only. Do
not use a power strip. If necessary, contact a licensed electrician to install a properly grounded outlet.
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Probable Causes Solutions

The printer is set to a slower printing mode (for | It takes more time to print with special media. Make sure
example, heavyweight stock or transparency). that the media type is set properly in the driver and at the
printer’s control panel.

The printer is in ENERGY SAVE mode. It takes time for printing to start in power saving mode.

The job is very complex. Wait. No action needed.

Probable Causes Solutions
The power cord is not correctly plugged into Turn off the printer, confirm that the power cord is correctly
the outlet. plugged into the printer and the outlet, and then turn on
the printer.
A system error occurred. Contact your local Xerox service representative with the
fault information. Check the fault history. For details, see
on page 231.

Probable Causes Solutions

The tray is not installed correctly. Open and close the tray you are printing from.

There is an obstruction or debris inside the printer. | Turn off the printer and remove the obstruction or debris. If
you cannot remove it, contact your Xerox
service representative.

Probable Causes Solutions

Media or settings are not correct. Make sure that you are using correct media. For details, see
on page 41. Envelopes, labels, gloss,
extra heavyweight stock, and transparencies cannot be
used for 2-Sided Printing.

In the printer driver, choose 2-Sided Printing.
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Troubleshooting

Solutions

Scanner is not communicating.

Turn off the printer, and check the scanner cable. Wait 2
minutes and turn the printer on again.

If the problem is not resolved, contact your local Xerox
service representative.
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Clearing Paper Jams

When a jam occurs, the control panel touch screen displays an animated graphic showing the location
of the jam.

This section includes:

e Clearing Paper Jams from Tray 1 and Tray 2 on page 175

e Clearing Paper Jams from Tray 3 and Tray 4 on page 176

e Clearing Paper Jams from Tray 5 (Bypass Tray) on page 177

e Clearing Paper Jams from Tray 6 (High-Capacity Feeder) on page 178
e Clearing Paper Jams in the Document Feeder on page 179

e Clearing Paper Jams in the Transfer Module on page 181

e Clearing Paper Jams in the Output Tray on page 183

e Clearing Paper Jams in the Bottom Left Cover on page 184

e Clearing Paper Jams in the Bottom Right Cover on page 185

e Clearing Paper Jams in Advanced Office Finisher and Professional Finisher on page 187
e Clearing Paper Jams in the Light Production Finisher on page 203

e Clearing Hole Punch Jams on page 213

e Clearing Staple Jams on page 215

To avoid damage, always remove misfed media gently, without tearing it. Try to remove the paper in the
direction that the paper would normally feed. Any piece of media left in the printer, whether large or
small, can obstruct the media path and cause further misfeeds. Do not reload media that has misfed.

Note: The printed side of jammed pages may smudge, and the toner may stick to your hands. Do
not touch the printed side of the media when removing it. Make sure not to spill any toner inside
the printer.

Warning: If you accidentally get toner on your clothes, lightly dust them off as best as you can. If
some toner remains on your clothes, use cool, not hot water, to rinse the toner off. If toner gets on
your skin, wash it off with cool water and a mild soap. If you get toner in your eyes, wash it out
immediately with cool water and consult a doctor.
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Troubleshooting

Clearing Paper Jams from Tray 1 and Tray 2

1. Pull the tray out toward you until it stops.

wc77xx-039

2. Remove the paper from the tray.
3. If the paper is torn, remove the tray completely and check inside the printer for torn pieces of paper.

wc77xx-040

4. Reload the tray with undamaged paper, then push the tray in until it stops.
5. On the printer’s touch screen, touch Confirm.
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Troubleshooting

Clearing Paper Jams from Tray 3 and Tray 4

1. Pull the tray out toward you until it stops.

wc77xx-041
gﬂ

3. If the paper is torn, remove the torn pieces of paper from the tray and check inside the printer for
torn pieces of paper.

2. Remove the paper from the tray.

wc77xx-042

1 wc77xx-123

4, Reload the tray with undamaged paper, then push the tray in until it stops.
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Troubleshooting

5. On the printer’s touch screen, touch Confirm.

Clearing Paper Jams from Tray 5 (Bypass Tray)

1.

N

o s w

Open the cover on Tray 5 (Bypass Tray).

wc77xx-043

Make sure there are no sheets of paper in the paper feed entrance area, and remove any
jammed paper.

If the paper is torn, check inside the printer for torn pieces of paper.
Close the Tray 5 cover.
Fan the paper you removed and make sure that all four corners are neatly aligned.

Insert the paper into the tray with the printing side faceup. The leading edge should lightly touch
the paper feed entrance.

\\%

wc77xx-028
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Clearing Paper Jams from Tray 6 (High-Capacity Feeder)

1. Slide the entire Tray 6 High-Capacity Feeder assembly to the left until it stops.

2. Pull the tray out toward you until it stops. If jammed paper is visible, remove it. If the paper is torn,
check inside the printer for torn pieces of paper.

wc77xx-044

3. If jammed paper is not visible, open the top cover and remove any jammed paper. If the paper is
torn, check inside the printer for torn pieces of paper.

wc77xx-046

4. Close the top cover, then gently slide the entire Tray 6 assembly to the right, back to its original position.
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Troubleshooting

Clearing Paper Jams in the Document Feeder

1. Open the document feeder top cover until it comes to a stop. The document feeder left cover will
open automatically.

wc77xx-049

2. If the paper is not jammed in the document feeder, pull it out in the direction shown.

wc77xx-050

3. If the paper is jammed in the document feeder, lift the handle and open the inner cover. Remove
the jammed paper.

wc77xx-051

WorkCentre 7755/7765/7775 Multifunction Printer 179
User Guide



Troubleshooting

4. Close the inner cover, close the top cover until it clicks into place, then close the left cover until it
clicks into place.

wc77xx-052

5. If the jammed paper is not visible, raise the document feeder. Pull the green handle and remove
any jammed media from under the document feeder or from the document glass. Return the green
handle to its original position.

wc77xx-053

6. Close the document feeder.
7. If the jammed paper is not visible, lift the document feeder tray and remove the jammed paper.

wc77xx-048
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Troubleshooting

8. Return the document feeder tray to its original position.
9. Reinsert originals in the document feeder.

Caution: Torn, wrinkled or folded originals may cause jams and damage the printer. To copy them,
use the document glass.
Clearing Paper Jams in the Transfer Module

Warning: Do not perform this operation when the printer is copying or printing.

1. Open the printer front cover.

2. Turn green handle 2 to the right until it stops in the horizontal position, then pull the transfer
module straight out until it stops.

Warning: The area around the fuser may be hot. Use caution to avoid injury.

wc77xx-054
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Troubleshooting

3. Remove the jammed paper.

Note: If the paper is torn, remove all torn pieces from the printer.

wc77xx-055

If jammed paper is not visible, move green handle 2a to the right, remove the jammed paper, then

release green handle 2a.

4,

wc77xx-056

2b and remove jammed paper.

pull down green handle

If jammed paper is not visible,

5.

wc77xx-057

6. Return green handle 2b to its original position.
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7. Push the transfer module completely into the printer, then turn green handle 2 to the left until it
stops in the vertical position.

wc77xx-058

8. Close the front cover.

Clearing Paper Jams in the Output Tray

Remove jammed paper from the output tray.

Note: If the paper is torn, remove all torn pieces from the printer.

\SY% (r

wc77xx-059
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Clearing Paper Jams in the Bottom Left Cover

1. If Tray 6 is installed, slide the entire Tray 6 High-Capacity Feeder assembly to the left until it stops.

2. Raise Tray 5 (Bypass Tray).

wc77xx-065

3. Pull the release handle and open the bottom left cover.

wc77xx-066

4. Remove any jammed paper.
Note: If the paper is torn, remove all torn pieces from the printer.

5. Close the bottom left cover.
6. Lower Tray 5 (Bypass Tray).
7. If necessary, slide the entire Tray 6 High Capacity Feeder assembly to the right to its original position.
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Clearing Paper Jams in the Bottom Right Cover

1. If afinisher is installed, open the finisher door.

o -
— %ﬂ
=" \\J

% wc77xx-068

2. Move green handle 1a to the right.

/i

ru-s\n/
/A

3. Push the release lever down and open the cover.

© wc77xx-085

Troubleshooting

Note: If a finisher is installed, the output tray shown in the illustration will not be present.

wc77xx-060
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Troubleshooting

4. Remove the upper and lower jammed paper.
Notes:

« If afinisher is installed, the output tray shown in the illustration will not be present.
» Paper may adhere to the inside of the cover and under the transport.

» If the paper is torn, remove all torn pieces from the printer.

wc77xx-061

5. Close the bottom right cover.

Note: If a finisher is installed, the output tray shown in the illustration will not be present.

\‘ f wc77xx-062

6. If afinisher is installed, push green handle 1a to the left until it locks, then close the finisher door.
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Clearing Paper Jams in Advanced Office Finisher and Professional Finisher

This section includes:

Paper Jams at Ta in the Finisher on page 187

Paper Jams at 1b in the Finisher on page 188

Paper Jams at 1d in the Finisher (Using Knob 1c) on page 190
Paper Jams at 2a in the Finisher (Using Knob 2c) on page 193
Paper Jams at 2b in the Finisher on page 195

Paper Jams at 2b in the Finisher (Using Knob 2c) on page 196
Paper Jams at 3 in the Finisher on page 197

Paper Jams at 5 in the Finisher on page 199

Paper Jams at 4a in the Booklet Maker on page 199

Paper Jams at 4b in the Booklet Maker on page 200

Paper Jams in the Booklet Tray on page 202

Paper Jams at 1a in the Finisher

1.

Open the finisher door.

S wc77xx-085
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3. Remove the jammed paper.

Troubleshooting

N

4. Return lever 1a to its original position.

Paper Jams at 1b in the Finisher

5. Close the finisher door.
1.

Open the finisher door.

wc77xx-068
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2. Move green lever 1b to the right.
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0

3. Remove the jammed paper.

A

4. Return lever 1b to its original position.
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5. Close the finisher door.
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Paper Jams at 1d in the Finisher (Using Knob 1c¢)
1. Open the finisher door.

— |\
///J\Q

% wc77xx-068

2. Move green lever 1d to the left.

© wc77xx-091
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Troubleshooting

4. Remove the jammed paper.

—

5. Return lever 1d to its original position.

wc77xx-097

6. Close the finisher door.

Paper Jams at 2a in the Finisher

1. If the paper is visible at the output tray exit, carefully remove the paper by pulling it in the
direction shown.

wc77xx-067
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Troubleshooting

2. Open the finisher door.

17

4. Remove the jammed paper.

wc77xx-070
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Troubleshooting

5. Return handle 2a to its original position.

wc77xx-152

6. Close the finisher door.

Paper Jams at 2a in the Finisher (Using Knob 2c)

/ \l

wc77xx-068

1. Open the finisher door.
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Troubleshooting

3. Turn green knob 2c in the direction shown to release the paper.

4. Remove the jammed paper.

wc77xx-152

6. Close the door of the finisher.
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Paper Jams at 2b in the Finisher

1. Open the finisher door.

Uﬂa\ry/
A i
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—
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wc77xx-068

2. Move green lever 2b to the right, then remove the jammed paper.

i
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A~ wc77xx-153

4. Close the finisher door.
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Paper Jams at 2b in the Finisher (Using Knob 2c¢)

I < =l

wc77xx-068

1. Open the finisher door.
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wc77xx-076
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4. Remove the jammed paper.

A~— —  wc77xx-077

3
A

A——  wc77xx-153

6. Close the finisher door.

Paper Jams at 3 in the Finisher

1. Open the finisher door.

/

=
% wc77xx-068
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2. Pull down green lever 3.

3. Remove the jammed paper.

5. Close the finisher door.
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Paper Jams at 5 in the Finisher

1. Open finisher exit cover 5 (right side of the finisher above the output tray), by lifting upward at

green label 5.

<

2. Remove the jammed paper by pulling it in the direction shown.

wc77xx-080

3. Return finisher exit cover 5 to its original position.

Paper Jams at 4a in the Booklet Maker

1. Open the finisher door.

wc77xx-149

Troubleshooting
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Troubleshooting

3. Turn green knob 4a in the direction shown to remove the jammed paper.

wc77xx-150

wc77xx-155

5. Close the finisher door.

Paper Jams at 4b in the Booklet Maker
1. Open the finisher door.

% wc77xx-068
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Troubleshooting

2. Move green lever 4b to the left.

il

3. If paper is visible, remove the jammed paper by pulling in the direction shown.

el

wc77xx-093
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Troubleshooting

6. Return unit 4 to its original position.

wc77xx-155

7. Return lever 4b to its original position.

/
wc77xx-160

8. Close the finisher door.

Paper Jams in the Booklet Tray
1. Open the finisher door.

% wc77xx-068
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Troubleshooting

Turn green knob 4a in the direction shown to release the jammed paper.

Close the finisher door.

wc77xx-096

Clearing Paper Jams in the Light Production Finisher

This section includes:

Clearing Jams at Ta (using Knob 1¢) on page 204

Clearing Jams at 2a on page 205

Clearing Jams at 3e (using Knob 3c) on page 206

Paper Jams at 4a in the Booklet Maker on page 207

Paper Jams at 4b in the Booklet Maker on page 208

Paper Jams in the Booklet Maker Tray on page 210

Clearing Jams from the Finisher Tray on page 211

Clearing Jams from the Output Tray on page 212

Clearing Jams from Tray & on page 212
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Troubleshooting

Clearing Jams at 1a (using Knob 1c¢)

1. Open the left finisher door.

wc77xx-148

2. Move green handle 1a to the right.

S wc77xx-085

3. Turn green knob 1cin the direction shown, then remove the jammed paper.

— [

j\ we77xx111
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4. Return handle 1a to its original position.

5. Close the left door of the finisher.

Clearing Jams at 2a

1. Open the right finisher door.

[

= |

<
S

Troubleshooting

2. Lift green handle 2a, then remove the jammed paper. If necessary, turn green knob 2c in the

direction shown to release the paper.
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Troubleshooting

3. Return handle 2a to its original position.

-
wc77xx-115

4. Close the right finisher door.

Clearing Jams at 3e (using Knob 3¢)

1. Open the right finisher door.

IS
1=||

T
5

wc77xx-140

2. Move green handle 3e to the right. If necessary, turn green knob 3c in the direction shown to
release the paper. Remove the jammed paper. If the paper is torn, check inside the printer for torn
pieces of paper.

c77xx-113
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Troubleshooting

3. Return handle 3e to its original position.

4. Close the right finisher door.

Paper Jams at 4a in the Booklet Maker

1. Open the right finisher door.
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wc77xx-140

2. Using the green handle, pull out unit 4 until it stops.

wc77xx-149
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Troubleshooting

3. Turn green knob 4a in the direction shown to remove the jammed paper.

A

wc77xx-150

wc77xx-155

5. Close the right finisher door.

Paper Jams at 4b in the Booklet Maker
1. Open the right finisher door.

™
I;l

wc77xx-140
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Troubleshooting

2. Move green lever 4b to the left.

3. If paper is visible, remove the jammed paper by pulling in the direction shown.

wc77xx-156

5. Remove the jammed paper from the upper left side and inside of the unit.

wc77xx-159
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Troubleshooting

6. Return unit 4 to its original position.

wc77xx-155

7. Return lever 4b to its original position.

/
wc77xx-160

8. Close the right finisher door.

Paper Jams in the Booklet Maker Tray
1. Open the finisher right door.

N
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wc77xx-140
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Troubleshooting

2. Turn green knob 4a in the direction shown. Remove the jammed paper from the tray.

wc77xx-116

3. Close the right finisher door.

Clearing Jams from the Finisher Tray

1. Remove any jammed paper from the tray. If paper is torn, look inside the printer for torn pieces.

wc77xx-067

2. Open, then close the right finisher door.

N

[

wc77xx-140
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Clearing Jams from the Output Tray

1. Remove jammed paper from the output tray. If paper is torn, look inside the printer for torn pieces.

wc77xx-117

Clearing Jams from Tray 8

1. Press the cover button.

wc77xx-118

wc77xx-119
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Troubleshooting

3. Close the cover until it clicks into place.

wc77xx-120

4. Remove and reload all paper in the tray.

Clearing Hole Punch Jams

1. Open the finisher door.

c77xx-121
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Troubleshooting

3. Empty the waste container.

wc77xx-122

4. Insert the container all the way into the finisher.

wc77xx-151

5. Locate and remove any paper jams.
6. Close the finisher door.
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Troubleshooting

Clearing Staple Jams

This section includes:
e Clearing Main Staple Jams in the Advanced Finisher and the Professional Finisher on page 215
e C(Clearing Main Staple Jams in the Light Production Finisher on page 217

e Clearing Booklet Staple Jams in the Professional Finisher and the Light Production Finisher on
page 220

Clearing Main Staple Jams in the Advanced Finisher and the Professional
Finisher

Warning: Do not perform this procedure while the printer is copying or printing.

1. Open the finisher door.

% wc77xx-068

2. Hold the staple cartridge unit by orange lever R1 and push it to the right.

R1)

wc77xx-098
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Troubleshooting

3. Grip the staple cartridge by the orange handle and remove it by pulling it firmly toward you. Check
inside the finisher for any loose staples and remove them.

wc77xx-100

5. Remove the jammed staples (1), then push the clamp in the direction shown until it snaps into the
locked position (2).

Warning: The points of the jammed staples are sharp. Remove the jammed staples carefully.

wc77xx-101
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Troubleshooting

6. Grip the staple cartridge by the orange handle and insert it into the staple cartridge unit until it clicks.

wc77xx-102

7. Close the finisher front door.

Clearing Main Staple Jams in the Light Production Finisher
1. Open the right finisher door.
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wc77xx-140

2. Grip the staple cartridge by the orange handle and remove it by pulling it firmly toward you. Check
inside the finisher for any loose staples and remove them.

——— wc77xx-141
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Troubleshooting

3. Open the staple cartridge cover and remove the jammed staples.

Warning: The points of the jammed staples are sharp. Remove the jammed staples carefully.

wc77xx-147
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Troubleshooting

5. Grip the staple cartridge by the orange handle and insert it into the staple cartridge unit until it

clicks into place.

6. Close the right finisher door.

\

N= |

wc77xx-145
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Clearing Booklet Staple Jams in the Professional Finisher and the Light
Production Finisher

The booklet stapler uses two staple cartridges labeled R2 and R3. Booklet stapling requires that both
staple cartridges be free of jammed staples.
Warning: Do not perform this procedure when the printer is copying or printing.

1. Open the finisher door.
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2. While squeezing orange levers R2 and R3 together (1), pull the staple cartridge unit out of the

finisher until it stops (2).
Note: The staple cartridge unit does not detach from the finisher.

ARA

wc77xx-104
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Troubleshooting

3. Grip the orange tabs on both sides of the staple cartridge.

ARR

ARR

AR

wc77xx-107
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6. Remove the jammed staples by pulling them in the direction shown.

Warning: The points of the jammed staples are sharp. Remove the jammed staples carefully.

ARA

Nips

wc77xx-109

AR

9. If no jammed staples were found, repeat steps 3 to 8 for the other staple cartridge.
10. Close the finisher door.
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Troubleshooting

The printer is designed to function with minimal paper jams using Xerox supported media types only.
Other media types may cause more frequent paper jams. If supported media is jamming frequently in
one areq, that area may need to be cleaned or repaired.

This section contains help for the following problems:

) on page 223
) on page 223

. on page 224

) on page 224

) on page 224

Probable Causes Solutions

The paper tray is too full. Remove some of the paper. Do not load paper past fill line.

The front edges of the paper are not even. Remove the media, align the front edges, and then reload it.

The media is moist from humidity. Remove the media from the tray, and replace it with new
dry media.

Too much static electricity is present. Try a new ream of paper.

Do not fan transparencies.

Unsupported media. Use only Xerox-approved media. See on
page 41.
Humidity is too high for coated paper. Feed paper one sheet at a time.

Probable Causes Solutions
Some paper remains jammed in the printer. Recheck the media path and make sure that you have
removed all of the jammed paper. For details, see
on page 223.
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Probable Causes

Solutions

Unsupported media (wrong size, thickness, type,
etc.) is being used.

Use only Xerox-approved media. For details, see

on page 41.
Recheck the media path inside the duplex unit and make
sure that you have removed all of the jammed paper.
Make sure that you have not mixed media types in the tray.

Do not duplex envelopes, labels, transparencies, extra
heavyweight, or gloss paper.

Probable Causes

Solutions

Unsupported media (wrong size, thickness,
type, etc.).

Do not use media that is too thick.

Use only Xerox-approved media. See on
page 41.

The documents loaded in the document feeder
exceed the maximum capacity allowed.

Place fewer documents in the document feeder.

The document feeder guides are
improperly adjusted.

Ensure the media guides fit snugly against the media
loaded in the document feeder.

Probable Causes

Solutions

The media is not correctly positioned in the tray.

Remove the misfed media and reposition the media
properly in the tray. Ensure that the media guides in the
tray are set correctly.

The number of sheets in the tray exceeds the
maximum sheets allowed.

Remove the excess media and load media below the fill line.

The media guides are not correctly adjusted to
the media size.

Adjust the media guides in the tray to match the size of
the media.

Warped or wrinkled media is loaded in the tray.

Remove the media, smooth it out, and reload it. If it still
misfeeds, do not use that media.

The media is moist from humidity.

Remove the moist media and replace it with new, dry media.

Unsupported media (wrong size, thickness, type,
etc.) is being used.

Use Xerox-approved media. See on
page 41.
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Troubleshooting

Probable Causes Solutions

The recommended transparency or label sheet | Load the transparencies or label sheets according to the
is facing the wrong way in the tray. manufacturer’s instructions.

Envelopes are facing the wrong way in Tray 5 Load the envelopes in Tray 5 (Bypass Tray) with the flaps
(Bypass Tray). open, on the trailing edge.
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Print Quality Problems

Your printer is designed to produce consistently high-quality prints. If you observe print quality
problems, the following troubleshooting tools are available online:

o WorkCentre 7755/7765/7775 Xerox Image Quality Tools
e  WorkCentre 7755/7765/7775 Image Quality Defects and Solutions

To download the tools, go online to Xerox User Documentation at
www.xerox.com/office/WC7755_WC7765_WC7775docs.

Caution: The Xerox warranty, service agreement, or Total Satisfaction Guarantee does not cover
damage caused by using unsupported paper, transparencies, or other specialty media. The Total
Satisfaction Guarantee is available in the United States and Canada. Coverage may vary outside
these areas; please contact your local representative for details.

Note: To enhance print quality, toner/print cartridge(s) for many models of equipment have been
designed to cease functioning at a predetermined point.

Note: Grayscale images printed with the composite black setting count as color pages, because
color consumables are used. This is the default setting on most printers.
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Troubleshooting

When the copy or scan quality is poor, select the closest symptom from the following table to correct
the problem.

If the copy quality does not improve after carrying out the appropriate action, contact Xerox Customer
Support or your reseller.

Symptom Solutions

Lines or streaks only present in copies made There is debris on the document glass. When scanning, the

from the document feeder. paper from the document feeder passes over the debris
creating lines or streaks. Clean all glass surfaces with a lint
free cloth.

Spots present in copies taken from the There is debris on the document glass. When scanning, the

document glass. debris creates a spot on the image. Clean all glass surfaces

with a lint free cloth.

The reverse side of the original is showing on Copy: Enable Automatic Background Suppression.
the copy or scan. Scan: Enable Automatic Background Suppression.
Image is too light or dark. Copy: Use the Image Quality settings to lighten, darken or

adjust contrast.

Scan: Use the Advanced Settings Tab to lighten, darken or
adjust contrast.

Colors are off. Copy: Use the Image Quality settings to adjust

color balance.

Scan: Confirm the correct Original Type is set. Use the
Advanced Settings tab to adjust color saturation.
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If a fax cannot be sent or received correctly, refer to the following table, and then perform the
indicated operation. If a fax still cannot be sent or received correctly, even after performing the

described operations, contac

This section includes:

Symptom

The document is not scanned.

t your service representative.

on page 228
on page 229
on page 230

Cause

The document is too thick, too thin,
or too small.

Solution

Use the document glass to send
the fax.

The document is scanned at
an angle.

The document feeder guides are not
adjusted to the width of
the document.

Adjust the document feeder guides to
fit the width of the document.

The fax received by the
recipient is blurry.

The document is
incorrectly positioned.

Position the document correctly.

The document glass is dirty.

Clean the document glass.

The text in the document is written
too faint.

Adjust the resolution. Adjust
the contrast.

There may be a problem with the
telephone connection.

Check the telephone line, and then
try sending the fax again.

There may be a problem with the
caller’s fax machine.

Make a copy to check that this
printer is operating correctly, and
then, if the copy was printed
correctly, have the recipient check
the condition of their fax machine.

The fax received by the
recipient is blank.

The document was sent with the
front side facing down (when the
document feeder is used).

Load the document to be faxed
facing up.
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Symptom

Fax was not transmitted.

Cause

The fax number may be wrong.

Troubleshooting

Solution

Check the fax number.

The one-touch dial key or speed dial
may be incorrectly programmed.

Check that the keys were correctly
programmed.

The telephone line may be
incorrectly connected.

Check the telephone line connection.
If it is disconnected, connect it.

There may be a problem with the
recipient’s fax machine.

Contact the recipient.

Symptom

The received fax is blank.

Cause

There may be a problem with the
telephone connection or with the
caller’s fax machine.

Solution

Check that the printer can make
clean copies. If it can, have the caller
send the fax again.

The sender may have loaded the
pages backward.

Contact the sender.

The Fax Machine answers the
call, but will not accept
incoming data.

Not enough memory

If the job contains several graphics,
the printer might not have enough
memory. The printer will not answer
if memory is low. Remove stored
documents and jobs and wait for the
existing job to complete. This will
increase available memory.

An image is reduced on
a transmission.

The paper supply at the receiving fax

may not match the original size sent.

Confirm the original size of the
documents. Documents might be
reduced based on the available paper
supply at the receiving fax machine.

Faxes cannot be
received automatically.

The printer is set to receive
faxes manually.

Set the printer to automatic reception.

The memory is full.

Load paper if it is empty, and then
print the faxes stored in the memory.

The telephone line is
incorrectly connected.

Check the telephone line connection.
If it is disconnected, connect it.

There may be a problem with the
sender’s fax machine.

Make a copy to check that this
printer is operating correctly, and
then, if the copy was printed
correctly, have the recipient check
the condition of their fax machine.
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Printing the Protocol Report

The Protocol Report provides information about the previous fax job as an aid in determining fax
protocol problems.

To print the report:

1. Login as system administrator. Press the Log In/Out button, enter the User ID (admin is the
default), touch Next, enter the Password (1111 is the default) then touch Enter.

Press the Machine Status button.
Touch the Tools tab, touch Service Settings, then touch Embedded Fax Settings.
Touch Print Fax Reports.

v & WwhN

Touch Protocol Report, then touch Print Now.
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Getting Help

This section includes:

e Control Panel Messages on page 231
e Faxand Scan Alerts on page 231

e Maintenance Assistant on page 231

e Online Support Assistant on page 231
e Helpful Weblinks on page 232

Control Panel Messages

Xerox provides several automatic diagnostic tools to help you produce and maintain print quality.

The control panel provides you with information and troubleshooting help. When an error or warning
condition occurs, the control panel touch screen displays a message informing you of the problem. In
many cases, the touch screen also displays an animated graphic showing the location of the problem,
such as the location of a paper jam. Press the Help button on the control panel to view additional
information about the message or menu displayed.

Fax and Scan Alerts

Alerts provide messages and instructions for helping the user solve problems that may arise when
faxing or scanning. Alerts can be viewed through CentreWare IS. Alerts can also be viewed by clicking
More Status in the print options (printer driver).

Note: Fax errors do not prevent scanning, copying, or printing activities.

Maintenance Assistant

Your printer includes a built-in diagnostic capability allowing you to send diagnostic information
directly to Xerox. To use this capability, do the following:

1. Press the Machine Status button.
2. Touch the Machine Information Tab, then touch Maintenance Assistant.
3. Touch Send Diagnostic Information to Xerox.

The diagnostic information will be sent to Xerox. This information can be used by the Xerox Call Center

to help you solve the problem.

Online Support Assistant

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help
to solve your printer problems. You can find solutions for print quality, copy quality, media jams,
software installation, and much more.
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To access the Online Support Assistant, go to

Xerox provides several websites that offer additional help on your printer.

Technical support information for your
printer, includes online Technical Support,
Recommended Media List, Online Support
Assistant, driver downloads, documentation,
and more

Supplies for your printer

A resource for tools and information, such as
printing templates, helpful tips, and
customized features to meet your
individual needs

Local sales and support center

Printer registration

Material Safety Data Sheets identify
materials, and provide information onsafely | (U.S. and Canada)
handling and storing hazardous materials

(European Union)

Information about recycling supplies
(U.S. and Canada)

(European Union)
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Printer Specifications

This chapter includes:

For media specifications and capacities, see Supported Media on page 41.

Physical Specifications on page 234
Environmental Specifications on page 235
Electrical Specifications on page 236
Performance Specifications on page 237
Controller Specifications on page 238
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Printer Specifications

Physical Specifications

Configuration with Offset Catch Tray

e Width: 1,574 mm (62.0 in.)
e Depth: 782 mm (30.8 in.)
e Height: 1,369 mm (53.9 in.)
e  Weight: 274.5 kg (604 b.)

Configuration with Advanced Office Finisher

e Width: 2,096 mm (82.5in.)
e Depth: 782 mm (30.8 in.)

e Height: 1,369 mm (53.9 in.)
e Weight: 351.8 kg (775.5 |b.)

Configuration with Professional Finisher (with Booklet Maker)

e Width: 2,096 mm (82.5 in.)
e Depth: 782 mm (30.8 in.)

e Height: 1,369 mm (53.9 in.)
e  Weight: 379.4 kg (834.7 |b.)

Configuration with Light Production Finisher (without Folding Option)

e Width: 2,286 mm (90 in.)
e Depth: 782 mm (30.8 in.)
e Height: 1,369 mm (53.9 in.)
e  Weight: 407.7 kg (897 Ib.)

Configuration with Light Production Finisher (with Folding Option)

e Width: 2,489 mm (98 in.)
e Depth: 782 mm (30.8 in.)
e Height: 1,369 mm (53.9 in.)
e Weight: 465.4 kg (1,024 |b.)
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Environmental Specifications

Temperature

Operating: 10° to 28° C/50°to 90° F

Relative Humidity

Operating: 10 % to 85%
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Electrical Specifications

e 110-127 VAC, 50-60 Hz; Power Consumption: 1.131 KVA maximum printing continuously
e 220-240 VAC, 50-60 Hz; Power Consumption: 1.096 KVA maximum printing continuously
e ENERGY STAR qualified product
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Performance Specifications

Resolution

Maximum Resolution: 2400x2400 dpi
Print Speed

WorkCentre 7755

Color: 40 ppm
Black and White: 55 ppm

WorkCentre 7765

Color: 50 ppm
Black and White: 65 ppm

WorkCentre 7775

Color: 50 ppm
Black and White: 75 ppm

Printer Specifications

WorkCentre 7755/7765/7775 Multifunction Printer

User Guide

237



Printer Specifications

Controller Specifications

Processor

1.8 GHz

Memory

1 GB minimum

Interface

Ethernet 10/100/1000Base-TX
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Regulatory Information

This chapter includes:

Basic Regulations on page 240

Copy Regulations on page 242

Fax Regulations on page 245

Material Safety Data Sheets on page 248
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Regulatory Information

Basic Regulations

Xerox has tested this product to electromagnetic emission and immunity standards. These standards are
designed to mitigate interference caused or received by this product in a typical office environment.

United States (FCC Regulations)

This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a commercial environment. This equipment generates, uses, and can
radiate radio frequency energy. If it is not installed and used in accordance with these instructions, it
may cause harmful interference to radio communications. Operation of this equipment in a residential
area is likely to cause harmful interference in which case the user will be required to correct the
interference at his/her own expense.

If this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

e Reorient or relocate the receiver.

e Increase the separation between the equipment and receiver.

e Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
e Consult the dealer or an experienced radio/television technician for help.

Any changes or modifications not expressly approved by Xerox could void the user's authority to operate

the equipment. To ensure compliance with Part 15 of the FCC rules, use shielded interface cables.

Canada (Regulations)

This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe A est conforme a la norme NMB-003 du Canada.

European Union

Warning: This is a Class A product. In a domestic environment this product may cause radio
interference in which case the user may be required to take adequate measures.

The CE mark applied to this product symbolizes Xerox’s declaration of conformity with
C € the following applicable Directives of the European Union as of the dates indicated:

December 12, 2006: Low Voltage Directive 2006/95/EC
December 15, 2004: Electromagnetic Compatibility Directive 2004/108/EC

e March 9, 1999: Radio & Telecommunications Terminal Equipment Directive
1999/5/EC
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This product, if used properly in accordance with the user's instructions, is neither dangerous for the
consumer nor for the environment.

To ensure compliance with European Union regulations, use shielded interface cables.

A signed copy of the Declaration of Conformity for this product can be obtained from Xerox.

Ozone Release

During print operation, a small quantity of ozone is released. This amount is not large enough to harm
anyone adversely. However, be sure the room where the product is being used has adequate
ventilation, especially if you are printing a high volume of materials, or if the product is being used
continuously over a long period.
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Copy Regulations

United States

Congress, by statute, has forbidden the reproduction of the following subjects under certain circumstances.
Penalties of fine or imprisonment may be imposed on those guilty of making such reproductions.

1. Obligations or Securities of the United States Government, such as:
e Certificates of Indebtedness
e National Bank Currency
e Coupons from Bonds
e Federal Reserve Bank Notes
e Silver Certificates
e Gold Certificates
e United States Bonds
e Treasury Notes
e Federal Reserve Notes
e Fractional Notes
e Certificates of Deposit
e Paper Money
e Bonds and Obligations of certain agencies of the government, such as FHA, etc.

e Bonds (U.S. Savings Bonds may be photographed only for publicity purposes in connection
with the campaign for the sale of such bonds.)

e Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a
canceled revenue stamp, this may be done provided the reproduction of the document is
performed for lawful purposes.

e Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps may be
photographed, provided the reproduction is in black and white and is less than 75 % or more
than 150 % of the linear dimensions of the original.

e Postal Money Orders
e Bills, Checks, or Draft of money drawn by or upon authorized officers of the United States.

e Stamps and other representatives of value, of whatever denomination, which have been or
may be issued under any Act of Congress.

e Adjusted Compensation Certificates for Veterans of the World Wars.
2. Obligations or Securities of any Foreign Government, Bank, or Corporation.

3. Copyrighted materials, unless permission of the copyright owner has been obtained or the
reproduction falls within the “fair use” or library reproduction rights provisions of the copyright law.
Further information of these provisions may be obtained from the Copyright Office, Library of
Congress, Washington, D.C. 20559. Ask for Circular R21.

4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may be photographed.
5. Passports. Foreign Passports may be photographed.
6. Immigration papers.
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Draft Registration Cards.

Selective Service Induction papers that bear any of the following Registrant’s information:
e Earnings or Income

e Court Record

e Physical or mental condition

e Dependency Status

e Previous military service

Exception: United States military discharge certificates may be photographed.

Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of
the various Federal Departments, such as FBI, Treasure, etc. (Unless photograph is ordered by the
head of such department or bureau.)

Reproducing the following is also prohibited in certain states:
e Automobile Licenses

e Drivers’ Licenses

e Automobile Certificates of Title

The above list is not all inclusive, and no liability is assumed for its completeness or accuracy. In case of
doubt, consult your attorney.

Canada

Parliament, by stature, has forbidden the reproduction of the following subjects under certain
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making
such reproductions.

1.

2.
3.
4

Current bank notes or current paper money.

Obligations or securities of a government or bank.

Exchequer bill paper or revenue paper.

The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of
a court of law.

Proclamations, orders, regulations or appointments, or notices thereof (with intent to falsely cause
same to purport to have been printed by the Queens Printer for Canada, or the equivalent printer
for a province).

Marks, brands, seals, wrappers or designs used by or on behalf of the Government of Canada or of
a province, the government of a state other than Canada or a department, board, Commission or
agency established by the Government of Canada or of a province or of a government of a state
other than Canada.

Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of
a province or by the government of a state other than Canada.

Documents, registers or records kept by public officials charged with the duty of making or issuing
certified copies thereof, where the copy falsely purports to be a certified copy thereof.

Copyrighted material or trademarks of any manner or kind without the consent of the copyright or
trademark owner.

The above list is provided for your convenience and assistance, but it is not all-inclusive, and no liability
is assumed for its completeness or accuracy. In case of doubt, consult your solicitor.
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Other Countries

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may
be imposed on those found guilty of making such reproductions.

Currency notes

Bank notes and cheques

Bank and government bonds and securities

Passports and identification cards

Copyright material or trademarks without the consent of the owner
Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of
doubt, contact your legal counsel.
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Fax Regulations

United States

Fax Send Header Requirements

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or
other electronic device, including a fax machine, to send any message unless such message clearly
contains in a margin at the top or bottom of each transmitted page or on the first page of the
transmission, the date and time it is sent and an identification of the business or other entity, or other
individual sending the message and the telephone number of the sending machine or such business,
other entity or individual. The telephone number provided may not be a 900 number or any other
number for which charges exceed local or long distance transmission charges.

In order to program this information into your machine, refer to customer documentation and follow
the steps provided.

Data Coupler Information

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the
Administrative Council for Terminal Attachments (ACTA). On the cover of this equipment is a label that
contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If
requested, this number must be provided to the Telephone Company.

A plug and jack used to connect this equipment to the premises wiring and telephone network must
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant
telephone cord and modular plug is provided with this product. It is designed to be connected to a
compatible modular jack that is also compliant. See installation instructions for details.

You may safely connect the machine to the following standard modular jack: USOC RJ-11C using the
compliant telephone line cord (with modular plugs) provided with the installation kit. See installation
instructions for details.

The Ringer Equivalence Number (REN) is used to determine the number of devices that may be
connected to a telephone line. Excessive RENs on a telephone line may result in the devices not ringing
in response to an incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0).
To be certain of the number of devices that may be connected to a line, as determined by the total
RENSs, contact the local Telephone Company. For products approved after July 23, 2001, the REN for
this product is part of the product identifier that has the format US:AAAEQ##TXXXX. The digits
represented by ## are the REN without a decimal point (e.g., 03 is a REN of 0.3). For earlier products,
the REN is separately shown on the label.
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To order the correct service from the local telephone company, you may also have to quote the codes
listed below:

e Facility Interface Code (FIC) = 02LS2
e Service Order Code (SOC) = 9.0Y

Warning: Ask your local telephone company for the modular jack type installed on your line.
Connecting this machine to an unauthorized jack can damage telephone company equipment.
You, not Xerox, assume all responsibility and/or liability for any damage caused by the connection
of this machine to an unauthorized jack.

If this Xerox equipment causes harm to the telephone network, the Telephone Company will notify you
in advance that temporary discontinuance of service may be required. But if advance notice is not
practical, the Telephone Company will notify the customer as soon as possible. Also, you will be advised
of your right to file a complaint with the FCC if you believe it is necessary.

The Telephone Company may make changes in its facilities, equipment, operations or procedures that
could affect the operation of the equipment. If this happens, the Telephone Company will provide
advance notice in order for you to make necessary modifications to maintain uninterrupted service.

If trouble is experienced with this Xerox equipment, for repair or warranty information, please contact
the appropriate service center; details of which are displayed either on the machine or contained
within the User Guide. If the equipment is causing harm to the telephone network, the Telephone
Company may request that you disconnect the equipment until the problem is resolved.

Repairs to the machine should be made only by a Xerox Service Representative or an authorized Xerox
Service provider. This applies at any time during or after the service warranty period. If unauthorized
repair is performed, the remainder of the warranty period is null and void.

This equipment must not be used on party lines. Connection to party line service is subject to state
tariffs. Contact the state public utility commission, public service commission or corporation
commission for information.

If your office has specially wired alarm equipment connected to the telephone line, make sure that the
installation of this Xerox equipment does not disable your alarm equipment.

If you have questions about what will disable alarm equipment, consult your Telephone Company or a
qualified installer.

Canada

Note: The Industry Canada label identifies certified equipment. This certification means that the
equipment meets certain telecommunications network protective, operational and safety requirements
as prescribed in the appropriate Terminal Equipment Technical Requirements document(s). The
Department does not guarantee the equipment will operate to the user’s satisfaction.

Before installing this equipment, users must make sure that it is permissible to be connected to the
facilities of the local telecommunications company. The equipment must also be installed using an
acceptable method of connection. The customer should be aware that compliance with the above
conditions may not prevent degradation of service in some situations.
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Repairs to certified equipment should be coordinated by a representative designated by the supplier.
Any repairs or alterations made by the user to this equipment, or equipment malfunctions, may give
the telecommunications company cause to request the user to disconnect the equipment.

Users should make sure for their own protection that the electrical ground connections of the power
utility, telephone lines and internal metallic water pipe systems, if present, are connected together.
This precaution may be particularly important in rural areas.

Caution: Users should not attempt to make such connections themselves, but should contact the
appropriate electric inspection authority, or electrician, as appropriate.

The Ringer Equivalence Number (REN) assigned to each terminal device provides an indication of the
maximum number of terminals allowed to be connected to a telephone interface. The termination on
an interface may consist of any combination of devices subject only to the requirement that the sum
of the Ringer Equivalent Numbers of all of the devices does not exceed 5. For the Canadian REN value,
please see the label on the equipment.

Europe

Radio Equipment & Telecommunications Terminal Equipment Directive

The Facsimile has been approved in accordance with the Council Decision 1999/5/EC for pan-European
single terminal connection to the public switched telephone network (PSTN). However, due to
differences between the individual PSTNs provided in different countries, the approval does not, of
itself, give an unconditional assurance of successful operation on every PSTN network terminal point.

In the event of a problem you should contact your authorized local dealer in the first instance.

This product has been tested to and is compliant with ES 203 021-1, -2, -3, a specification for terminal
equipment for use on analogue-switched telephone networks in the European Economic Area. This
product provides an user-adjustable setting of the country code. Refer to the customer documentation
for this procedure. Country codes should be set prior to connecting this product to the network.

Note: Although this product can use either loop disconnect (pulse) or DTMF (tone) signaling, it is
recommended that it is set to use DTMF signaling. DTMF signaling provides reliable and faster call
setup. Modification of this product, connection to external control software or to external control
apparatus not authorized by Xerox, will invalidate its certification.

South Africa

This modem must be used in conjunction with an approved surge protection device.
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Material Safety Data Sheets

For Material Safety Data information regarding your printer, go to:
North America: www.xerox.com/msds
European Union: www.xerox.com/environment_europe

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts.
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Recycling and Disposal

This chapter includes recycling and disposal guidelines and information for:

All Countries on page 250
North America on page 250
European Union on page 250
Other Countries on page 252
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Recycling and Disposal

Guidelines and Information

All Countries

If you are managing the disposal of your Xerox product, please note that the product contains lamp(s)
with mercury, and may contain lead, perchlorate, and other materials whose disposal may be
regulated due to environmental considerations. The presence of these materials is fully consistent with
global regulations applicable at the time that the product was placed on the market. For recycling and
disposal information, contact your local authorities. In the United States, you may also refer to the
Electronic Industries Alliance website: www.eiae.org. Perchlorate Material: This product may contain
one or more Perchlorate-containing devices, such as batteries. Special handling may apply, please see
www.dtsc.ca.gov/hazardouswaste/perchlorate.

North America

Xerox operates an equipment takeback and reuse/recycle program. Contact your Xerox sales
representative (1-800-ASK-XEROX) to determine whether this Xerox product is part of the program. For
more information about Xerox environmental programs, visit www.xerox.com/environment or for
recycling and disposal information, contact your local authorities.

European Union

Some equipment may be used in both a domestic/household and a professional/business application.

Domestic/Household Environment

Application of this symbol on your equipment is confirmation that you
should not dispose of the equipment in the normal household waste stream.

In accordance with European legislation, end of life electrical and electronic equipment subject to
disposal must be segregated from household waste.

Private households within EU member states may return used electrical and electronic equipment to
designated collection facilities free of charge. Please contact your local disposal authority for information.

In some member states, when you purchase new equipment, your local retailer may be required to take
back your old equipment free of charge. Please ask you retailer for information.
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Recycling and Disposal

Professional/Business Environment

Application of this symbol on your equipment is confirmation that you must
dispose of this equipment in compliance with agreed national procedures.

In accordance with European legislation, end of life electrical and electronic equipment subject to
disposal must be managed within agreed procedures.

Prior to disposal, please contact your local reseller or Xerox representative for end of life
takeback information.

Information for Users on Collection and Disposal of Old Equipment and Used Batteries

These symbols on the products and/or accompanying documents mean
that used electrical and electronic products and batteries should not be
mixed with general household waste.

For proper treatment, recovery and recycling of old products and used
batteries, please take them to applicable collection points, in accordance with
your national legislation and the Directive 2002/96/EC and 2006/66/EC.

By disposing of these products and batteries correctly, you will help to save
valuable resources and prevent any potential negative effects on human
health and the environment which could otherwise arise from inappropriate
waste handling.

For more information about collection and recycling of old products and
batteries, please contact your local municipality, your waste disposal service
or the point of sale where you purchased the items.

Penalties may be applicable for incorrect disposal of this waste, in
accordance with national legislation.

For Business Users in the European Union

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for
further information.
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Recycling and Disposal

Information on disposal in other countries outside the European Union

These symbols are only valid in the European Union If you wish to discard these items, please contact
your local authorities or dealer and ask for the correct method of disposal.

Note for the Battery Symbol

This wheeled bin symbol may be used in combination with a chemical symbol.
This establishes compliance with the requirements set out by the Directive.

Hg
Removal

Batteries should only be replaced by a MANUFACTURER approved service facility.

Other Countries

Please contact your local waste authorities and request disposal guidance.
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A

accounting, 28

B

before using the printer, 18
billing meters, 27
booklet printing, 67

C

choosing a network connection, 32
cleaning the printer, 157
document cover, 157
document feeder roller, 158
document glass, 157
exterior, 158
clearing paper jams
advanced office finisher, 187
bottom left cover, 184
document feeder, 179
duplex unit, 177
light production finisher, 203
output tray, 183
professional finisher, 187
transfer module, 181
tray 1 and tray 2, 175
tray 3 and tray 4,176
tray 5,177
tray 6,178
clearing staple jams, 215
booklet stapler
light production finisher, 220
professional finisher, 220
main stapler
advanced finisher, 215
light production finisher, 217
professional finisher, 215
color corrections, 70
configurations, 22
consumables, 160

control panel, 24
features and layout, 25
information pages, 26
supplies status message, 161
warnings, 161

copying, 89

custom size paper
creating custom sizes, 83
printing, 57

E

electrical safety, 13
electrical specifications, 236
envelopes
printing, 55
environmental specifications, 235
Ethernet, 32
exception pages
printing, 78
extension cord, 13

F

faxing, 135
internet fax, 140
mailboxes, 147
overview, 136
polling, 149
problems, 228
selecting options, 143
sending, 137
server fax, 139
speed dial entries, 151
features
printer configurations, 22

G
glossy paper
printing, 56
ground connection terminal, 13
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Index

H

help, 231
control panel messages, 231
fax alerts, 231
maintenance assistant, 231
online support assistant, 231
resources, 29
technical support, 29
Weblinks, 232

I

index
print, 39

information
about your printer, 29
on control panel, 25
printer management tools, 29
Quick Use Guide, 29
technical support, 29
Web links, 29

information pages, 26
printing, 26

installing staples, 162

booklet stapler
light production finisher, 164
professional finisher, 164

main stapler
advanced office finisher, 162
light product finisher, 167
professional finisher, 162

J

job completion notification, 84

L

labels
printing, 55
loading envelopes, 51
loading paper
tray 1 or tray 2, 43
tray 3 or tray 4, 45
tray 5 (Bypass tray), 47
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Macintosh
printer drivers, 34
maintenance, 153
material safety data sheets, 248
media
supported, 41
memory, 238
mirror images, 82
printing, 82
misfeeding, 224
multiple pages to single sheet (N-Up)
printing, 66

N

network
choosing a network connection, 32
non-Xerox supplies, 161

O

original size
scanning template setup, 121

P

pages per minute (ppm), 22
paper jams

advanced office finisher, 187
parts of the printer, 19
PCL5, 34
PCL®6, 34
performance specifications, 237
physical specifications, 234
PostScript, 34



printer

advanced features, 22
available configurations, 22
configurations, 22
connection, 22

control panel features, 25
disposal, 250

electrical safety, 13

fonts, 22

information resources, 29
internal components, 21
maximum print speed, 22
maximum resolution (dpi), 22
options, 23

physical specifications, 234
recycling, 250

safety requirements, 11
standard features, 22
supplies, 14

trays, 22

printer drivers

Macintosh, 34
UNIX, 37
Windows, 33

printer location, 14
printer specifications, 233

Index

printing
black and white, 74
booklets, 67
both sides of paper, 63
cover pages, 76
creating custom sizes, 83
custom size paper, 57
envelopes, 55
exception pages, 78
glossy paper, 56
information pages, 26
insert pages, 75
labels, 55
mirror images, 82
multiple pages to single sheet (N-Up), 66
options, 58
Macintosh PostScript, 60
Windows PCL, 58
Windows PostScript, 58
scaling, 79
secure print job, 85
selecting options, 58
special job types, 85
special media, 54
transparencies, 54
watermarks, 80

R

recommended media, 41
regulatory information

Canada, 240

Europe, 240

United States, 240
replacement parts, 160
routine maintenance items, 160
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S

safety
electrical, 12
laser, 12

maintenance, 15
operational, 14
printer location, 14
printer supplies, 14
requirements, 11
scaling, 79
scanning, 111
advanced options, 132
importing images into application, 129
load documents, 113
loading documents, 113
overview, 112
scan to a folder, 114
scan to email, 117
scan to home, 119
scan to network, 116
setting options, 132
template, 121
using Xerox Scan Utility, 120
secure print job, 85
printing, 85
selecting printing options, 58
special media
printing, 54
specifications
controller, 238
environmental, 235
memory, 238
performance, 237
printer, 233
status messages, 161
supplies, 14
non-Xerox supplies, 161
ordering, 161
recycling, 161
replacement, 160, 161
supported mediaq, 41
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transparencies
printing, 54
troubleshooting, 169
clearing paper jams, 169
clearing staple jams, 169
copy/scan problems, 227
fax, 228
print quality problems, 226
technical support, 29
TWAIN, 34

U
UNIX and Linux drivers, 37

W

web links
information, 29
WIA, 34
Windows printer drivers, 33

X

Xerox Scan Utility
attaching images to email, 126
creating scan templates, 121
deleting scan templates, 123
managing profiles, 124
scan to home feature, 119
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